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Document History

Revision Published Summary of Changes

1.0 February 2024 First revision for version 18.

2.0 April 2024 Updates for version 18 monthly release.

3.0 July 2024 Updates for version 18 monthly release - Keyboard Grouping added.

4.0 March 2025 Updates for version 18 monthly release - Updated Defining User Defaults
attribute to set signature on trade confirmation message.

5.0 May 2025 Updates for version 18 monthly release - Added information about salesPerson
domain.

The Calypso Front Office provides tools for working with trades using different criteria
definitions for collecting trades. The trades that satisfy the criteria of a particular trade
collection will be loaded into Trade Blotters where they share common market data updated
in real-time, and where they can be analyzed on-the-fly.
This document describes the various types of trade collections, as well as all common
functions related to trade capture: trade menus, trade functions, and user defaults.
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1. Defining Filter Sets
Filter sets allow defining dynamic collections of trades based on any user-defined criteria (not limited to trade
criteria).

From the Calypso Navigator, navigate to Configuration > Filters > Filter Set (menu action
trading.FilterSetWindow) to define filter sets.

A filter set is identified by its name throughout the system.

» You can click Load to load an existing filter set.

» To create a new filter set, click New.

Click Attributes to select criteria to collect trades.

For each attribute, click Add to set the value of the attribute.

Then click Save to save the filter set. You will be prompted to enter a filter set name.

Template
» You can click Save next to the Template field to save the filter set as a template. You will be prompted to enter a

filter set name. You can then select a template to create more filter sets. Only the user who creates a filter set
template can use it. However, you can copy a filter set template to another user from the Calypso Navigator using
Configuration > User Access Control > User Settings.
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The property name of filter set templates is "FS_TEMPLATE_DEFAULT" - The value is the filter set name.

Groups
You can click ... next to the Groups fields to associate the filter set with a group or multiple groups.

Available groups need to be defined in the "groupFilterSet" domain.

This is only used to define access rights for filter sets based on groups.

Please refer to Calypso Permissions and Authorization documentation for details.

Usage
» You can click Usage to view if a specific filter set is used in any configuration.
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2. Defining Static Data Filters
Static Data Filters allow filtering and grouping accounts, messages, trades, transfers and tasks for back office
processing based on user-defined criteria. Static Data Filters are used in the definition of back office configurations
such as settlement instructions, workflows, message generation, etc. to restrict their application.

From the Calypso Navigator, navigate to Configuration > Filters > Static Data Filter to define a Static Data Filter.

» Click Load to select an existing Static Data Filter, or New to create a new filter. Then modify / enter the fields as
needed - They are described below.

» Click Criteria to open the list of criteria that can be used to define the filters. When you select an attribute, it is
added to the table so that you can define its value. You can add as many criteria as needed for a given filter.

» You can click Simulate to open a report that allows you to check the results of applying static data filters to actual
data.
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You can select multiple static data filters.

Select an object type, and enter a comma-separated list of object IDs.

Then click . The results indicate if the data satisfy the static data filters.

» You can click Pending Modifs to get a list of all static data filters pending authorization - This only applies if the
Authorization mode is enabled.

» You can click Usage to view where a specific filter is used. When a filter includes another filter, the referencing
filters are also listed.

You can select a row and click View to view the configuration using the filter.

» Click Save to save your changes.

Note that if the Authorization mode is enabled, an authorized user must approve your entry.

Nasdaq Calypso
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Fields Description
Name Name of selected filter.

Comment Optional - Enter a free comment to describe the static data filter.

Groups You can associate a static data filter with a group so that it will only be used in the context of
that group. By default, a group is a Calypso application that can use a static data filter. They
are listed below.

For example, if you select SDI, the static data filter will only be available from the SDI
Configuration window.

ANY indicates that the static data filter can be used in any Calypso application.

You can add more groups to the domain “groupStaticDataFilter”, and in that case, you need
to specify which window it corresponds to from the Calypso Navigator using Configuration
> System > Custom SD Filter Window Config (menu action
"trading.CustomSDFilterWindowConfig"). You will need to provide the fully qualified
name of the window's class name.

Attribute Name of selected attribute.

Criteria Select as appropriate from: IN, NOT IN, LIKE, NOT LIKE, FLOAT_RANGE, etc.

Criteria type FLOAT_RANGE allows you to specify Double.MAX_VALUE (maximum range).

Filter values Choose the values you want to see in your Filter (or exclude, depending on the choice you
have made before: IN, NOT IN, etc.).

You can select multiple values as needed.

Criteria LIKE and NOT LIKE allow defining values with wildcards "%".

If the name contains an underscore, and you want to use wildcards, you need to prefix the
underscore with a backslash.

Example: You want to include all names with “_Z” or “Z_”. Instead of using “%_Z” or “Z_%”, you
need to use “%\_Z” or “Z\_%”.

Calypso Applications that use Static Data Filters
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Static Data Filters Customization
Please refer to the Calypso Developer's Guide for detailed information on customizing static data filters.

A single attribute is registered n the domain "sdFilterCriterion".

A set of attributes for the same object is registered in the domain "sdFilterCriterion.Factory".

Static Data Filter Elements TENOR_RANGE and TENOR_RANGE_BUS

Nasdaq Calypso
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You can set the timezone to be used in the domain “sdFilterTimeZone”. If it is empty, they use the timezone of the
associated book.

By default, the min date is excluded and the max date is included. You can use domain "SDFilter_TENOR_RANGE_
InverseIntervalDates" to inverse the dates inclusions. If empty, there is no change. If it contains Value = true, min date
is included and max date is excluded.

If you check Min Tenor, then the min date is included regardless of the domain. If you check Max Tenor , then the max
date is included regardless of the domain.

Static Data Filter Elements DATE_RANGE

If you select Date Range, you can select Min date and Max date. By default, the min date and the max date are
excluded. You can include them by selecting the checkboxes.

Static Data Filter on Product Groups
When a group is provided as a ProductType, if any child element of the group is a "<ProductType>.<Subtype>", the
static data filter checks the Product SubType instead of the Product Type.

Troubleshooting Static Data Filters
A configuration might not be selected because the static data filter is not satisfied due to incorrect criteria.

You may simulate the effect of a static data filter using the Simulate button in the Static Data Filter window.

You can also remove the static data filter to test if the configuration is properly selected then analyze the criteria of
the static data filter to make sure they are accurate.
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2.1 Stat ic Data Fi l ter Tree
The Static Data Filter Tree is a multi-level static data filter structure which allows for simplified static data filter
management, and allows more than one static data filter to be applied. It is especially useful for security eligibility and
for haircuts.

Static data filter trees are available from the same selection list as standard static data filters, so anywhere a static
data filter can be applied, a static data filter tree can be applied. Note that to use static data filter trees in haircut rules,
additional configuration is required in the Haircut Rule window.

Please refer to Calypso Fees documentation for details.

Rather than creating numerous static data filters with combinations of common criteria and different criteria, you can
build a static data filter tree with the "trunk" being the common criteria and the "branches" being the different criteria.

Each node can consist of a static data filter, another static data filter tree, or of attributes specified in the dynamic
filters.

To represent the table of security categories below would take 12 standard static data filters, and, following the same
pattern, for each currency/country combination you add, 3 more static data filters are required, so the amount of
static data filters can easily reach large numbers. Alternatively, you can create a 4-level static data filter tree to
represent this same data.

Category Currency Country Credit Rating

Government
Bonds

OCEU0C /
OCEU0J

>=6d and
<=12783d

EUR

Italy / Spain

>=AA-/Aa3/AA- and
<=AAA/Aaa/AAA

>=BBB-/Baa3/BBB- and
<=A+/A1/A+

>=BB-/Ba3/BB- and
<=BB+/Ba1/BB+

Austria / Belgium / Finland / France / Germany /
Netherlands

>=AA-/Aa3/AA- and
<=AAA/Aaa/AAA

>=BBB-/Baa3/BBB- and
<=A+/A1/A+

>=BB-/Ba3/BB- and
<=BB+/Ba1/BB+

CAD Canada

>=AA-/Aa3/AA- and
<=AAA/Aaa/AAA

>=BBB-/Baa3/BBB- and
<=A+/A1/A+

>=BB-/Ba3/BB- and
<=BB+/Ba1/BB+

DKK Denmark
>=AA-/Aa3/AA- and
<=AAA/Aaa/AAA

Nasdaq Calypso
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Category Currency Country Credit Rating

>=BBB-/Baa3/BBB- and
<=A+/A1/A+

>=BB-/Ba3/BB- and
<=BB+/Ba1/BB+

In the Calypso Navigator, add a menu item for the Static Data Filter Tree window (menu action
refdata.StaticDataFilterTreeWindow).

The left panel is the same as the standard Static Data Filter window and allows performing all the same functions.

The right panel allows building the static data filter tree.

» Define a standard static data filter consisting of the primary, common criteria. This will be used as the "trunk" of
the tree. This can be done in the Static Data Filter Tree window or the standard Static Data Filter window.

 Ⓘ [NOTE: If the static data filter tree will be used in the Collateral Manager, the root ("trunk") static data filter
must include Product Type in its criteria]

» In the Static Data Filter Tree window, click Load in the Tree Actions panel to select an existing static data filter
tree, or New to create a new tree.

» Define the root node (the "trunk" of the tree).

– In the right panel, select 'Root no filter defined'.

– In the left panel, click Load and select the desired "trunk" static data filter.
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– In the Tree Actions panel, click Apply. The static data filter is set as the root level (the "trunk") of the tree.

» Add a first level "branch" (node). Ensure that the root node is selected, then click to add a child node. Select
the new 'Null' child node and specify its criteria using one of the dynamic filters (filter field or selector fields), or a
static data filter.

– Filter field: Type in the filter field to find the desired static data filter attribute. Currently, only Currency,
Product Type, and Security Country are available. Then click Apply under the selector fields.

– Selector fields: Use the selector fields, similar to the static data filter window, to select the desired static
data filter attribute. Currently, only Currency, Product Type, and Security Country are available. Click Add
and select the desired value(s), then click OK. Then click Apply under the selector fields.

– Static data filter: If the node will be a static data filter or another static data filter tree, in the left panel, click
Load and select the desired static data filter or tree, then click Apply from the Tree Actions panel.

» Add more first level "branches" as needed. You can click with a node selected and it will add a new node at the
same level.

» Add second level "branches" as needed. With a first level node selected, click to add a new sub-node. Select
the new 'Null' node and specify its criteria as described above.

» Add additional "branch" levels as needed.

» You can also define a static data filter tree with no root, which allows adding multiple child nodes at once, instead
of adding them individually.

– In the right panel, select 'Root no filter defined', then click to add a child node. Select the new 'Null' child
node and specify its criteria using one of the methods described previously.

Nasdaq Calypso
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– Add other nodes as needed as described previously.

– Click Save in the Tree Actions panel when you are done. The static data filter tree is now available for
selection from the list of static data filters.

Note that if the Authorization mode is enabled, an authorized user must approve your entry.

In the example above, a static data filter tree "CR Rating Tree" with no root consists of 3 static data filters.
The tree is then applied to each of 4 nodes in the "Govt Bonds" tree. The alternative is to apply each of the 3
static data filters to each of the 4 nodes, which will yield the same result but takes many more steps. By
applying the tree to the first node and then using the node copy and paste functionality (described below), it
is possible to achieve the above result quickly and in very few steps.

» You can adjust a child node's position within its parent node by selecting the child node and clicking to move
it up or down as needed.

» You can delete a node it and any child nodes it contains by selecting the node and clicking .

» You can copy and paste nodes by selecting a parent node and clicking to copy its child nodes. Then select the
node to which you wish to apply it and click to paste the child nodes.

» The Simulate, Pending Modifs, and Usage functions are the same as in the standard static data filter window.

When simulating a static data filter tree, an additional panel is displayed showing if the data satisfy the criteria at
each node.
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» Click Save in the Tree Actions panel when you are done.

Note that if the Authorization mode is enabled, an authorized user must approve your entry.

Copyright ©May 2025, Nasdaq, Inc. All rights reserved.

All content in this document is owned, or licensed, by Nasdaq, Inc. or its affiliates (‘Nasdaq’). Unauthorized use is
prohibited without written permission of Nasdaq.

While reasonable efforts have been made to ensure that the contents of this document are accurate, the document is
provided strictly “as is”, and no warranties of accuracy are given concerning the contents of the information contained
in this document, including any warranty that the document will be kept up to date. Nasdaq reserves the right to
change details in this document without notice. To the extent permitted by law no liability (including liability to any
person by reason of negligence) will be accepted by Nasdaq or its employees for any direct or indirect loss or damage
caused by omissions from or inaccuracies in this document.
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3. Defining Trade Filters
From the Calypso Navigator, navigate to Configuration > Filters > Trade Filter (menu action
refdata.TradeFilterWindow) to define trade filters.

Sample Trade Filter window

The Ranges panel is selected by default. Select the other panels as applicable.

» Enter selection criteria in the various panels - They are described below.

» Then click Save to save the trade filter. You will be prompted to enter a trade filter name.

A trade filter is identified by its name throughout the system.

3.1 Creating a Trade Fi lter
Click New to create a trade filter, and enter selection criteria into the fields of the various panels as applicable. The
fields of the various panels are described below.

New trade filter

• Time Zone - Select a timezone as needed – It is used for date-related criteria.

• Comment – Enter a free form comment.
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• Holidays – Click ... to select holidays – Holidays are used to determine business days if the “Check Holidays”
checkbox is checked.

See Date / Time Panel for usage details.

• Use SQL – Check the “Use SQL” checkbox to define the trade filter using an SQL query.

See "Defining a Trade Filter using SQL" for details.

• Parent – You can select a parent trade filter to build a hierarchy of trade filters. A child trade filter combines its
criteria with the criteria of its parents through an AND logical expression.

[NOTE: For a given parent, the child filters can either be SQL filters OR non-SQL filters - Calypso does not support
having mixed child filters. Also, when using SQL in a child filter, Calypso does not validate the SQL code]

• Cache trades on load – Check the “Cache trades on load” checkbox to store the trades in cache when the trade
filter is loaded from the database.

[NOTE: The "Cache trades on load" checkbox cannot be checked if any date-related fields are set]

• Set as default parent - If you check “Set as default parent” on a given trade filter named TF for example, all new
trade filters created by the same user will have TF as a parent.

• Groups - You can click ... next to the Groups fields to associate the trade filter with a group or multiple groups.

Available groups need to be defined in the "groupTradeFilter" domain.

This is only used to define access rights for trade filters based on groups.

Please refer to Calypso Permissions and Authorization documentation for details.

Click Save to save your changes, you will be prompted to enter a name. A trade filter is identified by its name
throughout the system.

You can also click Save As to save the trade filter as a new trade filter. You will be prompted to enter a name.

3.2 Ranges Panel
Select the Ranges panel to select trade ranges.
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Sample Ranges panel

» Select the range criteria described below as needed.

Fields Description
Trade Id Min

Trade Id Max

Enter a minimum / maximum trade id.

Quantity Min

Quantity Max

Enter a minimum / maximum quantity.

Trade Price Min

Trade Price Max

Enter a minimum / maximum price.

Filter IN Click ... to select a nested trade filter. The system will combine the criteria of the trade filter
with the criteria of the nested trade filter using an OR logical expression.

If you uncheck IN, it works as NOT IN – It will load all trades except the trades of the nested
trade filters.

Trade Id List Enter a list of comma-separated trade ids.

3.3 Date / Time Panel
Select the Date / Time panel to select date and time criteria.
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Sample Date / Time panel

» To add a date / time criteria, click New Rule, then define the rule as needed.

Select a date (TradeDate for example) and a rule. Multiple types of rules are available:

– "is before", "is on or before", "is on", "is on or after", "is after" - For these rules, you can select "now", "today",
a specific date and time, or a tenor and time.

When you select a tenor, the corresponding date will be generated as business days if “Check Holidays” is
checked based on the selected holiday calendars. For example, "is before 3 business days ago".

– "within today", "within the current hour", "within the current month", "within the current year", "within the
last", "within the next" - For "within the last" and "within the next", you can select a number of hours, days,
months, or years. The corresponding date will be generated as business days if “Check Holidays” is checked
based on the selected holiday calendars.

– "between (absolute)" - You can select from and to dates and times. All trades (that satisfy the other criteria)
between the from and to dates will be loaded.

– "between (relative)" - You can select from and to tenors and times. For example, between 2 weeks ago and
a week ago.

The corresponding dates will be generated as business days if “Check Holidays” is checked based on the
selected holiday calendars.

– "is null" or "is not null".

You can check "Include null" to include trades where the selected date is not set. When you choose “Include Null”
for MaturityDate and FinalValuationDate, the system will check the settlement date if the maturity date / final
valuation date is not set.

For TerminationDate, TerminationEffectiveDate, LastNovationDate, LastNovationTD, since those dates are
stored as trade attributes (keywords), you can filter trades where the keyword is actually set or not set.
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For example, if you have a rule on "TerminationDate / Has keyword", the rule will only be applied to trades for
which the termination date is set. If you have a rule on "Termination Date / Has not keyword", the trade filter will
only load trades for which the termination is not set.

3.4 Product Criter ia Panel
Select the Product Criteria panel to select criteria on the product associated with the trade.

Sample Product Criteria panel

» Select the product criteria described below as needed.

Fields Description
Currency IN Click ... to select product currencies ("Product Currency" column in Trade Browser).

You can uncheck IN to load trades for which the product currency is not in the selected list.

In the case of trades with underlying products, the system checks the currency of the
underlying product.

In the case of trades with multiple legs (cross currency swap for example), the system
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Fields Description
checks each leg's currency.

Product Type IN Click ... to select product types.

You can uncheck IN to load trades for which the product type is not in the selected list.

Product Family IN Click ... to select product families.

You can uncheck IN to load trades for which the product family is not in the selected list.

Rate Index IN Click ... to select rate indices.

You can uncheck IN to load trades for which the rate index is not in the selected list.

Ccy Pair IN Click ... to select currency pairs.

You can uncheck IN to load trades for which the currency pair is not in the selected list.

Sub Type IN Click ... to select product subtypes.

You can uncheck IN to load trades for which the subtype is not in the selected list.

Extended Type IN Click ... to select extended types.

You can uncheck IN to load trades for which the extended type is not in the selected list.

Product Id IN Enter a list of comma-separated products ids.

You can uncheck IN to load trades for which the product id is not in the selected list.

Sec Code Click ... to view all security codes defined in the system. Security codes are created from the
Calypso Navigator using Configuration > Product > Code.

» For each security code, select “In” or “Not In” and enter a value as needed.

Example:

The trade filter will load trades for which the product has the security code DebtSeniority set
to SENIOR_SECURED.

Description Select an operator from the adjacent field, and enter a value.

Example:
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Fields Description

The trade filter will load trades for which the product’s description is
“BondCPIInflation/5Y/03/01/2010/5.15%”.

Market Place IN Check "Check"to display the market places selected in the Trade Criteria panel is any.

You can uncheck IN to load trades for which the market place is not in the selected list.

Has Leg Type IN Click ... to select an exotic type. Exotic types are created from the Calypso Navigator using
Configuration > Product > Exotic Type Creator.

You can uncheck IN to load trades for which the exotic type is not in the selected list.

Reference Entity IN Click Add to select reference entities. A reference entity is a legal entity of type Issuer and
only applies to CDS products.

You can uncheck IN to load trades for which the reference entity is not in the selected list.

3.5 Trade Criter ia Panel
Select the Trade Criteria panel to select trade criteria.

Sample Trade Criteria panel

» Select the trade criteria described below as needed.
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Fields Description
BUY Check to select Buy trades. The direction of the trade is from the processing organization’s

perspective.

SELL Check to select Sell trades. The direction of the trade is from the processing organization’s
perspective.

Internal Checked by default to select internal trades. You can clear to filter out internal trades.

External Checked by default to select external trades. You can clear to filter out external trades.

Internal Reference IN Enter an internal reference.

You can uncheck IN to load trades for which the internal reference is not in the selected list.

Bundle Click ... next to the Bundle field to select a bundle type.

You can then select "Id" or "Name" from the adjacent field, and click ... to select an individual
trade bundle of specified type.

Bundle Attribute Click ... to select bundle attributes. Bundle attributes are specified in the Trade Bundle
window.

» For each attribute, select “Like” or “Not Like”, and enter a value as needed.

Example:

The trade filter will load trades that belong to a bundle for which the bundle attribute
"Business Reason" is set to "Short Term Hedge".

Book IN Click ... to select trading books.

You can uncheck IN to load trades for which the book is not in the selected list.

Trader IN Click ... to select traders.

You can uncheck IN to load trades for which the trader is not in the selected list.

Status IN Click ... to select status codes.

You can uncheck IN to load trades for which the status code is not in the selected list.

Sales IN Click ... to select sales representatives.

You can uncheck IN to load trades for which the sales representative is not in the selected
list.

Book Attribute Click ... to view all book attributes defined in the system. Book attributes are created from
the Calypso Navigator using Configuration > Books & Bundles > Trading Book, Attributes
button.
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Fields Description
» For each attribute, select “In” or “Not In”, and enter a value as needed.

Example:

The trade filter will load trades for which the book attribute Activity is set to TRADING.

Keyword Value Click ... to add a filter on trade keywords.

» Click to add a filter on a trade keyword. You can select as many trade keywords as
needed.

» For each trade keyword, select an operator and select or enter a value.

For the "is in" operator, enter each value on a new row.

» Click OK.

In this example, the trade filter will load trades for which the trade keyword Broker is set to
BROKER A or BROKER B..

Keyword Has Select an operator Has or Not Has. Then click ... to select one or multiple keywords.

The trade filter will load trades for which the selected keywords are set (Has) or not (Not
Has) regardless of their value.

Market Type Click ... to select market types. Market types only apply to bonds trades.

You can uncheck IN to load trades for which the market type is not in the selected list.

Market Place IN Click ... to select market places (legal entities of role MarketPlace).

You can uncheck IN to load trades for which the market place is not in the selected list.

Currency IN Click ... to select trade currencies (“Trade Currency” column in Trade Browser).

You can uncheck IN to load trades for which the currency is not in the selected list.
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Fields Description
In the case of trades with multiple legs (cross currency swap for example), the system
checks the currency of the first leg.

3.6 Underlying Security Panel
The Underlying Security panel only applies to trades with underlying security products (Futures, Future Options, Bond
Options).

Sample Underlying Security panel

» Select the underlying product criteria described below as needed.

Fields Description
Sec Code Click ... to view all security codes defined in the system. Security codes are created

from the Calypso Navigator using Configuration > Product > Code.

» For each security code, select “In” or “Not In” and enter a value as needed.

Example:

The trade filter will load trades for which the product has the security code
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Fields Description
DebtSeniority set to SENIOR_SECURED.

Rate Index IN Click ... to select rate indices.

You can uncheck IN to load trades for which the underlying product’s rate index is not
in the selected list.

Product Type IN Click ... to select product types.

You can uncheck IN to load trades for which the underlying product’s product type is
not in the selected list.

Product Id IN Enter a list of comma-separated products ids.

You can uncheck IN to load trades for which the underlying product’s product id is not
in the selected list.

Market Place IN Click ... to select market places (legal entities of role MarketPlace).

You can uncheck IN to load trades for which the underlying product’s market place is
not in the selected list.

Issuer IN Click Add to select issuers (legal entities of role Issuer)

You can uncheck IN to load trades for which the underlying product’s issuer is not in the
selected list.

3.7 Post Processing Panel
This panel only applies if trade audit is enabled.

Sample Post Processing panel

» Click ... to select status codes. The trade filter will load the trades that satisfy the criteria of the other panels, and
return the versions of the trades for the selected status codes if any.

3.8 Posit ion Spec Panel
This panel only applies if you want to load positions and trades, rather than just trades.
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Sample Position Spec panel

» Select a position specification, or click ... to define a position specification. The trade filter will load the positions
corresponding to the selected position specification.

Such a trade filter can be used to compute risk analyses on positions and trades rather than trades only.

A position specification defines which positions you want to load. The position specification is comprised of the
aggregation criteria (Liquidation/Position Key), and which process you want to use it for:

– Risk and PL - To load positions and trades for the Official PL report and other risk reports.

– Liquidity - To load positions and trades for the Forward Ladder.

– Spot Blotter - Not used.

Recommended setup is provided in the documentation of the corresponding risk reports.

Aggregation criteria are defined from the Calypso Navigator using Configuration > Books & Bundles > Position
Aggregation.

Refer to Calypso Positions Management Documentation for details.

» You can click ... next to the Securities Selection field to select a bond report template to filter bonds. Only bonds
for which there is a corresponding position will be loaded.

» You can check "Exclude Inactive Positions" to exclude all flat positions that are also considered inactive. A
position may be flat but still active in P&L or other applications for some period of time. A position is considered
inactive and excluded only when all of the following are true:

– The position is flat

– It is not a fee position (fee positions cannot be filtered independently of related security positions)

– All trades settle before the valuation date (-1 business day)

– The last liquidation date is before the valuation date (-1 business day)

» You can check "Only Cross Book Positions" to only load positions related to cross books. A cross book allows
grouping multiple books to compute the positions across the books.

» The PositionCash Flow Type flag is used to filter by cashflow type. Use this flag in conjunction with selecting
PositionCash in the Product Type field in the Product Criteria panel.

Refer to Calypso Positions Management Documentation for details.
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3.9 Counterparty Panel
Select the Counterparty panel to select trade counterparty criteria.

Sample Counterparty panel

» Select the trade counterparty criteria described below as needed.

Fields Description

Counterparty IN Click Add to select trade counterparties of selected Cpty Role. If Cpty Role is not set, the
default role is CounterParty.

You can uncheck IN to load trades for which the trade counterparty is not in the selected
list.

Cpty Role IN Click ... to select trade counterparty's role if different from CounterParty.

You can uncheck IN to load trades for which the trade counterparty role is not in the
selected list.

Cpty Attribute Click ... to view all legal entity attributes defined in the system. Legal entity attributes are
created from the Calypso Navigator using Configuration > Legal Data > Entities, Attributes
button.

For each attribute, select “Like” or “Not Like” and enter a value as needed.

Example:

The trade filter will load trades for which the trade counterparty’s attribute DestinationBook
is set to TRADINGA.
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Fields Description

Cpty Status IN Click ... to select trade counterparty’s status codes.

You can uncheck IN to load trades for which the trade counterparty’s status code is not in
the selected list.

3.10 Portfol io Hierarchy Panel
This panel allows you to load trades from portfolio hierarchies.

Sample Portfolio Hierarchy panel

» Select a portfolio as needed.

» You can specify a valuation date if needed.

3.11 Diary Criter ia Panel
This panel only applies to scheduled tasks RATE_RESET, FX_RATE_RESET, and PRICE_FIXING if you want to load
trades that have diary entries. This requires the Diary engine to be running.

Sample Diary Criteria panel

» Select the type of diary entries you want to load.

» Enter diary From and To dates or tenors to limit the selection.

 Ⓘ [NOTE: Diary criteria are only applicable in the scheduled tasks RATE_RESET, FX_RATE_RESET, and PRICE_
FIXING - They are not taken into account otherwise]

3.12 TR / PO Role Panel
This panel allows loading trades based on specific trade keywords related to jurisdiction identifiers.
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Sample TR / PO Role panel

Please refer to Calypso Matching documentation for details on these trade keywords.

3.13 Defining a Trade Fi lter using SQL
Important Notes on SQL Trade Filters

• SQL Trade Filters are not supported in multiple components in the platform. Specifically they will not work in the
real-time features of the risk infrastructure (Calculation Server / Presentation Server / Calypso Workstation).

• The undo functionality in the reports will not work with SQL Trade Filters.

• SQL Trade Filters are not supported in ERS for certain cases. Specifically they will not work for real time features
of the following components: ERS Risk Calculator, OTC Margin Engine.

It is recommended to implement custom criteria instead of using SQL Trade Filters.

Please refer to the Calypso Developer's Guide for details on implementing custom criteria for Trade Filters.

You can enter basic criteria for the trade filter as needed and click Generate SQL to generate the corresponding SQL
query - You can then modify it as needed. The “Use SQL” checkbox will appear checked, and all the panels will be
disabled. Only the SQL query form will appear.

You can also check the “Use SQL” checkbox (blue arrow) directly, and enter your own SQL query.

Selecting “Exclude Future Trades by Trade Date” (red arrow) allows you to exclude trades whose Trade Date is
greater than their Valuation Date Time.
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Sample trade filter using SQL

» Edit the SQL query as needed and click Save.

The SQL From field can contain a list of comma-separated table names to be used in the SQL Where clause.

3.14 Viewing a Trade Fi lter Usage
Load a trade filter and click Usage to view where the trade filter is referenced. has been referenced, for example in
Workflow, Advice Config, TaskStation config, SDI etc. When a trade filter includes another filter (filter in, etc.), the
referencing filters are also listed.

Sample trade filter usage

3.15 Modifying a Trade Fi lter
 Ⓘ [NOTE: If you modify a trade filter, it will impact configurations and reports based on this trade filter]

Load a trade filter and modify as needed.

Then click Save to save your changes.
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3.16 Delet ing a Trade Fi lter
 Ⓘ [NOTE: A trade filter in use cannot be deleted]

Click Delete. You will be prompted to select a trade filter.

3.17 Note on Environment Propert ies
The following environment property applies to trade filters (portfolios):

• DEFAULT_PARENT_FILTER - Name of a Trade Filter used as default parent filter.

• LARGE_LIST_WARNING - If true, and the trade filter is loading a number of trades superior to the maximum
number of trades (user attribute "Max.Trade"), a warning message is displayed and the user is prompted to
proceed with the load. If false, and the trade filter is loading a number of trades superior to the maximum number
of trades, an error message is displayed and the load is suspended.
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4. Defining Trade Keywords (Trade
Attributes)
Trade keywords can be associated with trades for specifying additional information on the trades - Trade keywords
are user-defined, and their value is set on the trade. See below for defining trade keywords.

Some trade keywords are automatically assigned by the system after processing the trades, for example after
exercise, allocation, etc. They are referenced as "system keywords" and are not editable.

Click here for information on system keywords.

Trade keywords offer a loose relationship between trades - The trades that share the same keywords values can be
grouped together for reporting purposes but each trade exists by itself. The trades are not linked.

Trade keywords can then be used for filtering the trades throughout the system.

4.1 Setup
From the Calypso Navigator, navigate to Configuration > System > Keywords & Attributes > Trade Keywords (menu
action core.keyword.TradeKeywordConfigWindow) to define trade keywords.

» All existing keywords are loaded in the Trade Keyword Config window by default.

You can filter the list of keywords using the Filter tab, as needed.

» You can click to configure the column display.

» Trade Keywords are identified by their name throughout the system.
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4.1 .1 Creat ing Trade Keywords

» Click to create a new trade keyword.

» Enter the fields described below in the Details panel.

» Click to save your changes.

Note that if the Authorization mode is enabled, an authorized user must approve your entry.

 Ⓘ [NOTE: Once the trade keywords are saved and authorized, you need to create the data associated with
the trade keywords as described below Creating Trade Keyword Data - However, in order to prevent blocking
the system, when the Trade Keyword Configuration is modified, it is stored in a temporary table until Execute
SQL is run - The new, modified trade keywords will no be available until Execute SQL is run]

Fields Details

Fields Description

Id ID given by the system upon saving.

Version Version number given by the system upon saving.

Name Enter the name that will identify the trade keyword throughout the system.

Type Select the type of trade keyword to determine how the value can be set: Account, Boolean, Double,
Integer, JDate, JDatetime, LegalEntity, Long, String.

Domain For String trade keywords, you can select the domain that contains the available values for the trade
keyword.

 Ⓘ [NOTE: You first need to create the domain in the Domain Values in order to be able to select
it]

Searchable Check if the trade keyword is searchable in the reports, or clear otherwise.

Read-Only Trade Keywords
You can add trade keywords that should be read-only to the domain “readonlyKeyword”.

4.1 .2 Modi fy ing and Removing Trade Keywords
If you have not saved your changes, you can revert by re-loading the configurations.
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 Ⓘ [NOTE: If you delete or modify trade keywords and save your changes, you need to update the data
associated with the trade keywords as described below Creating Trade Keyword Data]

4.1 .3 Disp lay ing Pending Author izat ions

» Click to display any trade keyword pending authorization. This only applies if the Authorization mode is
enabled.

4.1 .4 Creat ing Trade Keyword Data
Once the trade keywords are saved and authorized, you need to create or update the data associated with the trade
keywords.

Follow the steps below:

Step 1 - Click to generate the SQL scripts that allow creating or updating the trade keyword data.

It creates the XML file: <calypso home>/client/bin/dbscripts/TradeKeywordSchemaData.xml

Step 2 - Run Execute SQL, and add the file previously created.

 Ⓘ [NOTE: You need to stop the Data Server prior to running Execute SQL, and you can restart it afterward]

4.2 Assigning Values to Trade Keywords
Choose Trade > Trade Attributes in a Trade window to invoke the Trade Attributes window. You can also click Trade
Attributes in the Details panel of a Trade window.

For FX trades, trade keywords can be set directly in the FX Deal station. For the Pricing Sheet, the Trade Attributes
window can be opened from the Trade Details menu.
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Favorites keywords and system keywords appear by default.

» You can click to toggle between displaying all trade keywords or favorite keywords only.

» You can search trade keywords using the search field.

» You can display editable trade keywords only (keywords that are not system keywords or not in the domain
“readonlyKeyword”).

» To set a trade keyword value, double-click a Value cell corresponding to a trade keyword to and enter its value.
Then click OK.

4.2.1 Adding Trade Keywords
To add typed or searchable trade keywords, choose Configuration > System > Keywords & Attributes > Trade
Keywords.

See Setup for details.

You can also choose Setup > Domain. You will be prompted to enter trade keywords. They will be added to the
domain "tradeKeyword".

4.2.2 Sett ing Favor i te Keywords
Choose Setup > Favorites. You will be prompted to select favorite keywords.

They will be added to the domain “<product_type>.keywords” for the product type of the current trade.

Example:
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4.3 Copying Trade Keywords on Save As New
The domain “TradeKeywordCopier” defines the list of copier classes that need to be used each time a save as new is
called.

The CustomKeywordValidator if it exists, will always be the first copier to be called. All the copiers defined in the
domain will then be called in sequence. You can implement a custom copier by creating a class named
<name>TradeKeywordCopier that implements TradeKeywordCopier. Then register "<name>" in domain
“TradeKeywordCopier”.

Out-of-the-box, the matching module uses DefaultMatchingTradeKeywordCopier to make sure that the trade
attribute MatchedWith is cleared upon save as new.

System keywords that should not be copied upon Save as New are defined in the domain "nonCopiableKeyword".

4.4 Propagating Trade Keywords
Function Description

Allocation Domain = "keywords2CopyUponAllocate"

The system does not automatically copy the custom trade attributes that you set manually
on a trade to the allocated trades. Add trade attributes to the
"keywords2CopyUponAllocate" domain so that the system copies them to the allocated
trades.

Back to Back Trades Domain = "B2BKeywords"

The system does not automatically copy the custom trade attributes that you set manually
on a trade to the back to back trades when the MMLinked trade workflow rule is used. Add
trade attributes to the "B2BKeywords" domain so that the system copies them to the back
to back trades.

Book Transfer Domain = "keywords2CopyUponTransfer"

The system does not automatically copy the custom trade attributes that you set manually
on a trade to the trade generated by a book transfer. Add trade attributes to the
"keywords2CopyUponTransfer" domain so that the system copies them to the generated
trade.

Corporate Action Domain = "keyword2CopyUponCA"

The system does not automatically copy the custom trade attributes that you set manually
on a trade to the trade generated by a corporate action. Add trade attributes to the
"keywords2CopyUponTransfer" domain so that the system copies them to the generated
trade.

Exercise Domain = "keywords2CopyUponExercise"

The system does not automatically copy the custom trade attributes that you set manually
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Function Description

on an option trade to the automatically generated trade created from exercising the option.
Add trade attributes to the "keywords2CopyUponExercise" domain so that the system
copies them to the generated trade.

Expiry

Equity Forward
Settlement

Domain = "keywords2CopyUponExpiry"

The system does not automatically copy the custom trade attributes that you set manually
on an option / future / equity forward trade to the automatically generated trade created
from expiring the option / future or settling the equity forward. Add trade attributes to the
"keywords2CopyUponExpiry" domain so that the system copies them to the generated
trade.

FX Spot Reserve Domain = "keywords2CopyUponSpotReserveSetVal"

The system does not automatically copy the custom trade attributes that you set manually
on a FX Spot Reserve trade to the generated FX Swap trade created from setting the value
date. Add trade attributes to the "keywords2CopyUponSpotReserveSetVal" domain so that
the system copies them to the generated FX Swap trade.

Mirror Trades Domain = "MirrorKeywords"

If you add trade attributes to the "MirrorKeywords" domain, when these trade attributes are
populated on the original trades, they will be saved on the mirror trades as well.

Rollover

Rollback

Domain = "keywords2CopyUponRolloverAndRollback"

The system does not automatically copy the custom trade attributes that you set manually
on a trade to trades generated from the rollover and rollback processes. Add trade
attributes to the "keywords2CopyUponAllocate" domain so that the system copies them to
the new trades.

4.5 Migrat ing Exist ing Trade Keywords
If your trade keywords were created by simply being added to the "tradeKeyword" domain, you may want to migrate
them to the Trade Keyword Configuration window so that they can have a type and be searchable.

Follow the steps below.

From the Calypso Navigator, navigate to Configuration > System > Keywords & Attributes > Trade Keywords (menu
action core.keyword.TradeKeywordConfigWindow).

Step 1 - Click to select the trade keywords you want to migrate. You will be prompted to select keywords, and
define their parameters.
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» Select the new keyword type in the Output field.

» For String trade keywords, you can select the domain that contains the available values for the trade keyword.

 Ⓘ [NOTE: You first need to create the domain in the Domain Values in order to be able to select it]

» Select the format of the existing trade keyword value.

» Click Next.

You will be prompted to create a data file and a migration script.

Select the file names you want to create then click Generate.

Step 2 - Run Execute SQL, and add the file previously created.
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 Ⓘ [NOTE: You need to stop the Data Server]

Step 3 - Execute the migration script previously created.

The default migration script is "MigrateKeywordScript.sql".

You can now restart the system.

4.6 Sett ing Trade Keywords
You can set trade keywords based on Attribute configurations (menu action
refdata.AttributeConfigurationWindow).

You need to add the workflow rule SetInternalAttribute to an action of the Trade workflow, and define the trade
keywords to set in the Attribute Configuration window based on static data filters.

Example:

The following trade keywords are set on the trade:
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4.7 Categorizing Trade Keywords
You can categorize trade keywords based on Trade Keyword Group Window (menu action
refdata.TradeKeywordGroupWindow).

Click to add a new group. You will be prompted to add group name. It should be prefixed with "keywordCategory".
Then select the trade keywords that belong to that group and click Save All.

New groups are saved in the domain "TradeKeywordCategory".

Trade keywords associated with a given group are saved in the domain "keywordCategory.<group name>".

4.8 Keyword Grouping
4.8.1 Trade Keyword Group Window
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Using the Trade Keyword group window:

Open the "Trade Keyword Group Window", Create a group name.

 Ⓘ Note: You must enter the group name as per your preference.

Highlighted in Green are the already existing list of System Keywords that you can add by moving it to the right to be a
part of the Group FXTRADING, you can also create custom keywords as per your requirement, Setup to create a
custom keyword is mentioned below.

These entries get auto created on Domain Values window.
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Creating a Custom Keyword using Domain Value window and adding it to the Trade Keyword group window:

Step 1: Create a new entry under NAME - domainName with VALUE - keyword.TradingTeam for example

Step 2: Update NAME - FX.Keywords with VALUE – TradingTeam as shows below
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Step 3: Update NAME - keyword.TradingTeam with VALUE such as (API, ELECTRONICTRDING, FORWARDTRADER,
G10, G20, LATAM, MENA, NonG10, RFSQ, RISKTRADER, SPOTTRADER, STREMING) as mentioned below

 Ⓘ Note: These values are individual choices, we have selected these just to show as an example.

Step 4: Update NAME - tradeKeyword with VALUE - TradingTeam

Step 5: Adding this Custom keyword (TradingTeam) on the new Keyword Group FXTRADING
l Reopen the "Trade Keyword Group Window"
l Select the new Keyword group FXTRADING
l Search for the new custom keyword that’s created with the name TradingTeam from the Available section and

move it to the Selected Section and hit save post which the Custom Keyword TradingTeam will be saved and
will be a part of your Keyword Group FXTRADING, screen shot below.

Nasdaq Calypso
Trading Environment / Version 18



This is how the Trade Attributes Grouped view would look.

QTE FX PRICER View: Showing the Trade Attribute Grouped view via the Keyword Button.

Nasdaq Calypso
Trading Environment / Version 18

May 2025
Revision 5.0 / Approved

Proprietary and Confidential
Page 54 / 239



May 2025
Revision 5.0 / Approved

Proprietary and Confidential
Page 55 / 239

Nasdaq Calypso
Trading Environment / Version 18



 Ⓘ Note: Along with accessing the Trade Attribute window from the Keywords button on QTE FX PRICER, user
can also make the Trade Attribute window to be a part of this design workplan as a component.

QTE FX PRICER View: Showing the Trade Attribute Grouped view via the Component where it’s a part of the workflow
design (Left) & Trade Attribute Grouped view via the Keyword Button on the right.
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4.8.2 Keyword Order ing
The ordering of the keywords can be directly controlled on the "Trade Keyword Group Window" itself. Let's take
Keyword "TradingTeam" which is currently present on the CalypsoFXTrading Keyword Group on the Trade Keyword
Group Window.
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As you can see the Keyword TradingTeam is currently right at the bottom of the selected Keywords on the Trade
Keyword Group Window under the CalypsoFXTrading Group, due to which the Keyword "TradingTeam" also shows at
the bottom of the keyword group CalypsoFXTrading on the FX Pricer Trade Attributes window.

If the user wants to reorder the keyword TradingTeam on the CalypsoFXTrading Group, all they need to do is select
the keyword TradingTeam with the cursor and drag it towards the Top with the help of the mouse and hit the SAVE
button. (screen shot below), When you now reopen your FX Pricer, you will see that the keyword TradingTeam is
located at the top.
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4.9 Sort ing Trade Keywords
You can sort trade keywords by group in the Trade Keyword Group Window using domain "keywordCategory.<group
name>".

Value = <trade keyword>

Comment = <order number>

The trade keywords are sorted by order number within their group and if they have the same number, by alphabetical
order.

Example:

Domain Name = keywordCategory.Group1

Value = ADRFee

Comment = 1

Domain Name = keywordCategory.Group1

Value = AccountNumber

Comment = 2

Domain Name = keywordCategory.Group1

Value = AccountFee

Comment = 2

The trade keywords will appear as:

keywordCategory.Group1

ADR Fee

AccountFee

AccountNumber

By default trade keywords are sorted in their group by alphabetical order.
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5. System Keywords
This document describes trade attributes (keywords) set by the system.

You can view trade attributes in reports by adding trade attributes columns (usually TRADE_KEYWORD). In reports
using the reporting framework, choose Data > Configure Columns to add trade attributes.

System keywords can be added to the following domains:

• “readonlyKeyword” for keywords that we do not want to be editable from the trade keyword window

• “nonCopiableKeyword” for keywords that we do not want to copy from original trade upon Save As New

5.1 General System Keywords
Keywords Description
AllocatedFrom Trade Allocation

Attaches to the allocated trade(s).

Contains the Trade Id of the allocated trade.

Value = <TradeId>

Example

AllocatedFrom = 10239

ALLOC_ENTERED_USER Trade Allocation
Attaches to the original and allocated trades. Specifies the Calypso user name of the
user who entered the trade allocations.

Value = <CalypsoUserName>

Example

ALLOC_ENTERED_USER = calypso_user

Broker Brokerage Fees
Attaches to trades with brokerage fees. Specifies the name of the broker (the short
name defined for the legal entity). If the broker is NONE, the keyword does not
attach to the trade.

Value = <BrokerName>

Example

Broker = REUTERS

ExercisedOption Option Exercise
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Keywords Description
Attaches to the underlying trade that the system automatically generates when you
exercise the Option trade with physical settlement. Contains the Trade Id of the
Option.

Value = <TradeId>

Example

ExercisedOption = 21206

ExercisedUnder Option Exercise
Attaches to the Option trade. Displays the Trade Id of the underlying trade that the
system automatically generates when you exercise the option.

Value = <TradeId>

Example

ExercisedUnder = 21207

EXERCISED_DATETIME Option Exercise
Attaches to the Option trade. Displays the process date and time for the exercised
option, which you can enter in the Option Exercise Window. The process date and
time is also the Trade Date of the new option that the system generates for physical
settlement.

Value = <DateTime>

Example

EXERCISED_DATETIME = 7/22/04 8:12:21 AM

FXTerminateFwd Trade Termination
Attaches to the terminated trade. Contains the forward rate applied when you
terminate the trade.

Value = <ForwardRate>

Example

FXTerminateFwd = 117.93

LimitExclude ERS Limits
Set this keyword manually to “Y” when you want to exclude the trade from limit
checking.

Value = Y

Value = N (default)

Example

LimitExclude = Y
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Keywords Description
RolledBackFrom Rollback

Attaches to the extension trade. Specifies the Trade Id of the original trade with the
ROLLBACKED status.

Value = <TradeId>

Example

RolledBackFrom = 9415

RolledBackTo Rollback
Attaches to the original trade. Specifies the Trade Id of the extension trade.

Value = <TradeId>

Example

RolledBackTo = 9416

RolledOverFrom Rollover
Attaches to the extension trade. Specifies the Trade Id of the original trade with the
ROLLOVERED status.

Value = <TradeId>

Example

RolledOverFrom = 9513

RolledOverTo Rollover
Attaches to the original trade. Specifies the Trade Id of the extension trade.

Value = <TradeId>

Example

RolledOverTo = 9514

StrategyType Pricing Sheet
Contains the name of the strategy and all of the trade ids that belong to the same
strategy.

Value = <StrategyName>:<TradeId1>,<TradeId2>…

Example

StrategyType = Straddle:52007,52008

TerminationAssignee Trade Termination
Attaches to the terminated trade. Contains the assignee party.

Value = Customer, InterFirm, IntraFirm

Example
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Keywords Description
TerminationAssignee = Customer

TerminationAssignor Trade Termination
Attaches to the terminated trade. Contains who terminated the trade.

Value = CounterParty, Party

Example

TerminationAssignor = CounterParty

TerminationDate Trade Termination
Attaches to the terminated trade. Contains the trade’s termination date.

Barrier Options
Attaches to the triggered Barrier Option trade. Contains the trade’s termination date.

Value = <Date>

Example

TerminationDate = 11-12-2003

TerminationPayIntFlow Trade Termination
Attaches to the terminated trade. Specifies whether to payout the interest and fees
that settle during the period between the date that you process the termination and
the date when the termination actually occurs.

Value = true, false

Example

TerminationPayIntFlow = true

TerminationReason Trade Termination
Attaches to the terminated trade. Contains the reason for the termination.

Value = Assigned, BoughtBack, ContractRevision, Manual

Example

TerminationReason = Assigned

TerminationTradeDate Trade Termination
Attaches to the terminated trade. Contains the date on which you process the
termination.

Barrier Options

Attaches to the triggered Barrier Option trade. Contains the process date and time,
at which the option has a value of 0.

Value = <TradeDateAndTime>
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Keywords Description
Example

TerminationTradeDate = 11/12/03 5:38:23 PM

TerminationType Trade Termination
Attaches to the terminated trade. Either full or partial type.

Value = FullTermination, PartialTermination

Example

TerminationType = FullTermination

Barrier Options
Attaches to Barrier Options that are hit. Contains the details of the hit barrier.

Value = <Up|Down>Barrier<IN|OUT>

Example

TerminationType = DownBarrierOut

TransferDate Attaches to the Vanilla option generated from knocking-in a Barrier option. Contains
the process date.

Value = <ProcessDate>

Example

12-03-2004

TransferFrom Attaches to the Vanilla option generated from knocking-in a Barrier option. Contains
the Trade Id of the Barrier option.

Value = <BarrierOptionTradeId>

Example

TransferFrom = 29308

TransferTradeDate Attaches to the Vanilla option that the system automatically generates when you
knock-in a Barrier option. Contains the process date and time at which the Vanilla
option replaces the Barrier option. Thus, the Vanilla option has a non-zero value.

Value = <ProcessDate> <ProcessTime>

Example

TransferTradeDate = 12/3/04 11:50:36 AM

TransferType Attaches to the Vanilla option generated from knocking-in a Barrier option. Contains
the details of the triggered barrier.

Value = <Up|Down>Barrier<IN|OUT>

Example

TransferType = UpBarrierIN
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5.2 System Keywords Specif ic to FX Trading
Keywords Description
AfterSettlementCutoffTime Value Today Spot Trades

Attaches to FX Spot trades where the trade date and value date are the same,
but the trade time is after the settlement cutoff time for either currency in the
currency pair. The system requires you to enter a mandatory comment with the
trade. You can view the comment in the Trade Blotter in the Comment column.

Value = Y

Example

AfterSettlementCutoffTime = Y

BrokerageFeeType Brokerage Fees
Attaches to trades with brokerage fees. Specifies the method used to calculate
the fee.

Value = Fixed— The fee applies to all trades falling within the configured
range.

Value = Quantity — The fee applies to all trades in the configured range; it
increases according to the specified increment.

Example

BrokerageFeeType = Fixed

CalcAmountCurrency Brokerage Fees
Attaches to trades with brokerage fees where the brokerage fee config uses
the Quantity calculation method. Specifies the currency used in the calculation.

Value = <Currency>

Example

CalcAmountCurrency = USD

CalcAmountUnits Brokerage Fees
Attaches to trades with brokerage fees where the brokerage fee config uses
the Quantity calculation method. Specifies the increment used in the
calculation.

Value = <Amount>

Example

CalcAmountUnits = 1,000,000.00

CashOriginalTradeID Auto-Generated Cash Trades
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Keywords Description
Attaches to trades that the system automatically generates. Contains the
Trade ID of the original trade, which is the trade entered with the customer as
the counterparty.

Value = <TradeID>

Example

CashOriginalTradeID = 35505

CLS

FAR_CLS

NEAR_CLS

CLS Settlement
CLS is set to true on FX trades, when there is a legal agreement of type CLS
between the processing organization and the counterparty. This allows
triggering the CLS settlement process - Refer to the Calypso CLS Integration
Guide for complete details.

Value = true

Example

CLS = true

FX Swaps
For FX Swaps, FAR_CLS and NEAR_CLS are used instead of CLS: one for the far
leg, and one for the near leg.

CLS_ELIGIBLE

CLS_ELIGIBLE_FAR

CLS_ELIGIBLE_NEAR

CLS Settlement
Use CLS_ELIGIBLE to manually override CLS settlement on FX trades in case a
CLS agreement exists between the processing organization and the
counterparty but you do not want to trigger the CLS settlement process. The
trade uses the next settlement method defined by the priority in the settlement
instructions.

Value = false (to override the CLS settlement process)

Example

CLS_ELIGIBLE = false

FX Swaps
For FX Swaps, CLS_ELIGIBLE_FAR and CLS_ELIGIBLE_NEAR are used instead
of CLS_ELIGIBLE: CLS_ELIGIBLE_NEAR allows overriding NEAR_CLS when set
to false, and CLS_ELIGIBLE_FAR allows overriding FAR_CLS when set to false.

ConstProps Pricing Sheet
The system sets this keyword in the FX Options Pricing Sheet when you save a
constant property.

Value = <Property>=<ConstantValue>

Example
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Keywords Description
ConstProps = Term=1M, Strike=1.18

CQS_Spread Spread Engine
The spread from the Customer Quote Server.

Value = <Spread in Basis Points>

Example

CQS_Spread = 4

CurrencyPair Single Currency Cash Flows
Specifies the currency pair that a single currency cash flow (for example, a fee,
premium, loan or deposit) attaches to for inclusion in the position in risk reports.
The system automatically sets this keyword based on the defined currency pair
group configuration. You can manually change the currency pair value to attach
the cash flow to a different currency pair.

Value = <CurrencyPair>

Example

CurrencyPair = EUR/USD

CustomB2BInfo Back-to-Back
Attaches to the original trade when you set a custom B2B configuration in the
B2B Details dialog window.

Value = <CurrencyPair>, <ProductType>, <OriginalBookId>,
<StaticDataFilter>, <PVFwdAmountBoolean>, <TransferMarginBoolean>,
<TransferBookId1>, <TransferBookId2>

Example

CustomB2BInfo = USD/JPY,FXForward,37,NONE,TRUE,TRUE,32,35

CustomB2BSetting Back-to-Back
Attaches to the original trade when you either select the B2B checkbox or clear
the B2B checkbox in the trade window.

Value = YES—When you manually select the B2B checkbox in the trade
window, the system automatically sets the keyword to YES.

Value = NO—When you manually clear the B2B checkbox in the trade window,
the system automatically sets the keyword to NO.

Examples

CustomB2BSetting = YES

CustomB2BSetting = NO

CUSTOMER_QUOTE Customer Quote Engine
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Keywords Description
Attaches to trades saved with an expired quote from the Customer Quote
Engine.

Value = <ExpiredMessage>

Example

CUSTOMER_QUOTE = Quote for USD/JPY expired

CustomForwardRiskTransferSetting Forward Risk Transfer
Attaches to the original trade. Contains a value if you use a different book than
the book specified in the forward risk transfer routing.

Forward risk transfer routing is done for FXNDF trades.

CustomSplitInfo Cross-Currency Split
Attaches to the original trade. Contains a value if you use a different book than
the book specified in the split routing.

Value = <SplitCcy>, <CcyPair1Base>, <Book1Id>, <CcyPair2>, <Book2Id>

Example

CustomSplitInfo = USD,USD/CAD,8307,USD/JPY,6903

CustomSplitSetting Cross-Currency Split
Attaches to the original trade. Contains a value if you switch on or off splitting
manually (Split checkbox), that is, the setting on the trade is different from the
split configuration.

Value = Split or No split

Example

CustomSplitSetting = NO

CustomTransferInfo Spot Risk Transfer
Attaches to the original trade. Contains the book id for the transfer trade if you
select a different book than specified in the spot risk transfer routing.

Value = <CustomBookId>

Example

CustomTransferInfo = 37

CustomTransferSetting Spot Risk Transfer
Attaches to the original trade if you switch on or off the transfer function
manually, that is, the setting is different from the routing.

Value = YES— A spot risk transfer configuration does not exist; you manually
select Spot Tran in the trade window.

Nasdaq Calypso
Trading Environment / Version 18

May 2025
Revision 5.0 / Approved

Proprietary and Confidential
Page 68 / 239



May 2025
Revision 5.0 / Approved

Proprietary and Confidential
Page 69 / 239

Keywords Description
Value = NO— The system selects Spot Tran because a configuration exists for
the currency pair and book that you selected; you manually deselect Spot Tran
in the trade window.

Example

CustomTransferSetting = NO

EFP_FUTURE_TRADE Exchange For Physical (EFP)
Attaches to the FX trade. Contains the Future FX trade id.

Attaches to the FX offset trade. Contains the Future FX trade id.

Value = <FutureFXTradeId>

Example

EFP_FUTURE_TRADE = 49009

EFP_OFFSET_TRADE Exchange For Physical (EFP)
Attaches to the FX trade that you exchange for the Future FX. Contains the FX
offset trade id.

Value = <FXOffsetTradeId>

Example

EFP_OFFSET_TRADE = 49010

EFP_SPOT_TRADE Exchange For Physical (EFP)
Attaches to the Future FX trade created from saving the EFP deal. Contains the
original FX trade id.

Attaches to the FX offset trade. Contains the original FX trade id.

Value = <SpotTradeId>

Example

EFP_SPOT_TRADE = 49007

ExecutedFromOrderId FX Order Management
Attaches to the trade that fills an order. Contains the Order Id from the
customer order.

Value = <OrderId>

Example

ExecutedFromOrderId = 11509

FAR_MARGIN FX Swap
Specifies the margin set on the far leg of the swap. The system sets this
keyword to be blank for FX swaps that do not have a spot margin.
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Keywords Description
Value = <MarginPoints>

Example

FAR_MARGIN = 1

FAR_MARGIN_FWD_PART FX Swap
Specifies the margin points attributed to the forward trader.

Value = <MarginPoints>

Example

FAR_MARGIN_FWD_PART = 8

FwdPointForSMHedge FX Sales Margin Hedge
Stores the forward points used in the calculation of the sales margin hedge
amount. The value is empty if the forward points are zero.

Value = <ForwardPoints>

Example

FwdPointForSMHedge = 10

FwdPointForFarLegSMHedge FX Sales Margin Hedge
Stores the forward points on the FX Swap far leg used in the calculation of the
sales margin hedge amount.

Value = <ForwardPoints>

Example

FwdPointForFarLegSMHedge = 10

FXBulkTrade FX Spot, FX Spot Reserve, and FX Forward
Displays the trade date of a trade entered in the FX Bulk Trades window.

Value = <TradeDate>

Example

FXBulkTrade = 12/11/2003

FXHRRFirstRollDt Rollover and Rollback
Attaches to the extension trade(s). Contains the date of the original trade
rollover.

Value = <RolloverDate>

Example

FXHRRFirstRollDt = 05/13/2004

FXHRRFundingIntRate Rollover and Rollback
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Keywords Description
Attaches to the extension trade when you apply a rollover or rollback to a trade.
Specifies the rate for funding the rollover or rollback using the historical rate.

Value = <FundingRate>

Example

FXHRRFundingIntRate = 0.02554812039517475

FXHRRFundingPtPips Rollover and Rollback
Attaches to the extension trade. Specifies the funding points in pips.

Value = <FundingPointPips>

Example

FXHRRFundingPtPips = 0.030695938866199996

FXHRRHistoricalRate Rollover and Rollback
Attaches to the extension trade. Specifies the historical spot rate used in the
original trade.

Value = <HistoricalRate>

Example

FXHRRHistoricalRate = 117.38

FXLinkedStatusAwaitTTM FX TTM
Set for all trades linked to a TTM trade for which the TTM rate has not been set.

Value = Y

Example

FXLinkedStatusAwaitTTM = Y

FXOpt_Hedge_TradeId FX Option Hedge Trade
Attaches to the FX Option trade. Displays the Trade Id of the spot or forward
hedge trade the system automatically generates.

Value = <TradeId>

Example

FXOpt_Hedge_TradeId = 19311

FXOriginalTradeID Auto-Generated FX Trades
Attaches to trades that the system automatically generates, including trades
generated from mirror deals, spot risk transfer, cross-currency split, spot
mismatch, and back-to-back. Contains the Trade ID of the original trade, which
is the trade entered with the customer as the counterparty.

Value = <TradeID>
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Keywords Description
Example

FXOriginalTradeID = 35505

FXPricingEnv All FX Products
Attaches to all FX trades that you enter in the system (original trades, not
generated trades). Specifies the name of the pricing environment (PE) used
when you saved the trade.

Value = <PEName>

Example

FXPricingEnv = default

FXRollOverFarFwdPt Rollover and Rollback
Attaches to the swap extension trade. Specifies the forward points for the far
leg.

Value = <ForwardPoints>

Example

FXRollOverFarFwdPt = -51.56000000000063

FXRollOverNearFwdPt Rollover and Rollback
Attaches to the swap extension trade. Specifies the forward points for the near
leg.

Value = <ForwardPoints>

Example

FXRollOverNearFwdPt = -18.319999999999936

FXRollOverSpotRt Rollover and Rollback
Attaches to the swap extension trade. Specifies the spot rate used in the swap
extension trade.

Value = <SpotRate>

Example

FXRollOverSpotRt = 118.40

FXSpotResTransFrom FX Spot Reserve
In the swap trade, contains the original Spot Reserve Trade Id.

Value = <SpotReserveTradeId>

Example

FXSpotResTransFrom = 6707

FXSpotResValDtBeforeSpot FX Spot Reserve
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Keywords Description
When you set a value date on the Spot Reserve that is before the spot date,
this keyword attaches to the generated swap.

Value = Y

Example

FXSpotResValDtBeforeSpot = Y

FXTerminateFwd Trade Termination
Attaches to the terminated trade. Contains the forward rate applied when you
terminate the trade.

Value = <ForwardRate>

Example

FXTerminateFwd = 117.93

FXTerminateMargin Trade Termination
Attaches to the terminated trade. Contains the margin points applied when you
terminate the trade.

Value = <MarginPoints>

Example

FXTerminateMargin = 2

FXTerminateSpot Trade Termination
Attaches to the terminated trade. Contains the spot rate applied when you
terminate the trade.

Value = <SpotRate>

Example

FXTerminateSpot = 117.88

HedgedTrades FX Options Pricing Sheet
Attaches to the trades linked for hedging. Contains the trade ids of the trades.

Value = <TradeId>

Example

HedgedTrades= 52005, 52006

INCEPTION_CURRENCY FX Options
Attaches to the saved trade. Specifies the currency used in the inception PL
calculation, which is the delta currency for the currency pair.

The delta currency is the quoting currency in the currency pair by default.
However, in the Currency Defaults you can set the Primary Delta Term flag to
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Keywords Description
set the primary currency as the delta currency.

Value = <Currency>

Example

INCEPTION_CURRENCY = USD

INCEPTION_PL FX Options
Attaches to the saved trade. Contains the Inception PL.

Inception PL = PV trade + PV fees + PV hedge trade

Value = <InceptionPL>

Example

INCEPTION_PL = 5,909,057.68

INCEPTION_PV FX Options
Attaches to the saved trade. Contains the option PV.

Value = <PV>

Example

INCEPTION_PV = 63,293.93

INCEPTION_FEE FX Options
Attaches to the saved trade. Contains the PV of the premium.

Value = <FeePV>

Example

INCEPTION_FEE = -63,293.67

INCEPTION_HEDGE_PV FX Options
Attaches to the saved trade. Contains the hedge trade PV.

Value = <HedgePV>

Example

INCEPTION_HEDGE_PV = 5,909,057.42

InternalRate Spread Engine
Rate from the curve + spread.

Value = <Rate>

Example

InternalRate = 10.8084

LateTradeDatetime This keyword should de used in the context of late FX trades, and should
contain the position effective date and time.
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Keywords Description
Please refer to Calypso Position Management documentation for complete

details.

LE_CapitalSpread Spread Engine
Stores the capital spread applied to loan trades. The capital spread is defined
in the legal entity attribute Capital Spread.

Value = <Spread in Basis Points>

Example

LE_CapitalSpread = 25

MarginFXCcyPair FX Margin
Currency pair of the FX quote used in the margin calculation.

Value = <CurrencyPair>

Example

MarginFXCcyPair = EUR/USD

MarginFXRate FX Options
Stores the rate used to convert the margin amount to the converted margin
amount. Used when the premium currency is different than the margin
currency, for example, the premium currency is the primary currency and the
margin currency is the base currency as defined in the pricing environment.
The converted margin amount is the FX Option margin fee that attaches to the
trade.

Value = <FXRate>

Example

MarginFXRate = 1.1812

MarginRate FX Options
Displays whether the sales margin is a percentage of the base amount or
entered as pips, and the rate.

Value = <%> or <pips>

Examples

MarginRate = %=1.00

MarginRate = Pips=200

MirrorTrader FX Options
Attaches to the trade generated from exercise of the FX Option. Displays the
trader name from the FX Option trade.

Value = <TraderName>
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Keywords Description
Examples

MirrorTrader = TRADER1

NegotiatedCurrency FX Products
An FX transaction is typically made up of two currency amounts, CCY1 and
CCY2 and a rate, with these three inputs always triangulating. When an FX
transaction is negotiated, one of the currency amounts (CCY1 or CCY2) and the
rate are negotiated between the two parties and the other currency amount is
calculated off the first two. The currency that is negotiated is called the
Negotiated Currency and needs to be held “locked” for the life of the trade. The
“locking” on the negotiated currency needs to be stored with the trade and be
available when ever the trade is brought up again, or any trade lifecycle
performed on it.

When you enter an amount in the primary amount or secondary amount field,
the application automatically assumes that currency is the negotiated
currency. It locks that currency for the life of the trade, and displays the locked
padlock icon next to that amount field.

When you save the trade, the trade keyword NegotiatedCurrency stores the
currency value.

Value = <LockedCurrency>

Example

NegotiatedCurrency = EUR

No_Calc_Exp No longer used since v15 Maint.

Replaced by Expiry Delivery Link property.

Off_Market_Rate FX Products
Attaches to a trade saved with a rate that is outside of the tolerance range
defined for the currency pair in the Deal Entry Rate Tolerance configuration.
The Comment column in the Trade Browser displays the Deal Entry Rate
Tolerance Comment required for saving the trade.

Value = Y

Example

Off_Market_Rate = Y

PreciousMetal-allocation Precious Metals
Attaches to the precious metal trade captured in the FX Spot, FX Forward, FX
Swap, or FX Option trade window. Specifies whether the precious metal is
allocated or unallocated.

Allocated—when a client requires the precious metal to be physically
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Keywords Description
segregated, with a list of bar weights and assays (purity tests). Each bar has an
identification code against which its details are recorded and the client holds
full title of this bar. It is merely held in custody.

Unallocated—when specific bars are not set aside and the client retains a
general entitlement to the metal. It is at its most convenient in this form, as it
can be credited and debited electronically between parties.

Value = <allocated | unallocated>

Example

PreciousMetal-allocation = allocated

PreciousMetal-location Precious Metals
Attaches to the precious metal trade captured in the FX Spot, FX Forward, FX
Swap, or FX Option trade window. Specifies the location where the precious
metal trades.

Value = <Location>

Example

PreciousMetal-location = London

PreciousMetal-loco-spread Precious Metals
Attaches to the precious metal trade captured in the FX Spot, FX Forward, FX
Swap, or FX Option trade window. Specifies the location spread over the base
rate.

Value = <LocationSpread>

Example

PreciousMetal-loco-spread = .3

PreciousMetal-loco-spread-
converted

Precious Metals
Attaches to the precious metal trade captured in the FX Spot, FX Forward, FX
Swap, or FX Option trade window. Specifies the location spread over the base
rate, converted to the cross pair (for example, the unconverted spread is in
XAU/USD, and the converted spread is in XAU/AUD).

Value = <LocationSpreadConverted>

Example

PreciousMetal-loco-spread-converted = .0025

PremRate FX Options
Displays whether the premium is a percentage of the base amount or entered
as pips, and the rate.

Value = <%> or <pips>
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Keywords Description
Examples

PremRate =%=-1.05467

PremRate =Pips=-2.00000

Primary Specialist Sales Margin
For reporting purposes, you can define the primary specialist for the sales
counterparty in the Primary Specialist legal entity attribute. During trade
capture, the system automatically sets the primary specialist name in the
Primary Specialist trade keyword. You can include the Primary Specialist trade
keyword in the Sales Margin Report to report the fee with the primary
specialist.

Value = <PrimarySpecialistName>

Example

Primary Specialist = John Doe

RatesPrecision All FX Products
Attaches to FX trades. Displays the decimal precision for the rate fields. It takes
the default values defined by currency pair in the Currency Default window.
However, you can change the precision in the trade window by selecting the
rate field and pressing [F12] to increase the precision or [F11] to decrease the
precision.

Value = <Ccy1>/<Ccy2>=<DecimalPrecision>

Also displays the precision for cross-currency split pairs:

<SplitPr1Ccy1>/<SplitPr1Ccy2>=<DecimalPrecision>

<SplitPr2Ccy1>/<SplitPr2Ccy2>=<DecimalPrecision>

Examples

RatesPrecision = USD/JPY=4

RatesPrecision = CAD/JPY=5,USD/JPY=15,USD/CAD=4

ROUNDING All FX Products
This keyword contains the rounding method applied to the trade.

Value = NEAREST, UP, DOWN

Example

ROUNDING = UP

SalesB2B Back-to-Back
Attaches to the original trade. Contains the id(s) of the transfer book(s).

Value = <TransferBookId>…
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Keywords Description
Examples

SalesB2B = Transfer To=7803

SalesB2B = Spot Transfer Book=7803,Swap Transfer Book=7804

SalesB2BFrom Back-to-Back
Attaches to the SalesB2B internal trade(s). Contains the Trade Id of the original
trade.

Value = <OriginalTradeId>

Example

SalesB2BFrom = 8025

SalesB2BTo Back-to-Back
Attaches to the original trade. Contains the Trade Id(s) of the SalesB2B internal
trades(s).

Value = <SalesB2BTradeId>

Example

SalesB2BTo = 8026,8028

SalesMargin Spread Engine
Sales margin applied to the trade; total of the spreads.

Value = <Margin in Basis Points>

Example

SalesMargin = 29

SavedTransferInfo Spot Risk Transfer
Attaches to the trade that originated the spot risk transfer. Contains the
transfer details, regardless if the transfer uses a configuration or a custom
setting.

Value = <CcyPair>, <ProductType>, <BookId>, <TransferBookId>

Example

SavedTransferInfo = USD/JPY,FXForward,38,7754

SavedXccySplitInfo Cross-Currency Split
Attaches to the trade that originated the cross-currency split. Contains the split
details, regardless if the split uses a configuration or a custom setting.

Value = <CrossPair>, <ProductType>, <BookId>, <SplitCcy>, <SplitPair1>,
<SplitPair1BookId>, <SplitPair2>, <SplitPair2BookId>

Example
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SavedXccySplitInfo = AUD/JPY,FX,32,USD,AUD/USD,32,USD/JPY,32

In this example, the system generated all trades in the same book.

SavedXccySpotMismatchInfo Cross-Currency Split with Spot Mismatch
Attaches to a cross-currency trade that has a spot mismatch. One or both of
the spot dates on the split trades do not match the spot date on the original
trade. The system generates an FX Swap deal to account for the difference.
The keyword contains the details of the generated FX Swap deal.

Value = <SplitPair>, <OriginalBookId>, <FXSwapBookId>

Example

SavedXccySpotMismatchInfo = USD/CAD,353,8308

ScratchPadTrade FX Options
Attaches to trades that you save by clicking WhatIf in the trade window. These
are temporary trades.

Value = Y

Example

ScratchPadTrade = Y

SINGLE_CONFIRM Bulk FX Option
Attaches to trades that you save in the Bulk FX Option application. Specifies
whether the system generates one bulk confirmation including the details of
each trade, or an individual confirmation statement for each trade.

Value = true — one bulk confirmation generated.

Value = false (default value) — confirmations generated for each trade.

Example

SINGLE_CONFIRM = true

SINGLE_PAYMENT Bulk FX Option
Attaches to trades that you save in the Bulk FX Option application. Specifies
whether the system generates a single netted premium payment, or individual
premium payments for each trade.

Value = true — one netted premium payment.

Value = false (default value) — individual premium payments.

Example

SINGLE_PAYMENT = true

SPOT_MARGIN All FX Products
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Keywords Description
Specifies the margin points. The system sets this keyword to be blank for FX
products that do not have a spot margin.

Value = <MarginPoints>

Example

SPOT_MARGIN = 2

SPOT_MARGIN_FWD_PART FX Forward, FX TTM, FX NDF, FX Option Forward
Specifies the margin points attributed to the forward trader.

Value = <MarginPoints>

Example

SPOT_MARGIN_FWD_PART = 8

SPOT_RES_TTM_TRADE_ID TTM with Spot Reserve
Attaches to the generated Spot Reserve trade. Specifies the Trade Id of the
original TTM trade.

Value = <TTMTradeId>

Example

SPOT_RES_TTM_TRADE_ID = 16927

SPOT_RISK_TRANS_AMT Spot Risk Transfer
Attaches to the original trade. Contains the transfer amount for the
automatically generated trade. By default, the transfer amount for the Spot Risk
Transfer is opposite the value of the PV pricer measure (-PV).

Value = <TransferAmount>

Example

SPOT_RISK_TRANS_AMT = -1072.39

SPOT_ROLLOVER FX Position Rollover
Attaches to the original spot trade. Specifies the currency pair, roll date, and
book for the new trade.

Value = <PositionCcy>, <HomeCcy>, <RollFromDate>, <RollOverBookId>

Example

SPOT_ROLLOVER = JPY,USD,05/14/2004,8305

Spot_Transfer_From Spot Risk Transfer
Attaches to the transfer trade. Contains the original Trade Id.

Value = <OriginalTradeId>

Example
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Spot_Transfer_From = 7368

Spot_Transfer_To Spot Risk Transfer
Attaches to the original trade. Contains the transfer Trade Id.

Value = <TransferTradeId>

Example

Spot_Transfer_To = 7369

SpotRateForSMHedge FX Sales Margin Hedge
Stores the spot rate used in the calculation of the sales margin hedge amount.

Value = <SpotRate>

Example

SpotRateForSMHedge = 108.03

Spread Spread Engine
Stores the spread as defined in the spread configuration and captured in the
trade.

Value = <Spread in Basis Points>

Example

Spread = 11

Subsidiary FX Options Sales Margin
Attaches to option trades where the sales margin is generated between the
trading book processing organization and the parent of the subsidiary. Stores
the name of the subsidiary.

Value = <SubsidiaryLegalEntityShortName>

Example

Subsidiary = CHICAGO

TTM_SPOT_RES_ID TTM with Spot Reserve
Attaches to the original TTM trade. Specifies the Trade Id of the generated
Spot Reserve trade.

Value = <SpotReserveTradeId>

Example

TTM_ SPOT_RES _ID = 16928

ValueDateSet Spot Reserve
Attaches to the original Spot Reserve trade. Specifies that the value date is set.
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Value = Y

Example

ValueDateSet = Y

VOLATILITY FX Options
Contains the volatility captured in the trade.

Value = <Vol%>

Example

VOLATILITY = 9.3117

VOLATILITY1 FX Options
Contains the market volatility.

Value = <Vol%>

Example

VOLATILITY1 = 9.3389

XCcySplitRates Cross-Currency Split
Attaches to the original trade and split trades. Specifies the rates of the split
cross-currency trades.

Value = <CcyPair1>=<SpotRate1>,<CcyPair2>=<FwdRate2>,
<CcyPair1>=<FwdRate1>,<CcyPair2>=<SpotRate2>

Example

XCcySplitRates = USD/CAD_SPOT=1.3375, USD/JPY_FWD=0.0, USD/CAD_
FWD=0.0, USD/JPY_SPOT=107.94

XCcy_Offset_From Cross-Currency Split
You can create the split trades in the same book as the original trade for the
cross pair. Also, you can create one split trade in the original book and the other
split trade in a different book. In these cases, the system generates an offset
trade for the split trade(s), which is the reverse of the split trade. The keyword
attaches to the offset trade and contains the Trade Id of the split trade.

Value = <SplitTradeId>

Example

XCcy_Offset_From = 41404

XCcy_Offset_To Cross-Currency Split
You can create the split trades in the same book as the original trade for the
cross pair. Also, you can create one split trade in the original book and the other
split trade in a different book. In these cases, the system generates an offset
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trade for the split trade(s), which is the reverse of the split trade. The keyword
attaches to the split trade and contains the Trade Id of the offset trade.

Value = <OffsetTradeId>

Example

XCcy_Offset_To = 41406

XCcy_Split_From Cross-Currency Split
Attaches to the split trade. Contains the id of the trade that originates the split
trades.

Value = <OriginalTradeId>

Example

XCcy_Split_From = 10805

XCcy_Split_Fwd_Only Cross-Currency Split
You can select to create split trades for the forward points, only. Attaches to
the original trade.

Value = Y

Example

XCcy_Split_Fwd_Only = Y

XCcy_Split_To Cross-Currency Split
Attaches to the original trade. Contains the ids of the split trades.

Value = <SplitTrade1Id>,<SplitTrade2Id>

Example

XCcy_Split_To = 10808,10810

XCcy_Split_Trade1_Offset_To Cross-Currency Split
Attaches to the original trade when the system generates one or both split pair
trades in the same book as the original trade. Contains the Trade Id of the first
split trade.

Value = <SplitTradeId> or <SplitTrade1Id>

Example

XCcy_Split_Trade1_Offset_To = 41406

XCcy_Split_Trade2_Offset_To Cross-Currency Split
Attaches to the original trade when the system generates both split pair trades
in the same book as the original trade. Contains the Trade Id of the second split
trade.
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Value = <SplitTrade2Id>

Example

XCcy_Split_Trade2_Offset_To = 41408

XCcyInternalSplit Cross-Currency Split
When you split a cross-currency position (or recreate a cross-currency
position) in the Spot Position Blotter by using the “Split Position Trade”
function, the XCcyInternalSplit=YES keyword attaches to the trade that you
capture. It causes the system to generate the internal split trades, and prevents
mirror trades from being generated.

Value = <YES | NO>

Example

XCcyInternalSplit = YES

XccySptMismatchRates Spot Mismatch
Attaches to the original trade, mismatch swap, and split trades. Stores the spot
rates and forward points for the mismatch swap trade(s).

Value = <CcyPair1>=<SpotRate>,<CcyPair2>=<FwdPts>,
<CcyPair1>=<FwdPts>,<CcyPair2>=<SpotRate>

Example

XccySptMismatchRates = USD/CAD_SPOT=1.3365, USD/JPY_FWD=0.0,
USD/CAD_FWD=-10.0, USD/JPY_SPOT=107.94

XccySptMismatchSplitFrom Spot Mismatch
Attaches to the mismatch swap trade. Contains the id of the trade that
originates the mismatch.

Value = <OriginalTradeId>

Example

XccySptMismatchSplitFrom = 10805

XccySptMismatchSplitTo Spot Mismatch
Attaches to the original trade. Contains the id of the mismatch swap trade.

Value = <Ccy1/Ccy2>=<SwapTradeId>…

Note: There could be a second mismatch swap for the second currency pair.

Example

XccySptMismatchSplitTo=USD/CAD = 10806
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6. Defining Audit Filters
An audit filter is a set of audit fields that can be monitored to determine if a process can be performed.

Audit filters are currently used in the following processes:

• To determine if a message should be regenerated in case a trade is modified, and the modified fields belong to
the audit filter associated with the message configuration.

• To determine if a workflow action should be applied in case a trade is modified, and the modified fields belong to
the audit filter associated with the action.

From the Calypso Navigator, choose Configuration > Filters > Audit Filter to define audit filters (menu action
refdata.audit.AuditFilterWindow).

Audit Filter window

» All existing filters are loaded by default.

You can filter the list of audit filters using the Filter tab, as needed.

» You can click to configure the column display.

» Audit Filters are identified by their name throughout the system.
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6.1 Creating Audit Fi l ters
» Click to create a new audit filter.

» Enter the fields described below in the Details panel.

» Click to save your changes.

Note that if the Authorization mode is enabled, an authorized user must approve your entry.

Fields Details

Fields Description
Id ID given by the system upon saving.

Version Version number given by the system upon saving.

Name Enter the name that will identify the audit filter throughout the system.

Type Select the reference object where the fields are coming from.

Currently, you can select Trade.

Audits Click to select the fields of the audit filter.

• Fee types and their state: added, removed, modified.

• Trade keywords and their state: added, removed, modified.

• Trade fields that have been modified.

• Other fields that have been modified.

 Ⓘ [NOTE: Product fields are not supported by the audit filter]

6.2 Displaying Pending Authorizat ions
» Click to display any audit filter pending authorization. This only applies if the Authorization mode is enabled.
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7. Analytics Menu
The Analytics menu allows running risk analyses on-the-fly for the trade currently loaded in the trade worksheet.

Also, the Analytics menu usually contains a solver to solve for a target NPV or other indicators, and a solver panel.

Menu Items Description
Solve (F9) The Solve function is not implemented by default for all product types. However, you can

create a custom Solver. Refer to the Calypso Developer’s Guide for details.

Sample Swap Solver

» Select a target pricer measure and enter the target value. Then select the value to solve
for (pay rate, receive rate, or FX rate), and click Solve.

» You can click Apply to set the value to solve for on the trade. In this example, the Pay leg
is fixed, and the result is applied to the fixed rate.

For a floating leg, the result would be applied to the spread.

Then click Price to obtain the target value.

» You can modify the solver variables and details as needed.

Solver Panel To add the bond solver panel to the fixed leg of a swap.
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Menu Items Description

Before using the solver, you can press [F11] to calculate the break-even rate on the swap.

Next, select a bond or bond spread from the Product field. You can click ... to add bonds or
bond spreads.

The latest price of the selected product will appear in the Price field. Enter it otherwise.

When you enter a price, the solver calculates the bond yield and the implied spread (in basis
points) against the fixed rate.

To apply a spread to your fixed rate, type the spread in basis point in the spread field and
press [Enter].

Calibration To perform on-the-fly calibration of a pricing model according to user-defined parameters.

Refer to Calypso Calibration documentation for details.

On Demand Analysis You can run risk analyses on-the-fly on the trade, using one of the following methods:

• Choose On Demand Analysis, and select the Ad Hoc panel - Select the input
parameters and the analysis parameters, and click Run.

• Choose On Demand Analysis, and select the On Demand panel - Select the input
parameters and click a predefined analysis, and click Run.

The results will be displayed in the Calypso Workstation or saved to a file, based on the
selected parameters.

Refer to Calypso On Demand Analysis documentation for details.

On Demand Analysis
Speed Buttons

To define risk speed buttons.

Risk speed buttons can be accessed from On Demand Analysis Shortcuts.

Refer to Calypso On Demand Analysis documentation for details.

On Demand Analysis
Shortcuts

You can run risk analyses on-the-fly on the trade, from On Demand Analysis Shortcuts, and
select a risk speed button, provided you have defined risk speed buttons.

The results will be displayed in the Calypso Workstation or saved to a file, based on the
selected parameters.

Risk speed buttons can be defined using On Demand Analysis Speed Buttons.
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8. Back Office Menu
The menu items of the Back Office menu are described below.

Menu Items Description
BO Browser Opens the Back Office Browser to view back office details.

See Back Office Browser for complete details.

Action Not applicable.

Terminate Opens the Termination window that allows terminating a trade, partially or fully.

» Click Help in the Termination window for details.

Configure Fee Columns Opens a dialog to select what columns to display in the Fees panel.

Audit Opens the Trade Audit Viewer.

» You can view audit information by Trade ID or by Internal Reference if applicable.

» Select "Versions" to see the different versions of the trade, or select "Field Details" to
see the details of the modified fields.

» Select a version and click View Version to see the corresponding version of the trade.
You can also double-click a version.

» Click Show Back Office Audit, and select the BO Audit Panel to display all elements
related to the trade that have been created or modified.

» The Bundle Audit Panel displays activity related to the actual trade bundles, while the
Trades Bundled Audit Panel displays activity related to all of the trades in the specified
bundle.
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Menu Items Description
» The Exotics Panel displays activity related to exotic structures. Select "Exotics" then

select the Exotics Panel to view the details.

Note that the Audit mode must be enabled. Refer to the Calypso Security User Guide for
details.

Show Generic
Comment

Displays comments if any in the Generic Comments report.

Add Generic Comment Brings up the Add Generic Comment window that allows associating comments and
documents with various types of objects.

» Select a comment type and enter a comment.

Comment types are defined in the "genericCommentType" domain.

You can predefine comments in the domains "generic<object>Comment", for example
"genericTradeComment". They will be available for selection from the Comment field.

» You can check URL to indicate that the comment is a URL, provided it is entered as a
fully qualified URL. Example: http://www.google.com.

It appears as a link in the Generic Comment Report. You can double-click the link to
bring up the URL in your default browser.

» You can also attach a document , delete an attachment , and open any existing
attachment .

The types of documents available for upload can be defined in the domain
“genericCommentDocumentExtensions”. Examples:

– pdf

– txt

If the domain is not defined, any type of document can be uploaded.

The environment property GENERIC_COMMENT_MAX_DOCUMENT_SIZE restricts the
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Menu Items Description
size of the document attached to a generic comment. The max size can be set in bytes,
Kilos, Megas or Gigs such as 200000, 100K, 10M, 1G.

» Then click Save.

Custom Data Opens a custom data window provided trade custom data are specified, a custom data
window is implemented, and a custom trade validator is implemented for this type of trade.

Note that you can also create a custom trade panel for entering custom trade data.

Refer to the Calypso Developer’s Guide for information on handling trade custom data.

Allocate Opens the Allocation window that allows allocating a block trade to multiple books or legal
entities. When allocating a block trade, child trades are created for each book or legal entity
to which the block trade is allocated. The allocation can be manual, or according to an
allocation template. The allocation is performed based on a percentage of the notional
amount of the block trade.

» Click Help in the Allocation window for details.

Switch Collateral This option is available in the Advance window. Selecting this menu option displays the
Switch Collateral window.

Refer to Calypso Advances documentation for details.

Historical Pricing Allows a user to bring up past trades with past data based on val date. It can be used for
auditing.
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9. File Menu
The menu items of the File menu are described below.

Menu Items Description
Trade Details Brings up the Trade Details window.

See Trade Details For details.

BO Browser Brings up the BO Browser.

See BO Browser for details.

Fee Details Brings up the Fees window.

Refer to Calypso Fees, Haircuts and Sales Margins documentation for details.

Keywords Bring up the Keywords window.

See Trade Keywords for details.

Trade Allocation Opens the Allocation window that allows allocating a block trade to multiple books or legal
entities. When allocating a block trade, child trades are created for each book or legal entity
to which the block trade is allocated. The allocation can be manual, or according to an
allocation template. The allocation is performed based on a percentage of the notional
amount of the block trade.

» Click Help in the Allocation window for details.

Trade Rollover Does not apply to FX Options.

Opens the Trade Rollover window that allows extending the duration of a trade.

» Click Help in the Rollover window for details.

Trade Termination Opens the Termination window that allows terminating a trade.

» Click Help in the Termination window for details.

Save As Template To save the trade as a template. You will be prompted to enter a template name and specify
whether the template is private or public. Other users will not be able to use private tem-
plates.

Delete Template To delete a template. You will be prompted to select a template.

Only the user who created a template (whether it is public or private) can delete it.

You can also delete templates from the Calypso Navigator using Utilities > Maintenance >
Monitoring > Clean-up > Clean-up Database > Products panel.

Refer to Calypso Utilities documentation for details.

Exercise Opens the Exercise window that allows exercising and expiring options.

» Click Help in the Exercise window for details.

Trade Audit Opens the Trade Audit Viewer.
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Menu Items Description

» Select Versions to see the different versions of the trade, or select Field Details to see
the details of the modified fields.

» Select a version and click View Version to see the corresponding version of the trade.
You can also double-click a version.

» Click Show Back Office Audit and select the BO Audit Panel to display all elements related
to the trade that have been modified.

Note that the Audit mode must be enabled. Refer to the Calypso Security User Guide for
details.

Show Generic
Comments

Displays comments if any in the Generic Comments report.

Add Generic Comment Brings up the Generic Comment Editor that allows associating comments and documents
with various types of object.
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Menu Items Description

» Select a comment type and enter a comment.

Comment types are defined in the "genericCommentType" domain.

You can predefine comments in the domains "generic<object>Comment", for example
"genericTradeComment". They will be available for selection from the Comment field.

» You can check URL to indicate that the comment is a URL, provided it is entered as a
fully qualified URL. Example: http://www.google.com.

It appears as a link in the Generic Comment Report. You can double-click the link to
bring up the URL in your default browser.

» You can also attach a document , delete an attachment , and open any existing
attachment .

» Then click Save.

Tree View Displays the hierarchy of trades linked to the trade loaded in the trade window.

It displays the following details for each trade: Trade Id, workflow status, product type,
primary currency and trade amount, secondary currency and trade amount, value date,
counterparty in external trades, trading book in internal trades, and final rate.

» Double-click a trade to open the trade window and display the trade details.

Open Opens the Trade Selector window to select trades.

» Click Attributes to specify attribute values as applicable.

Nasdaq Calypso
Trading Environment / Version 18



Menu Items Description
» Click Show Trades to display the trades that satisfy the attribute values.

» Double-click a trade to load its worksheet.

Custom Entry Opens a custom data window provided trade custom data are specified, a custom data
window is implemented, and a custom trade validator is implemented for this type of trade.

Note that you can also create a custom trade panel for entering custom trade data.

Refer to the Calypso Developer’s Guide for information on handling trade custom data.

Nasdaq Calypso
Trading Environment / Version 18

May 2025
Revision 5.0 / Approved

Proprietary and Confidential
Page 96 / 239



May 2025
Revision 5.0 / Approved

Proprietary and Confidential
Page 97 / 239

10. Market Data Menu
Choose menu items from the Market Data menu to configure market data as applicable. Help is available from Market
Data windows.

Refer to Market Data Documentation for details.
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11. Pricing Env Menu
The menu items of the Pricing Env menu are described below.

Menu Items Description
Display Not applicable.

Refresh Reloads the latest market data for the Pricing Env currently selected, as of the current
valuation date and time.

Reload Reloads the Pricing Env currently selected: definition and market data as of the current
valuation date and time.

Edit Invokes the Pricing Env window. Help is available from that window.

Check Invokes the Checking Pricing Env window that checks if all required pricing data are
available in the Pricing Env. This window shows missing quotes, missing pricers, and missing
market data.

» Click Set Quotes to set missing quotes as applicable. This will invoke the Quote window.

» Click Set Pricer Config to set missing pricers and missing market data items as
applicable. This will invoke the Pricer configuration window

Refer to the Calypso Market Data documentation for information on setting up market data
and pricer configurations.

Pricing Params Invokes the Trade Pricing Params window.

See Pricing a Trade for details.

Pricer Measures Help Invokes the Pricer Measures Help that describes all pricer measures.

Check Past Resets Invokes the Quote window to display missing past resets.

» Enter rate resets as applicable and click Save.
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Menu Items Description
Show Past Resets Invokes the Quote window to display past resets.

Real Time Change This menu item operates as a checkbox. It is checked by default.

Check to update the Pricing Env in real-time with market data changes. This only applies if a
Market Data Server is up and running.

Refer to Calypso Market Data Server Documentation for details.

You can set the default value for this menu item per product type using Configuration >
User Access Control > User Settings from the Calypso Navigator.

The properties are "<product type>_RT_FLAG".
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12. Product Menu
Each trade worksheet has a product specific menu "Product Type".

All the menu items of the product specific menus are described below.

 Ⓘ [NOTE: All menu items described here may not be available for all types of trades because they would not
be applicable]

Menu Items Description
Premium Fee
Calculator

Applies to swaption and cap floor trades.

The premium fee is calculated according to the swap schedule when the trade is priced.

However, you can modify the premium fee using the Premium Calculator window. Help is
available from that window.

Price (F4) To price the trade.

See Trade Pricing for complete details on the pricing area.

Switch Pay/Rec To switch the direction of the trade between pay and receive.

Configure Results To configure the pricer measures to be displayed in the Results panel. You will be prompted to
select pricer measures.

Pricer measures are the outputs of the pricing routines.

Save Result Config To save the pricer measures configuration.

Re-order Pricing
Parameters

To order the display of the pricing parameters in the Pricing Params panel.

Save Parameters
Order

To save the pricing parameters display.

Save As Template To save the trade as a template. You will be prompted to enter a template name and specify
whether the template is private or public. Other users will not be able to use private templates.

Delete Template To delete a template. You will be prompted to select a template.

Only the user who created a template (whether it is public or private) can delete it.

You can also delete templates from the Calypso Navigator using Utilities > Maintenance >
Monitoring > Clean-up > Clean-up Database > Products panel.

Refer to Calypso Utilities documentation for details.

Custom Product
Data

To open a custom product window provided custom product data are specified, and a custom
product window is implemented for this type of product.

Refer to the Calypso Developer’s Guide for information on implementing custom product
data.

Save Panel
Directions

Saves the direction signs located in the middle of the worksheet. You can double-click a sign
to toggle between:
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Menu Items Description
>> Copy to the right panel.

<< Copy to the left panel.

--- Turn off copying.

Termination Dates This menu item is outdated. You should use Cash Settle Info instead.

Cash Settle Info To specify a termination schedule. It brings up the Cash Settlement window. Help is available
from that window.

Payout Formula
(Left)

Payout Formula
(Right)

This feature has been replaced with the definition of exotic structures for most products.
However, an example is shown below.

To set a payment formula on the left leg, or on the right leg.

Out-of-the-box, the RangeFloater formula is available. It allows defining an embedded option.

RangeFloater Example
You can set a payout spread that occurs if the floating rate is within a defined range. If LIBOR is
between 5% and 6%, then the rate actually used for fixing is LIBOR + 0.5%.

» Enter the range for the floating rate in the LowerBound and UpperBound fields.

» Enter the payout in the Payout Spread field.

» Click Apply.

For information on implementing custom payout formulas, refer to the Calypso Developer’s
Guide.

Show Fixed Rate in
Basis Points

Applies to CRD Trades.

This menu item operates as a checkbox.

Check to display the fixed rate as basis points. Otherwise, the fixed rate is percentage.

Show Premium in
Basis Points

Applies to CRD Option Trades.

This menu item operates as a checkbox.

Check to display the option’s premium fee as basis points. Otherwise, the option’s premium fee
is an amount.
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Menu Items Description
Exercise Timing
Details

Applies to CRD Option Trades.

To set the expiration time. It brings up the Exercise Timing Details window.

» Enter the expiration times and select the timezone as needed.

» Then click Apply.

Bermudan Details Applies to CRD Option Trades.

To set the expiration schedule for Bermudan options.

» Click Add to add an exercise date as needed, and enter the expiration date and the
delivery date.

» Then click Apply.

Specific Resets To enter price fixings and rate resets specific to the current trade. The resets defined here are
not used by other trades. It brings up the Reset Samples window.
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Menu Items Description

» Enter a reset rate, and select a reset date, then click Add.

» Click Apply to save the specific resets.

The rates will appear in the corresponding cashflows, and the Manual Reset checkbox will
appear checked.

PV01_Credit per
name

Applies to CRD Trades.

To display PV01_CREDIT for each name in the basket.

This is obtained by perturbing each credit curve separately by 1bp.

 Ⓘ [NOTE: The pricing parameter PER_REF_NAME should be set to true, and the pricer
measure PV01_CREDIT should be selected under Product Menu > Configure Results]
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Menu Items Description
You can also bring up this window when you double-click the pricer measure PV01_CREDIT in
the results panel of the pricing area.

Click Hedge With Single Name CDS to enter credit default swap hedge trades for each issuer in
the basket. It brings up the Credit Default Swap Bulk Entry Frame.

Enter Sales Margin To enter a sales margin, as a percentage of the original principal of the trade. It brings up the
Enter Sales Margin window.

» Click Receive or Pay to indicate to which leg the sales margin applies.

» Enter the percentage in the Sales Margin field. Then click Apply.

The sales margin appears to the right of the principal amount.

The columns Sales Margin, Interest Amt (Sales Margin) and Disc. Interest Amt (Sales
Margin) can be added to the cashflows. They are calculated provided the pricer measure
SALES_NPV is added to the pricing results.

The pricer measures SALES_CASH, and TRADER_NPV also reflect the sales margin.

Automatically This menu item operates as a radio button. Cannot be selected if “Warn Before Adjusting Stub”
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Menu Items Description
Adjusting Stub or “No Stub Adjusting” is selected.

Click to automatically create stub periods without warning when changes to the trade require
stub periods.

You can override stub period settings in the Product Details window. Help is available from that
window with complete details on stub periods.

Warn Before
Adjusting Stub

This menu item operates as a radio button. Cannot be selected if “Automatically Adjusting
Stub” or “No Stub Adjusting” is selected.

You will be prompted to create stub periods when changes to the trade require stub periods.

You can override stub period settings in the Product Details window. Help is available from that
window with complete details on stub periods.

No Stub Adjusting This menu item operates as a radio button. Cannot be selected if “Warn Before Adjusting Stub”
or “Automatically Adjusting Stub” is selected.

This is the default setting. The system will not create the stub periods even when changes to
the trade require stub periods.

You can define stub period settings in the Product Details window. Help is available from that
window with complete details on stub periods.

Allow Overlapping
Periods

This menu item operates as a checkbox. This applies when cashflows are customized.

If checked, trades can have overlapping cashflows (Pmt Begin date of next period can be
before Pmt End date of previous period - or vice versa), or gaps in accrual (Pmt Begin date of
next period can be after Pmt End date of previous period).

In this example, the first two periods are overlapping, and there is a gap between the last two
periods.

If not checked, trades cannot have overlapping cashflows, or gaps in accrual. If Pmt End date
of prior period is modified, then Pmt Begin date of next period is modified accordingly.
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Menu Items Description
Discount This menu item operates as a checkbox.

Check to identify Brazilian OIS swap trades on a discount basis.

If checked, and if the payment frequency is set to ZC (zero coupon), the field Negotiated Price
will appear.

When you enter a negotiated price, the principal is updated according to the following
formulas:

PV = FV / (1 + Fixed Rate) ^ Period for exponential interest

PV = FV / (1 + Fixed Rate x Period) for simple interest where Period = (Swap Start, Start End,
Fixed Leg Pay Daycount)

In other words, PV + Interest from Fixed Leg Cashflow = FV.
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13. Product Details Window
This window appears when you double-click any red label in a trade worksheet.

This documents describes the settings of the Product Detail window.

» Click Apply after setting the details, to apply them to the selected product (a swap, a cap floor, etc.) – You then
need to generate the cashflows to view the changes.

13.1 Amort izat ion and Accrual Panel
Select the Amortization and Accrual panel.

» Select the amortization structure from the Amortization field. Then click ... to set the parameters of the selected
structure. The default is Bullet (no amortization, no parameters are required). The amortization structures are
described below. They are defined in the domain "principalStructure".

Not all amortizations structures are available for all products.

» Select the adjustment method of the accrual period from the Accrual Method field:

– ADJUSTED— Adjusts the period’s end date if it falls on a non-business day, according to the payment date
roll convention. Rolling the end date adjusts the period length, so a rolled date changes the interest amount.

– UNADJUSTED—Does not adjust the period’s end date for non-business days.

– MAT_UNADJUSTED— Adjusts the period’s end date if it falls on a weekend unless it is the last period
(maturity), in which case it is not adjusted. Thus the adjustment method may affect intermediate interest
amounts, but it does not change the maturity date.

– MAT_ADJUSTED— Adjusts only the last accrual period on a valid business day. Cashflows up to maturity
are treated as unadjusted. If the end date of final accrual lands on a non-business day, however, it is
adjusted to the next valid business day. The maturity date of the trade is not affected.

– FRN— Adjusts the period’s end date for non-business days to the next business day unless the next
business day is in the following month, in which case it uses the preceding business day.
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» For trades using compounding, select from the Compounding Method field:

– ADJUSTED— Adjusts the payment's begin/end dates if it falls on a non-business day, according to the
payment date roll convention.

– FRN— Adjusts the period’s end date for non-business days to the next business day unless the next
business day is in the following month, in which case it uses the preceding business day.

– MAT_UNADJUSTED— Adjusts the period’s end date if it falls on a weekend unless it is the last period
(maturity), in which case it is not adjusted.

– UNADJUSTED—Does not adjust the compound’s begin/end date for non-business days.

» Click “Extra day in first period” to add a day to the first payment period, or “Extra day in last period” to add a day to
the last payment period. The system uses the daycount (nominator+1)/denominator on the first or last cashflow -
For example ACT+1/360.

Amortization Structures
When a parametrized amortization type is used, it is possible to control the logic for the first amortization period by
setting a true/false value for the domain "isAmortStartDateDirect":

• When false (default), it assumes the first amortization occurs in the first coupon period where Pmt End Date >=
Amort Start Date + Amort Tenor.

• When true, it assumes the first amortization occurs in the first coupon period where the Pmt End Date > Amort
Start Date.

Values Description
Accreting The principal accrues according to a rate schedule. The rate schedule is based on a formula

that can be made of a constant rate increase, a cap, a floor, and one or more rate indices
with a factor. The accretion rate calculated by inputs from the current period is applied to
the next period. The accretion rate index can reset at the beginning of the period or in
arrears.

Rate = (1st Factor * 1st Rate Index Reset + ... nth Factor * nth Rate Index Reset + Constant),
and is compared to the cap and floor.

For the cases with actual principal exchange, you have to set one more period as accretion
end date.

You can select “Accretion Sample Dts” from the Cashflow menu to view the reset dates of
the rate schedule.

Click ... to set the Accreting parameters. It brings up the Accreting Schedule window.
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Values Description

» Select a date rule from the Coupon Date Rule field to generate the schedule using the
date rule, or select a frequency from the Frq field to generate the schedule using a
frequency.

» Enter start and end dates.

» There are no tolerance days by default – Uncheck Left Side and/or Right Side to allow
tolerance days on the left leg and/or right leg respectively. Enter the number of days.
Default is 5.

» Click Generate to generate the schedule.

» Enter the constant rate increase, cap and floor as needed. You can also add a rate index
with a factor over the index.

To add a rate index, select a rate index and set all the required parameters on the index
then click Add. You can then enter a factor. If you add multiple indices, you can enter a
factor for each index.

» Then click Apply to apply the amortization structure.

Annuity The amount of each payment (interest + principal) remains constant over the life of the
product. The interest payments are larger in the beginning and decrease over time, while the
principal repayments are smaller in the beginning and increase over time.

Click ... to set the Annuity parameters. It brings up the Notional Scheduler window.
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Values Description

» Enter the initial principal amount in the “Base amt” field.

» Check the “Term As Date” checkbox to enter a date for the annuity term. Otherwise, the
system uses the end date of the period.

» Enter the start and end dates for the amortization schedule if different from the trade’s
dates, in the Start Date and End Date fields.

» Enter the fixed amortization rate in the Rate field.

» Select the amortization frequency from the Frequency field.

» Check the “Use Loan Term” checkbox to disable the Start Date and End Date fields. In
this case, select a term from the Loan Term field. It can be greater than the duration of
the product.

» Then click Apply to apply the amortization structure.

AnnuityAdj Select this for non-constant annuity payments. For calculations where Amort = Annuity on a
cash instrument, it will take into account the exact number of days according to the
daycount on intermediate amounts.

Click ... to set the AnnuityAdj parameters. It brings up the Notional Scheduler window. See
Annuity above for details.
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Values Description

Bullet No amortization - No parameters are required.

Custom The amortization structure is set to Custom by the system when you customize the
cashflows.

Equal The principal is amortized in equal payments, one for each interest period of the trade, so
that the final repayment of principal occurs in the last interest period. In this case, the
amortized principal is the same for each calculation period.

Click ... to set the Equal parameters. It brings up the Notional Scheduler window.

» Enter the initial principal amount in the “Base amt” field.

» Enter the start and end dates for the amortization schedule if different from the trade’s
dates, in the Start Date and End Date fields.

» Select the amortization frequency from the Frequency field.

» Check the “Term As Date” checkbox to enter a date for the equal term. Otherwise, the
system uses the end date of the period.
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Values Description
» Then click Apply to apply the amortization structure.

Mortgage You can define a Mortgage structure for Swaps, Cancellable Swaps, Caps & Floors, and
Swaptions.

The Mortgage structure ensures that the annuity (interest plus amortization) for every period
is the same. It is similar to the Annuity structure, but it supports all daycount conventions,
and periods of different length.

Click ... to set the Mortgage parameters. It brings up the Mortgage Scheduler window.

If you check "Use Calculated", the parameters are used to compute the amortization
amount. Otherwise, they are used to compute the annuity amount (amortization plus
interest).

The base rate defaults to the fixed rate of the trade and the custom rate is an amortization
rate that you can enter.

» You can check Base Rate and Custom Rate, the annuity or amortization amount is
computed using Base Rate + Custom Rate.
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Values Description
You can also modify the base rate as needed.

Or, you can check "Lock" to lock the base rate.

» You can also check the Base Rate only or the Custom Rate only to compute the annuity
or amortization amount.

» Or, you can check Total Payment to set the interest amount as the annuity or
amortization amount.

» The "Use FullCpn" checkbox is only used in the case of a stub period. If you check "Use
FullCpn", the full annuity or amortization amount is used for the stub period. Otherwise, it
is prorated to the length of the stub period.

» You can check the “Term As Date” checkbox to enter a date for the mortgage term.
Otherwise, the system uses the end date of the period.

» Enter the start and end dates for the amortization schedule if different from the trade’s
dates, in the Start Date and End Date fields.

» Select the amortization frequency from the Frequency field. It defaults to the trade’s
payment frequency (Value from Trade).

» Select a daycount from the DayCount field. It defaults to the trade’s payment daycount.

» Select an adjustment method for the period from the Period Rule field.

– ADJUSTED— Adjusts the period’s end date if it falls on a non-business day,
according to the payment date roll convention.

– UNADJUSTED—Does not adjust the period’s end date for non-business days.

– MAT_UNADJUSTED— Adjusts the period’s end date if it falls on a weekend unless
it is the last period (maturity), in which case it is not adjusted. Thus the adjustment
method may affect intermediate amounts, but it does not change the maturity
date.

– FRN— Adjusts the period’s end date for non-business days to the next business
day unless the next business day is in the following month, in which case it uses
the preceding business day.

» Enter the residual principal amount after the mortgage term completes in the Residual
field as needed. It defaults to the notional amount of the period following the last
selected period.

» Enter the unit amount to which the mortgage amount should be rounded in the “Round
to Amt” field, and select the rounding method from the Rounding Option field.

For example, if “Round to Amt” is $1.00 and the rounding option is NEAREST, the
mortgage amount will be rounded to the nearest dollar.

You can check the “Only Principal” checkbox to apply the rounding conventions to the
principal only. Otherwise, they also apply to the interest.
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Values Description
» Then click Apply to apply the amortization structure.

Negotiable Only applies to Cash trades.

To specify principal changes.

Click ... to set the Negotiable parameters. It brings up the Principal Schedule window.

» Enter a date and an amount and click Add. The system displays the remaining principal
after each principal change.

» You can also choose to perform interest cleanup on the principal change date:

– FFCP = False - The interest cleanup is split between the interest on the initial
principal and the remaining principal.

– FFCP = True - The interest cleanup is split between the interest on the principal
change amount and the remaining principal.

See below details

» Click Applywhen you are done.

Interest Cleanup
If FFCP = False, the interest calculation is split as follows:

• First period:

Interest Cleanup = Principal on CF Start Date * Nb days from CF Start Date to first
Cleanup Date * Rate / DayCount

• Subsequent period:

Interest Cleanup = Remaining principal on CF Cleanup Date * Nb days from previous
Cleanup Date to Next Cleanup Date (or CF End Date) * Rate / DayCount

If FFCP = True, the interest calculation is split as follows:

• First period:

Interest Cleanup = Principal Change amount * Nb days from CF Start Date to first

Nasdaq Calypso
Trading Environment / Version 18

May 2025
Revision 5.0 / Approved

Proprietary and Confidential
Page 114 / 239



May 2025
Revision 5.0 / Approved

Proprietary and Confidential
Page 115 / 239

Values Description
Cleanup Date * Rate / DayCount

• Second period:

Interest Cleanup = Remaining principal on CF Cleanup Date * Nb days from CF Start
Date to Next Cleanup Date (or CF End Date) * Rate / DayCount

Schedule To generate an amortization schedule according to a date rule and a set of parameters, or
according to custom cashflows.

Click ... to set the Schedule parameters. It brings up the Schedule window.

Schedule from Parameters
» Select “Params” from the “Schedule From” field.

» Check the "Use Amort Rate" checkbox to use amortization rates.

» Select a date rule from the Coupon Date Rule field to generate the schedule using the
date rule, or select a frequency from the Frequency field to generate the schedule using
a frequency.

» Enter start and end dates.

» Select date roll information, daycount convention, holiday calendars, and the accrual
method.

» Left Tolerance is set to False by default. Select True to allow tolerance days on the left
leg, and enter the number of days. Default is 5.

» Right Tolerance is set to False by default. Select True to allow tolerance days on the
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Values Description
right leg, and enter the number of days. Default is 5.

» Click Generate Schedule to generate the schedule. The schedule is generated by default
for the full principal amount, you can modify it as needed.

» Then click Save to apply the schedule.

Schedule from Custom Cashflows
Only applies if you have generated the cashflows on the trade.

» Select “Cash Flows” from the “Schedule From” field.

» Click Generate Schedule to generate the schedule based on the cashflows. You can
modify as needed.

» Then click Save to apply the schedule.

Step down The Step down amortization structure is an incremental structure whereby the base amount
decreases (or increases) by a certain amount for a set number of payment periods.

Click ... to set the Step down parameters. It brings up the Notional Scheduler window.

» Enter the initial principal amount in the “Base amt” field.

» Enter the start and end dates for the amortization schedule if different from the trade’s
dates, in the Start Date and End Date fields.

» Enter the step amount in the Increment field.

» Select the amortization frequency from the Frequency field.
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Values Description
» Click the operator that you want to use: +, -, x, or /.

» Then click Apply to apply the amortization schedule.

13.2 Index and Resets Panel
This panel only appears for floating legs.

Select the Index and Resets panel.

» The index source and index factor are displayed and can be altered directly.

» Click ... next to "Spread Schedule" to define a spread schedule. It brings up the Spread Schedule window.
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– Select a date rule from the Coupon Date Rule field to generate the schedule using the date rule, or select a
frequency from the Frequency field to generate the schedule using a frequency.

– Enter Start and End Dates.

– Click Generate to generate the schedule. Then enter the spreads as needed.

– Then click Save to apply the schedule.

» The field "Cmp Sprd" only appears for a compounding rate with spread compounding - You can enter the spread
in basis points, or click ... to define a compounding spread schedule. The Compound Spread Schedule window will
appear, it is the same as the Spread Schedule window shown above.

» Check the “Convert Basis” checkbox to check whether the reference index and the trade have the same
daycount convention. If not, the rate’s daycount convention is converted to the trade’s daycount convention. The
following cases are currently supported:

» For RFR based Daily Compounding swaps, the conversion will get applied to the compounded rate and not on
Daily Rates. Such Converted Rate will be used for Interest Amount calculation as well as the Accrual Amount
calculation. Value displayed in the ‘Rate’ column will be the converted rate. Daily Rates displayed in the Sample
Values Window will be the actual rates and not the converted rates.

» In case of Spread and Index Factor, If Convert Basis is checked and if the trade has Index Factor value other than
1; by default ‘Apply Index Factor to Cmp Rate’ should get checked. It won’t be possible for the user to uncheck this
(unless ‘Convert Basis’ checkbox is unchecked back).

» In case of Unsupported Compounding Methods, when the user chooses Compounding Method other than
‘SimpleSpread’, while keeping ‘Convert Basis’ checked, below message will be displayed when the user hits on
‘Price’ or generates cashflows or tries to save the trade:

“Convert basis is not supported with the selected Compounding Method”.
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Rate Index
Daycount

Trade
Daycount

Conversion Method

ACT/360 ACT/365 Multiply by 365/360

ACT/365 ACT/360 Divide by 365/360

ACT+1/365 ACT+1/360 Divide by 365/360

ACT+1/360 ACT+1/365 Multiply by 365/360

ACT/ACT ACT/360 Convert Basis unchecked, forward rate = higher rate
(BEY)

ACT/ACT ACT/360 Convert Basis checked, forward rate = lower rate (MMY
by multiplying the rate by 360/365)

» Check "Multiplicative Spread" so that the spread over the rate index is multiplicative rather than additive.

This setting is available when the floating leg uses an inflation rate index, or when the floating leg uses flat
compounding in addition to selecting "EXP" as the payment discount method.

This is the spread set next to the index on the Trade window.

» Select the reset date roll convention from the Reset Roll field, if different from the payment date roll convention.
Date roll conventions are described in the Calypso Navigator under Help > Date Roll Conventions.

» For an inflation rate, the calculation method and interpolation method are displayed - You can modify as needed.

» Check the Reset Lag checkbox to modify the reset lag (number of days between the reset date and the payment
date). It defaults to the reset lag specified on the rate index.

– You can double-click the Bus label (business days) to change to Cal (calendar days) if needed.

– If the Bus label is selected, you can select a custom calendar from the Custom Reset Hol field.

» The field “CutOff Lag” appears when resets are sampled at a frequency different from the payment frequency. It
only applies to daily and weekly sampling. When daily, it should be set to “-1”.
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When used with the “Cutoff Adj.” weight method, set to the lag between the last sample period’s end date and the
cutoff date.

– You can double-click the Bus label (business days) to change to Cal (calendar days) if needed.

– You can specify the cutoff lag holidays. They are used for the cutoff lag on both daily compounding and
daily averaging coupons.

» The field “Monthly Reset On This Day” appears when resets are sampled at a frequency different from the
payment frequency. It only applies to weekly and monthly sampling (weekly: day of the week, monthly: day of the
month).

» Set “Different Reset Dates Per Coupon” to True to generate the reset dates based on the coupon payment
frequency, or N to generate the reset dates based on the index tenor.

For a coupon frequency higher than the index frequency, all coupons within an index term can have a different
reset date, or the same reset date.

For example, LIBOR 3M and coupon frequency = M. If True, every coupon within the index term will have a
different reset date. If False, every coupon within the index term will have the same reset date.

If you do not select True or False, the system will use the value of the environment property DIFFERENT_RESET_
DT_PER_CPN.

When False (default), you can check "Apply Reset Dates beginning at First Coupon" to combine coupons within
the same index term from top to bottom - Otherwise, they are combined from bottom to top.

Example: LIBOR 3M, coupon frequency = M, and there are 4 coupon periods.

– If "Apply Reset Dates beginning at First Coupon" = True:

Period 1, Period 2, Period 3 = Reset 1 and Period 4 = Reset 2

– If "Apply Reset Dates beginning at First Coupon" = False (default):

Period 1= Reset 1 and Period 2, Period 3, Period 4 = Reset 2

» Check the “Use Reset Period Dates for Compound” to compound trades based on the reset dates rather than the
payment dates. Only applies to compounding trades.

» Select the "Use Payment Holiday For Averaging Periods" checkbox to calculate sample periods using payment
holidays instead of the reset calendar.

» The FX Reset panel appears for Cross-Currency Swaps and Cancelable Cross-Currency Swaps with principal
adjustment (the Adj checkbox is checked).
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– Check the “Idx Reset Dts” checkbox to specify that the FX reset dates are the same as the index reset dates.

Or check the Lag checkbox to specify that the FX reset dates are a number of days before the interest start
date. Enter the number of days in the adjacent field. It defaults to the reset lag specified on the FX rate. You
can double-click the Bus label (business days) to change to Cal (calendar days) if needed.

If the Bus label is selected, you can select a calendar from the Hol field.

» "Override Daily Index Calculator" - *** It is not recommended to check this field as it will be deprecated in an
upcoming version ***

When checked, the system uses the DailyCompound rate index calculator for trades based on rate indices
defined with legacy rate index calculators.

» "Use Sample Period Shift" appears when coupons are daily compounding and daily averaging. When checked, it
shifts the sample period by as many days as the Reset Lag, such that the weights of any given daily fixing remains
the same.

» "Partial Period Compounding" appears for daily compounding swaps with SimpleSpr compoundinh method -
Select NCCR for Non-Cumulative Compound Rate, or not set for CCR (Cumulative Compound Rate). The NCCR
rate is the daily change in CCR rate.

The value NCCR can be added to the domain "PartialPeriodCompRateEnrichmentMethods" if it is not available for
selection.

In the Reset Samples window, the Partial Period Comp Rate column is computed.

» ISDA Set-In-Advance appears for swap trades. Setting to True causes the system to use the ISDA 2021
convention for daily compounding and simple averaging coupons where the Reset Timing of the daily
compounded rate is BEG_PER.

You can set the default value of this field by setting Value = True in domain isdaSetInAdvance.

Introduce a new property by the name of 'Apply Index Factor to Cmp rate' in the trade window under ‘Index and
Resets’ as below:

» When not checked (default), the index factor is applied to each daily rate.

» When checked, the index factor is applied to the final compounded rate.

13.3 Stub Periods Panel
Select the Stub Periods panel.
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The system automatically creates the stub periods when needed if Product > Automatically Adjusting Stub, or
Product > Warn before Adjusting Stub is checked. Otherwise, you can define stub periods manually in this panel.

Stub periods take into account date roll conventions, holidays and accrual method.

The stub periods use the ISDA interpolation methodology to interpolate stub rates.

If a period (in calendar days) is less than or equal to the stub tolerance, it will be merged into the period immediately
next to it. The default stub tolerance is 5 days (or set in the environment property STUB_TOLERANCE) - You can
customize the stub tolerance in this window as well.

» Select the type of stub period from the Stub field.

FIRST / LAST indicate whether the stub is the first period or the last period.

SHORT / LONG indicate whether the stub is shorter or longer than the payment frequency.

SPECIFIC FIRST – You can enter the end date of the first period.

SPECIFIC LAST – You can enter the start date of the last period.

SPECIFIC BOTH – You can enter the end date of the first period, and the start date of the last period.

FULL COUPON – You can enter the full coupon date (FULL COUPON is not applicable to Security Finance trades:
repo and security lending).

Examples: You have a QTR interest frequency, and the trade start date is 03/01 and the trade end date is 10/15
(these examples do not take into account holidays, date roll conventions, and accrual method – Their purpose is
to show how the stub periods are created).

– SHORT FIRST creates 3 periods (03/01 – 04/15 || 04/15 – 07/15 ||  07/15 – 10/15)

– LONG FIRST creates 2 periods (03/01 – 07/15 || 07/15 – 10/15)

– SHORT LAST creates 3 periods (03/01 – 06/01 || 06/01 – 09/01 ||  09/01 – 10/15)

– LONG LAST creates 2 periods (03/01 – 06/01 || 06/01 – 10/15)

– SPECIFIC FIRST (end date of first period is 03/15) creates 4 periods (03/01 – 03/15 || 03/15 – 06/15 || 06/15 –
09/15 || 09/15 – 10/15)

– SPECIFIC LAST (start date of last period is 10/01) creates 4 periods (03/01 – 04/01 || 04/01 – 07/01 || 07/01 –
10/01 || 10/01 – 10/15)
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– SPECIFIC BOTH (end date of first period is 04/01 and start date of last period is 09/15) creates 4 periods
(03/01 – 04/01 || 04/01 – 07/01 || 07/01 – 09/15 || 09/15 – 10/15)

– FULL COUPON – It creates 3 periods (01/15 – 04/15 || 04/15 – 07/15 || 07/15 – 10/15)

» Check the “Custom Stub Tolerance” checkbox to specify the stub period offset in days, and enter the number of
days in the adjacent field.

If a period (in calendar days) is less than or equal to the stub tolerance, it will be merged into the period
immediately next to it. If not set, the default stub tolerance is 5 days (or set in the environment property STUB_
TOLERANCE).

» Whenever there is a stub on a floating rate, the system automatically calculates the best index tenor for the stub
period (provided “No Auto Interp” is unchecked on the rate index definition). If the length of a stub period matches
exactly one of the index tenors, there is no interpolation required. If the length of a stub period is between two
index tenors, the system defaults the stub index to interpolate between the two index tenors.

You can customize these tenors using the Interp checkbox and the adjacent tenor fields. If no interpolation is
required, select the same tenor in both boxes. When you modify the index tenors, the Custom checkbox will
appear checked. To return to the default tenors computed by the system, uncheck the Custom checkbox.

You can select the interpolation style:

– Index Based - The DateRoll, the holidays and the daycount are coming from the rate index.

– Product Payment - The DateRoll, the holidays and the daycount are coming from the coupon panel.

– Product Payment-Ignore EOM Rule - Same as "Product Payment", and the Follow End-End maturity is
ignored.

If the Roll Day setting in the payment details schedule is set to EOM, you can use the domain
"InterpolateIgnoreEOMRoll" to ignore the Roll Day setting so that it does not interfere with the Interp Style
setting.

When "InterpolateIgnoreEOMRoll" is set to True, interpolation ignores Roll Day=EOM. When
"InterpolateIgnoreEOMRoll" is set to False, interpolation will include the date roll and roll day settings in the
payment schedule.

For Cash trades and Structured Flows trades, you can select "Interp On Payment Period":

– Not set – In this case the value is taken from the domain “InterpolateOnPaymentPeriod” if any, or false
otherwise.

– True: Interpolate on payment period
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– False: Interpolate on forward period

For a swap trade, if the system finds a curve for each stub tenor, it will use them to interpolate the stub period,
otherwise it uses tenors on the curve of the trade’s tenor forecast curve.

Here the system is using a curve for the 3M tenor, and a curve for the 6M tenor.

You must have rate indices for each tenor with “No Auto Interp” unchecked, curves defined for each tenor, and
the curves must be associated as forecast curves with the pricer configuration.

» You can enter a Full Cpn date to create periods starting on that date rather than the trade start date. The same
logic applies with stub periods but for trade start date = Full Cpn date.

» Cmp Stub - Only appears if the compounding frequency is LUN(R), BIWK(R), or WK(R).

Select a stub for the compounding period as needed - This is used to adjust the compounding periods that are
generated when they are not exactly divisible by the payment frequency.

Example: You pick a MTH payment frequency with compound frequency as WK(R). A month cannot be divided
exactly in 7 days periods so we will have few extra days (if the month has 31 days you will have 4 extra days).

– SHORT FIRST: The first period will have 4 days, the others periods 7 days.

– LONG FIRST: The first period will have 11 day, the others periods 7 days.

– SHORT LAST: The first periods will have 7 days, the last one 4 days.

– LONG LAST: The first periods will have 7 days, the last one 11 days.

For more detailed information, refer to Handling of Stubs.

13.4 Date Rules Panel
Date rules can be used instead of frequencies to determine the interest periods.

Select the Date Rules panel.
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–

» You can select a payment date rule, an interest date rule, and a reset date rule.

The payment date rule determines the payment dates of the cashflows. If none is specified, the payment lag is
used instead.

The coupon date rule determines the interest dates of the cashflows.

The reset date rule determines the reset dates of the cashflows.

For Cash products, the payment date rule determines the payment dates of principal flows - You can also select
an interest payment date rule for the payment dates of interest flows.

» Check the Prior checkbox to perform the reset for the prior period (in arrears).

» Enter a number of days between the interest date and the payment date in the Payment Lag field if needed. You
can double-click the Bus label (business days) to change to Cal (calendar days) if needed.

» You can select True from the Apply Pmt Lag To Principal Flows field to apply the payment lag to PRINCIPAL flows
in addition to INTEREST flows. It is applied to INTEREST flows only otherwise.

You can set a default value for this field using the domains "ApplyPmtLagtoPrincipalFlows" for IRD trades and
"StructuredFlows.ApplyPmtLagToPrincipalFlows" for Structured Flows. Default is True.

» You can select additional settlement holidays as needed.
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13.5 Rounding Panel
Select the Rounding panel.

» Select the interest amount’s rounding method from the Amounts field.

» Select the rate’s rounding method from the Rates field. You can enter the number of decimal places in the Dec
Places field.

» You can select the stub rate’s rounding method from the Interpolated Rates field. Only appears if stub periods are
defined. You can enter the number of decimal places in the Dec Places field.

» You can select the first reset rate rounding method from the 1st Rate field. Only appears if a first reset rate is set
on the trade. You can enter the number of decimal places in the Dec Places field.

» You can select the rate factor rounding method from the Rate Factor field. Only appears when a fixed leg's
payment discount method is "EXP" or "NONE", or when the floating leg uses flat compounding, selects "EXP" as
the payment method, and checks the multiplicative spread checkbox. You can enter the number of decimal
places in the Dec Places field.

» When the rate index on the floating leg is for inflation and Calculation Type on the Inflation tab is set to
InflationIndexation, the Inflation Factor drop-down list is enabled. This provides the ability to round known values
for Inflation Factor results in cashflows. The available rounding types are NEAREST, UP, or DOWN, and the
number of decimal places can be entered.
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13.6 Inf lat ion Panel
For inflation swaps, additional details can be specified in the Inflation panel.

Select the Inflation panel.

» Select the calculation method:

– Interpolated - Daily index levels are interpolated between publication dates.

– IndexLevel - Index levels are not interpolated between publication dates.

» The only "Interp Method" option is "Weighted", which is only available for the Interpolated calculation method.

» Select the calculation type to apply inflation level changes to cashflows:

– InflationIncome - [(Final Level / Initial Level) - 1]

– InflationIndexation - [Final Level / Initial Level]

» Select whether to apply the InflationIndexation calculation type to just Interest, or both Interest and Principal.

13.7 Embedded Option Panel
For daily compounding trades with the SimpleSpr compounding method, you can apply a cap or a floor to each daily
interest rate before compounding.
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Select either Daily Floor or Daily Cap, and specify the upper or lower strike. If you don't want to apply a cap or a floor
to each daily interest rate before compounding, select None.
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14. Stubs Handling
Detailed description of how the system handles stub periods.

14.1 Environment Property
You may choose the default tolerance for when stub periods are created using environment property STUB_
TOLERANCE. This is a number of days.

 Ⓘ [NOTE: There are other settings described below that affect default stub handling]

Example: If STUB_TOLERANCE = 5, no stub would is created for a period less than 5 days in length.

14.2 Default Interpolat ion and Curve Selection
You can of multiple curves for stubs, based on the tenor of the stub periods. For example, suppose the trade is based
on LIBOR 3M, the period is quarterly and there is a stub period of 6 weeks. You can interpolate the rate for this period
between 1M and 3M rates using the LIBOR 3M curve set up in the Pricing Environment, or you can use the declared
LIBOR 1M and the declared LIBOR 3M curve. This difference depends on the setup described below.

14.2 .1 Rate Index Sett ings

No Automatic Interpolation
This checkbox is not related to the interpolation method of inflation indices. When checked, there is no automatic
interpolation applied to stub periods. Otherwise, stub periods are automatically interpolated. The Rate Index Window
can be viewed from the Calypso Navigator by selecting Configuration > Interest Rates > Rate Index Definition.
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Rate Attribute - Excl_intrp_tnr_list
The Rate Attribute, Excl_intrp_trn_list is used to exclude tenors from being included in stubs. The tenors should be in
the list separated by commas.
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14.2 .2 Pr ic ing Parameters
You may turn on or off usage of multiple curves with the INTERPOLATE_ON_STUBS pricing parameter. When this
parameter is set to false, the curves used for interpolation do not depend on the interpolation tenor, they depend on
the rate index tenor.

In addition, you can set STUB_FORECAST_ADJ=true to utilize two forecast curves when a curve for the stub period
ccy/index/tenor cannot be found in the pricing environment. One curve is built around a tenor shorter than the actual
stub period and the second is built around a tenor greater than the actual stub period. The rate implied from each
curve is weighed according to the proximity of the curve tenor to the tenor of the stub period.

To edit the pricing parameter set, from the Calypso Navigator, selectMarket Data > Pricing Environment > Pricing
Parameter Set.

14.3 Swap Window Sett ings
You are able to set the Swap window to automatically calculate stub periods from the Swap menu.
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Selection Description

Automatically
Adjusting Stub

Select to automatically create stub periods without warning, when changes to the trade require
stub periods. You may override the stub period settings in the Swap window.

This cannot be selected ifWarn before Adjusting Stub or No Stub Adjusting is selected.

Warn before
Adjusting Stub

When selected, you are prompted to create stub periods when changes are made to the trade that
require stub periods. You may override the settings in the Swap window.

This cannot be selected if Automatically Adjusting Stub or No Stub Adjusting is selected.

No Stub
Adjusting

This is the default setting. The system will not create the stub periods even when changes to the
trade require stub periods. You may override the settings in the Swap window.

This cannot be selected ifWarn before Adjusting Stub or Automatically Adjusting Stub is selected.

14.3 .1 Swap Deta i ls Panel
You can set up a stub period in the Swap details area. You can select the type of stub period, custom tolerance (days)
and the index or indices used in interpolating the rate for that period.

The stub periods take into account date roll conventions, holidays and accrual methods. The stub periods use the
ISDA interpolation methodology to interpolate stub rates. These are described below:
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• FIRST / LAST indicates whether the stub is the first period or the last period

• SHORT / LONG indicates whether the stub is shorter or longer than the payment frequency

• SPECIFIC FIRST means you can enter the end date of the first period

• SPECIFIC LAST means you can enter the start date of the last period

• SPECIFIC BOTH means that you can enter the end date of the first period, and the start date of the last period

• FULL COUPON allows you to enter the full coupon date

Example
Suppose the following:

– QTR interest frequency

– trade start date of 03/01

– trade end date of 10/15

 Ⓘ [NOTE This example does not take into account holidays, date roll conventions and accrual methods. The
sole purpose is to demonstrate how stub periods are created]

SHORT FIRST Creates three periods: 03/01 - 04/15, 04/15 - 07/15, 07/15 - 10/15
LONG FIRST Creates two periods: 03/01 - 07/15, 07/15 - 10/15
SHORT LAST Creates three periods: 03/01 - 06/01, 06/01 - 09/01, 09/01 - 10/15
LONG LAST Creates two periods: 03/01 - 06/01, 06/01 - 10/15
SPECIFIC FIRST (end date of first period is 03/15) Creates four periods: 03/01 - 03/15, 03/15 -

06/15, 06/15 - 09/15, 09/15 - 10/15
SPECIFIC LAST (start date of last period is 10/01) Creates four periods: 03/01 - 04/01, 04/01 -

07/01, 07/01 - 10/01, 10/01 - 10/15
SPECIFIC BOTH (end date of first period is 04/01 and start date of last period is 09/15) Creates

four periods: 03/01 - 04/01, 04/01 - 07/01, 07/01 - 09/15, 09/15 - 10/15
FULL COUPON Creates three periods: 01/15 - 04/15, 04/15 - 07/15, 07/15 - 10/15

» Select Custom Stub Tolerance to specify the stub period offset in days, and enter the number of days in the
adjacent field. If the period in calendar days is less than or equal to the stub tolerance, it will be merged into the
period immediately next to it. If it is not set, the default is set in the environment property STUB_TOLERANCE.

» Whenever there is a stub on a floating rate, the system automatically calculates the best index tenor for the stub
period (provided No Auto Interp is un-checked on the rate index definition.) If the length of a stub period matches
exactly one of the index tenors, there is no interpolation required. If the length of a stub period is between two
index tenors, the system defaults the stub index to interpolate between the two index tenors.
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» You may customize these tenors using the Interp checkbox and the adjacent tenor fields. If no interpolation is
required, select the same tenor in both boxes. When other index tenors are selected, the Custom checkbox will be
checked. To return to the default tenors computed by the system, un-check the Custom checkbox.

14.4 General Logic of the Period Calculat ions
Calypso uses some standard date rules to calculate accrual periods, payment dates and reset dates.

• Using the trade end date and the frequency in the Payment section, Calypso calculates unadjusted period begin
and end dates. Calypso starts at the trade date and works backward to the start date. This then results in stubs
being automatically put at the beginning of the trade.

• Using the day-count (e.g. ACT/360), holiday (e.g. LON), non-business day roll rule (e.g. MOD FOLLOW) and the
accrual method selection (e.g. ADJUSTED), the period start and end date of each period is adjusted.

• The payment dates are calculated using the period end dates and the payment lag settings. Note that payment
date logic uses the same holidays and date rolls as the calculation periods.

• The reset dates are calculated using the period start dates, the reset lags and the reset roll setting (on the Swap
Details window)

• The forward dates are calculated from the reset lag and the tenor of the index.

Example
In this trade, the Pay Leg is set so that there are no adjustments for any dates, while the Receive Leg has adjustments
applied.
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14.4 .1 Curve Usage

Because of the settings (stub, with interpolation and pricing parameter), the system finds the curves that are declared
for use in the pricing environment for the 3M and the 1M curve. In this example, there is no 1W curve. These curves are
used for forecasting forward rates.
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14.4 .2 Reset Rates Used
Calypso automatically looks for the rates needed for the resets.

 Ⓘ [NOTE: Stub periods are independent of the setting for compounding and averaging, and for the Notional
amounts on which interest is computed]

Nasdaq Calypso
Trading Environment / Version 18

May 2025
Revision 5.0 / Approved

Proprietary and Confidential
Page 136 / 239



May 2025
Revision 5.0 / Approved

Proprietary and Confidential
Page 137 / 239

14.4 .3 Customiz ing Cashf lows
Rate Index, Day Count, Interpolation, Currency, Rates and Amount can be customized for any flow row. Dates can be
also set for Payment Dates and Reset Dates, but not Forward Dates.
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15. Trade Menu
The menu items of the Trade menu are described below.

Menu Items Description
New Clears the trade worksheet to allow entering a new trade.

Save Saves the trade with a unique id.

By default, the system does not allow saving a trade with a settlement date on a non-
business date.

You can add the product type to the domain "AllowNonBusinessSettleDate" to allow saving
the trade with a settlement date on a non-business day.

Save as New Saves the trade as a new trade with a unique id.

Please note the following when using the Save as New function:

• Non automatic fees attached to the original trade are not propagated to the new trade.

• Custom cashflows associated with the original trade are propagated to the new trade.

It is recommended to use the Copy and Paste functions instead to start a new trade.

Save Action Only available in the Bond and Repo windows.

Save the trade in any status available in the workflow. You will be prompted to select an
action.

Trade Attributes Opens the Trade Attributes window to enter and view trade attributes (keywords).

See Defining Trade Attributes for details.

Open Opens the Trade Selector window to select trades.

» Click Attributes to specify attribute values as applicable.

» Click Show Trades to display the trades that satisfy the attribute values.

» Double-click a trade to load its worksheet.

Simulate Allows simulating a workflow action. You will be prompted to select an action and the Trade
Simulation Report will be displayed.

See the Action field under Details Panel for details.

Trade Pending
Processing

Checks if the trade is pending processing for any engine. You will be prompted to select an
engine, and a message will be displayed to indicate the status of the trade.

See Back Office Menu for details.

Copy Copies the trade. You can use this command to copy the trade to another trade worksheet
using the Paste command.

Paste Pastes a copied trade.

XML Import To import a trade from an XML file. you will be prompted to select a file.
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Menu Items Description
XML Export To export the trade currently loaded to an XML file. You will be prompted to enter a file

name.

Print Exports the trade to the web browser in HTML format. From there, you can print the trade as
applicable.

It uses the message configuration for the TICKET message type. A default template is
provided by Calypso if no message configuration is specified. Refer to the Calypso
Messages User Guide for information on specifying message configurations.

Status Bar Displays the status of the trade at the bottom of the trade worksheet.

Old Style Market Data
Window

Activates the old style Market Data window. Close and re-open the trade worksheet for this
activation to take effect.

Close Closes the trade worksheet.
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16. Utilities Menu
The menu items of the Utilities menu are described below.

Menu Items Description
Calendar Opens the Calendar window to check business days and non-business days for a given

Holidays calendar.

» Select a Holidays Calendar as applicable. The current day Today appears in red.
Business days appear in white and non business days appear in gray.

» You can use the calendar to calculate a number of days between two dates. Enter a
start date and an end date. Select a Daycount and click Calc.

Day Diff is the number of days between the two dates with the given daycount.

Year Diff is the Day Diff equivalent with respect to the year.

» Click Closewhen you are done.

Set Default Role Opens the legal entity role selector.

» Select the default role of the trade counterparty. Then click OK.

Configure Favorite
Books

Allows specifying favorite books.

» Select books as applicable and click OK.

Configure Favorite
Templates

Allows specifying favorite templates.

» Select trade template as applicable and click OK.

Configure Favorite
CounterParties

Allows specifying favorite trade counterparties.

» Select legal entities as applicable and click OK.

Selected CounterParty
Info

Opens the Legal Entities Window for the selected trade counterparty.

Create Note This menu item will appear provided the environment property ENABLE_TRADE_NOTES is
set to true.

Opens the Create Note window that allows adding notes to the trades. When you re-open
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Menu Items Description
the trade, the notes will appear in front of the trade worksheet.

» Enter the information as applicable.

» Click Save to save the note.

» Click Help for details.

See Creating Notes for complete details.

Show Notes This menu item will appear provided the environment property ENABLE_TRADE_NOTES is
set to true.

Displays trade notes after you have closed them.

When you open a trade, the trade notes will appear in front of the trade worksheet. Trade
notes with the highest severity will appear first, then the medium severity, and finally the low
severity. You cannot access the trade worksheet until you dismiss or close the trade notes.

» Dismiss — Click Dismiss if you do not want a note to appear with the trade again. You
will not be able to dismiss a permanent note, and you will not be able to dismiss a non-
permanent note if you do not have permission to dismiss notes.

» Close — Click Close to close the note.

See Creating Notes for complete details.
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17. Back Office Browser
The Back Office Browser (BO Browser) allows viewing all the back office activity for a given trade or a given bundle,
and applying additional actions as needed.

It can be launched from the Calypso Navigator using Reports > BO Browser, from any trade window, and from the
Task Station.

Contents

- Tour of the BO Browser

- Loading a Trade

- Loading a Bundle

- Viewing Transfer Rules and Settlement Instructions

- Viewing Transfers

- Viewing Settlements

- Viewing Messages

- Viewing Postings

- Viewing CREs

- Viewing Liquidations

- Viewing Trade Diary Entries

- Viewing Tasks
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17.1 Tour of the BO Browser

BO Browser (general tour)

The BO Browser shows the following windows:

• A panel for each BO Trade Browser, each BO Bundle Browser, and each BO Trade Internal Ref Browser currently
open.

• A "Filter" window - To display the selection criteria: Trade ID, Internal Ref, or Bundle ID.

• A panel for each type of back office data: Transfer rules, Transfers, Settlements, Messages, Postings, CREs,
Liquidation, Trade Diary, and Tasks. There might be additional panels based on which modules are installed.

• A "Details" window - When you select a back office data (a message, a transfer, etc.), this window displays
additional details, and allows applying actions to the selected back office data.

• A toolbar to load, save, delete, and reset custom layouts.

These windows are described below.

You can choose > Frames to close / open the various windows.

You can hide a window by clicking . It will appear as a tab as shown for the Filter window below.
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Filter Window (shown as at tab when hidden)

To bring it back, click the tab and click .

Filter Window (bringing back a hidden window)

At any time, you can choose Layout > Reset Layout to reset the window layout.

You can click on , and choose to load, save, delete, or reset a layout.

If you choose to delete a layout, it will no longer appear to the right of the icon.

17.2 Loading a Trade

BO Trade Browser
"BO Trade Browser" is selected by default at the top of the window.

BO Trade Browser (loading a trade)

» Enter a trade ID, and click .

You can also click ... to search trades using the Trade Selector window, and select a trade.

The trade details appear in a "BO Trade Browser" panel.

» To load another trade, click "BO Trade Browser" - It will open another "BO Trade Browser" where you can select
another trade.

» You can click to view trade details, and to bring up the corresponding trade window.

» You can click to view the bundle details in case the trade is part of a bundle.

BO Trade Internal Ref Browser
You can also load trades using their internal reference.
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Click the down arrow next to "BO Trade Browser" and select "BO Internal Ref Browser" - It will open a "BO Trade
Internal Ref Browser" - Select "Int Ref" in the Trade Id field, and enter an internal reference in the adjacent field. Then
click . All the trades with the same internal reference will be loaded.

BO Trade Internal Ref Browser (the Trades panel shows the trades for the selected internal reference)

17.3 Loading a Bundle
Click the down arrow next to "BO Trade Browser" and select "BO Bundle Browser" - It will open a "BO Bundle
Browser", and you can select a bundle.

BO Bundle Browser (loading a bundle)

» Enter a bundle ID, and click .

You can also click ... to search bundles using the Bundle Selector, and select a bundle.

The bundle details appear in a "BO Bundle Browser" panel.

The "BO Bundle Browser" panel has an additional panel that allows viewing the trades in the bundle.
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BO Bundle Browser (the Trades panel shows the trades in the selected bundle)

You can select a trade to view its details in the Details window.

You can select a trade and click to open a BO Trade Browser for the selected trade.

The other panels are described below.

» To load another bundle, click "BO Bundle Browser" - It will open another "BO Bundle Browser" where you can
select another bundle.

17.4 Viewing Transfer Rules and Sett lement Instructions
Load a trade or a trade bundle, and select the "Transfer rules" panel. It displays the transfer rules (types of cashflows
that can be generated), and their corresponding settlement instructions (SDIs).

For example, if a trade is generating PAY PRINCIPAL cashflows, PAY INTEREST cashflows, and RECEIVE INTEREST
cashflows, there will be a transfer rule for each type of cashflows so that when the transfers are generated from the
cashflows, they can follow the instructions of the transfer rule: which settlement instructions to use, which settlement
type to use, which netting type to use, etc.
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BO Browser (the "Transfer Rules" panel shows transfer rules and settlement instructions)

Step 1 - You can select a transfer rule to view its details and associated settlement instructions in the Details window.
The settlements instructions are displayed in the "SDIs" panel.

You can configure the "Transfers rules" and "SDIs" panels using the menu items.

You can select a transfer rule and click to view details of the SDI route.

See Viewing the SDI Route for details.

Step 2 - The Details window shows the details of the selected transfer rule.

The settlement instructions are automatically assigned by the system if preferred SDIs have been defined.

Otherwise, you can select non-preferred SDIs, or you can click to define SDIs. It brings up the Settlement and
Delivery window - Help is available from that window.

If the SDIs are not known, you can save the trade without SDIs, and assign them later.

If none of these options are suitable because the SDIs are exception SDIs, you can associate "manual" SDIs to the
transfer rule.

See Selecting non-Preferred SDIs for details.

See Associating Manual SDIs for details.
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If you make any change to the transfer rules but do not want to keep these changes, you can click to reset the
transfer rules.

You can use the domain “DisabledTradeTransferRuleDetailView” - Any value from the Transfer Rule Details window
added to this domain will not be editable. Example “Payer Name”.

If you modify the counterparty SDI, the PO SDI can be adjusted automatically if environment property PO_SDI_AUTO_
ASSIGN = true. In this case, the PO SDI is automatically adjusted if there is an eligible SDI. If there is no eligible SDI, the
PO SDI is set to TBA.

17 .4 .1 Se lect ing Non-Preferred SDIs
In the Details window, click the down arrow next to the field "Receiver Instructions" or "Payer Instructions" as needed.

Details window (select SDI)

It brings up the SDI Chooser window.
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SDI Chooser window

You can configure the SDI Chooser using the menu items.

Step 1 - Select a different SDI, like a non-preferred SDI.

Step 2 - Click Apply in the Details window in order for the new SDI to be saved with the transfer rule.

The transfer rule will appear with a green background in status Assigned, indicating that it has been customized.

You can use the trade workflow rule CheckCustomTransferRules to check the validity of SDIs associated with
customized transfer rules.

17 .4 .2 Associat ing Manual SDIs

 Ⓘ [NOTE: You can only associate manual SDIs for the counterparty]

In the Details window, check the "Manual SDI" checkbox.

Details window (set manual SDI)
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Step 1 - Check "Manual SDI".

Step 2 - If you have already created manual SDIs, click the down arrow next to the field "Receiver Instructions" or
"Payer Instructions" as needed. It brings up the SDI Chooser as described above.

Otherwise, click to bring up the Cash Manual SDI window that allows creating manual SDIs.

Help is available from that window.

Step 3 - Click Apply in the Details window in order for the new SDI to be saved with the transfer rule.

The transfer rule will appear with a pink background in status Manual.

17 .4 .3 Viewing the SDI Route

Select a transfer rule and click . It displays the details of the SDI route.

SDI Route

» You can select the Table panel to view the SDI route in tabular form.

17.5 Viewing Transfers
Load a trade or a trade bundle, and select the "Transfers" panel. It displays the expected transfers that have been
generated by the Transfer engine.

Refer to Calypso Settlements documentation for information on generating transfers.
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BO Browser (the "Transfers" panel shows expected transfers)

You can configure the Transfers panel using the menu items.

You can select a transfer to view its details in the Details window.

You can right-click a transfer and show additional information, or apply actions.

17.6 Viewing Sett lements
Load a trade or a trade bundle, and select the "Settlements" panel. It displays the known transfers. A known transfer is
a transfer for a fixed settlement amount, a transfer for a floating amount that has been reset, or a netted transfer that
has been released for settlement.

BO Browser (the "Settlements" panel shows known transfers)

You can configure the Settlements panel using the menu items.

You can select a settlement to view its details in the Details window.

You can right-click a settlement and show additional information, or apply actions.
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17.7 Viewing Messages
Load a trade or a trade bundle, and select the "Messages" panel. It displays the messages that have been generated
by the Message engine.

Refer to Calypso Messages documentation for information on generating messages.

BO Browser (the "Messages" panel shows messages)

You can configure the Messages panel using the menu items.

You can select a message to view its details in the Details window.

You can double-click a message to view the actual document.
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You can right-click a message and show additional information, or apply actions.

17.8 Viewing Postings
Load a trade or a trade bundle, and select the "Postings" panel. It displays the postings that have been generated by
the Accounting engine.

Refer to Calypso Accounting documentation for information on generating postings.

BO Browser (the "Postings" panel shows postings)

You can configure the Postings panel using the menu items.

• Canceled postings appear with a pink background

• Stock ledger postings appear with a blue background

You can select a posting to view its details in the Details window.

You can right-click a posting and show additional information.

17.9 Viewing CREs
Load a trade or a trade bundle, and select the "CREs" panel. It displays the account enrichment events that have been
generated by the CRE engine prided the environment property SHOWCRE=true.

Refer to Calypso CREs documentation for information on generating CREs.
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BO Browser (the "CREs" panel shows account enrichment events)

You can configure the CREs panel using the menu items.

You can select a CRE to view its details in the Details window.

You can right-click a CRE and show additional information.

17.10 Viewing Liquidations
Load a trade or a trade bundle, and select the "Liquidation" panel. It displays the liquidations that have been
generated by the Liquidation engine.

Refer to Calypso Position Management documentation for information on generating liquidations.

BO Browser (the "Liquidation" panel shows liquidations)

You can configure the Liquidation panel using the menu items.

You can select a Liquidation to view its details in the Details window.

You can right-click a Liquidation and show additional information.
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17.11 Viewing Trade Diary Entr ies
Load a trade or a trade bundle, and select the "Trade Diary" panel. It displays all the trade diary entries that have been
generated by the Diary engine.

Refer to Calypso Trade Diary documentation for information on generating trade diary entries.

BO Browser (the "Trade Diary" panel shows trade diary entries)

You can configure the Trade Diary panel using the menu items.

You can select a trade diary entry view its details in the Details window.

17.12 Viewing Tasks
Load a trade or a trade bundle, and select the "Tasks" panel. It displays all the workflow tasks that have been
generated on the trade or associated messages and transfers, based on the workflow configuration.

BO Browser (the "Tasks" panel shows workflow tasks)

You can configure the Tasks panel using the menu items.
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You can select a Task to view its details in the Details window.

You can right-click a Task and show additional information.
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18. Quick Search
The Quick Search window allows looking for trades, transfers, messages, postings, bundles, CREs (provided the
environment property SHOWCRE=true), based on their ID. You can obtain those IDs from the various back office
reports.

From the Calypso Navigator, navigate to Processing > Quick Search to bring up the Quick Search window.

Quick Search window

Step 1 - Enter and ID, and select the type of ID: Trade Id, Trade External Reference, Trade Internal Reference,
CAReference, Transfer Id, Message Id, Posting Id, Bundle Id, Cre Id.

Step 2 - Click the item you want to display for the selected ID, provided the item has been generated:

• Trade - Brings up the Trade window for the following IDs:

– trade ID

– unique trade internal reference

– unique trade external reference

– transfer ID

– message ID

– posting ID

It brings up the Trade Browser otherwise.

For example, you can bring up a Trade Browser that contains all the trades associated with a given CAReference
or Bundle Id.

• BO Browser - Brings up the BO Browser.

• Transfer - Brings up the Transfer Viewer for a transfer ID, or the Transfer report otherwise.

• Message - Brings up the Message Viewer for a message ID, or the Message report otherwise.
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• Document - Brings up the actual Message Document for a message ID, or the Message Documents report
otherwise.

• Posting - Brings up the Manual Posting window for a posting ID, or the Posting report otherwise.

• Cre - Brings up the Manual CRE window for a CRE ID, or the Account Enrichment report otherwise.

Template Definition
You can specify which type of ID you want to look up by default using the Template menu.

For example, if you want to look up messages IDs by default, select Type = Message Id and choose Template > Set
Default Template. The next time you open the window, the Type field is set to Message Id.
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19. Create Note
The Create Note window allows adding notes to the trades. When you re-open the trade, the notes will appear in front
of the trade worksheet.

19.1 Creating a Note
» Enter the information as applicable. The fields are described below.

» Then click Save to save the note.

Fields Description
Type Select a note type.

You can add new types in the tradeNoteType domain from the Calypso Navigator using
Configuration > System > Domain Values (menu action refdata.DomainValueWindow).

Permanent Select this to make the note permanent so that it always appears with the trade and cannot
be dismissed. Non-permanent notes can be dismissed.

Severity Select a severity from HIGH, MEDIUM or LOW.

HIGH Severity
HIGH severity notes have a red background.

These notes appear first.

MEDIUM Severity
MEDIUM severity notes have a green background.

These notes appear after the HIGH severity notes.
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Fields Description

LOW Severity
LOW severity notes have a yellow background.

These notes appear last.

Message Enter the actual message of the note.

Audience Click ... to select who can view the note.

Process By Click ... to select who can dismiss the note. This only applies to non-permanent notes.

End Date Enter the expiration date of the note. This only applies to non-permanent notes.
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19.2 Viewing Trade Notes
When you open a trade, the trade notes appear in front of the trade worksheet. Trade notes with the highest severity
appear first, then the medium severity, and finally the low severity. You cannot access the trade worksheet until you
dismiss or close the trade notes.

• Dismiss — Click Dismiss if you do not want a note to appear with the trade again. You cannot dismiss a permanent
note, and you cannot dismiss a non-permanent note if you do not have permission to dismiss notes.

• Close — Click Close to close the note.

To view trade notes after you have closed them, choose Utilities > Show Notes.
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20. Collateral Pricing
 Ⓘ [NOTE: Collateral pricing is currently only supported for Interest Rate Derivatives trades, Equity Derivatives
trades, Commodity Swaps, Commodity OTC Options]

Collateral pricing is the ability to select the discount curve based on the collateral agreement's collateral policy
instead of the trade currency.

This necessitates the definition of a collateral agreement between the counterparty and the processing organization,
and additional settings. The CSA panel in the Trade window will show the collateral agreement if any, and the
collateral policy that will be used to select the discount curve.

 Ⓘ [NOTE: There can be only one collateral agreement per trade]

Before you Begin
Collateral pricing is enabled if the pricing parameter COLLATERALIZED_PRICING is set to On. You can set the pricing
parameter by product type.

For Equity Derivatives, the CSA panel is not displayed by default.

You need to add the CSA panel to the Equity Derivatives trade windows from the Calypso Navigator using
Configuration > System > CustomTabWindow.

» Select a product type, and set the class name to “com.calypso.apps.trading.CSATabTradeWindow”.

The margin call contract associated with the trade is saved in trade keyword MARGIN_CALL_CONFIG_ID, provided
you add the workflow rule UpdateCSA to the Trade workflow (transition NONE – NEW – PENDING for example).

For existing trades, you need to run Process Trade to update this trade keyword and set the workflow rule on
transition VERIFIED – UPDATE – VERIFIED for example.

Contents
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- Collateral Agreement Definition

- Pricer Configuration

- CSA Panel

- Collateral Policy Override

- Collateral Policy Defaults for Swaption Trades

20.1 Col lateral Agreement Definit ion
From the Calypso Navigator, navigate to Configuration > Fees, Haircuts, & Margin Calls > Margin Call to define a
collateral agreement.

Sample Agreement

The following fields are mandatory.

• In the Parties panel, select the processing organization and the counterparty.

• In the Details panel, select the product types to which this agreement applies, and set the start date.

• In the Eligible Currencies panel, set the Collateral Policy. It will be used to select the discount curve. Then set at
least one eligible currency.

Collateral policies are defined in the domain "CollateralPolicy".
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20.2 Pricer Configurat ion
In the Pricer Configuration, you need to indicate which curve to select based on the collateral policy.

Load your pricing environment, and select the Discount Curves panel.

In this example, USD trades with a CTD1 collateral policy use a EUR discount curve.

You can also use a blended curve created using the curve generator "CTDCollateral". It allows building the cheapest-
to-deliver collateral curve by blending up to three collateral discount curves.

Please refer to Calypso Zero Curve documentation for details on creating blended curves.
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Sample pricer configuration

» Select the trade currency and the collateral policy.

» Select an Interest Rate Derivatives or Equity Derivatives product type.

» Then select the curve corresponding to the collateral policy.

20.3 CSA Panel
Enter a USD trade between the processing organization and the counterparty for which you have defined the
agreement, then select the CSA panel.

It displays the corresponding agreement and collateral policy.

» You can click ... to view the agreement details.

The discount curve is selected based on the collateral currency.
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20.4 Col lateral Pol icy Overr ide
You can override the collateral policy at the trade level using the pricing parameter COLLATERAL_POLICY_OVERRIDE.

» You can enter a different collateral policy in the pricing parameter COLLATERAL_POLICY_OVERRIDE.

» When you price the trade, the discount curve will now be selected based on this collateral policy, provided there
is a curve defined in the pricer configuration for the trade currency and the selected collateral currency.
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20.5 Col lateral Pol icy Defaults for Swaption Trades
For Swaptions that settle as "Cleared Physical Settlement" or "Collateralized Cash Price," you can define a single
default collateral policy to select the discount curve, or multiple defaults distinguished by currency.

Normally, for Swaptions that settle in one of the above two conditions, the trade attribute CCPCollateralPolicy is
populated with the currency code for the underlying Swap. However, you can define domains that override this
process and automatically specify a particular collateral policy and associated discount curve configured together in
the pricing environment. The following shows the primary domain for specifying a default collateral policy and
examples of other domains defined by currency with their sample values.

• CCPCollateralPrice - When configured, this domain overrides the CCPCollateralPolicy trade attribute and replaces
the default currency code for the underlying Swap with a preferred collateral policy. Example (domain name =
domain value): CCPCollateralPolicy = CVA_1

• CCPCollateralPrice.EUR - When configured, the domain overrides the CCPCollateralPolicy trade attribute with a
domain value based on the currency code EUR. Example: CCPCollateralPolicy.EUR = CVA_2

• CCPCollateralPrice.USD - When configured, the domain overrides the CCPCollateralPolicy trade attribute with a
domain value based on the currency code USD. Example: CCPCollateralPolicy.USD = CTD-USD

Example of domains configured with values

For details on defining domains, see "Defining Domain Data" in the Getting Started documentation.

The preferred discount curve associated with the collateral policy is configured in the Pricer Configuration Window.
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For details on using the Pricer Configuration Window, see "Pricing Environment" in the Analytics and Pricing
Environment documentation.

When the type of settlement for the Swaption is specified as either "Cleared Physical Settlement" or "Collateralized
Cash Price," the trade attribute CCPCollateralPolicy is populated with the policy defined by the domain.

The preferred discount curve associated with the collateral policy is then included in the trade's market data.

Hierarchy for Domain Values
When domains are defined and the COLLATERALIZED_PRICING pricing parameter is set to “On,” the system will
perform the following flow of events to set the collateral policy.

1. Identify the underlying swap currency (e.g., EUR).

2. Look for a domain that specifies the currency (CCPCollateralPolicy.EUR). If one exists with a value, the trade
attribute CCPCollateralPolicy is set with this value. If one doesn’t exist …

3. Look for the primary domain CCPCollateralPolicy. If it exists with a value, the trade attribute CCPCollateralPolicy is
set with this value. If one doesn’t exist …

4. Set the trade attribute with the currency identified in step 1.
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21. Setting Favorites
You can set favorites from the Calypso Navigator under Configuration > Favorites: calendars, countries, time zones,
currencies, currency pairs, books, pricing environments, trade filters, analyses, analysis parameters, counterparties,
and brokers.

They will be available for selection throughout the system.

 Ⓘ [NOTE The currency pair favorite menu item must be configured using the action
apps.FavoritesUtil$CurrencyPair]

Nasdaq Calypso
Trading Environment / Version 18

May 2025
Revision 5.0 / Approved

Proprietary and Confidential
Page 170 / 239



May 2025
Revision 5.0 / Approved

Proprietary and Confidential
Page 171 / 239

22. Product Chooser
The Product Chooser window is available throughout the system each time you are prompted to select existing
products.

You can use this window to search products using the Type/Ccy panel, using the Code panel, using the Custom panel,
or using a template.

22.1 Select ing a Product

Once you have specified and selected search criteria (search criteria are defined below), do the following:

• Click Query. The products corresponding to the search criteria will be displayed on the right-hand side of the
window.

You can right-click the products list and choose “Configure Columns” from the popup menu to configure the
display.

• Select one or more products and click OK to apply the selection and close the window.

You can also double-click a product to select it and close the window.

The following functions are also available:

Functions Description
Clear Click Clear to clear the search results.

Product Id Enter a product-id and click Add to add the corresponding product to the search results.
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Functions Description
Save Click Save to save the current search criteria as a template. You will be prompted to enter a

template name.

Delete Click Delete to delete the template currently selected.

Cancel Click Cancel to close the Product Chooser window without selecting any product.

22.2 Searching Products using the Type/Ccy Panel
In this panel, you can search products by product type, currency and using the Name like function.

22.2 .1 Product Type

» To add or remove a product type, double-click the Products label and the “Select product(s)” dialog will appear
as, alternatively you can select the Products label and click Edit).

» To search all products for a given product type, select a product type and click Query.

22.2 .2 Currenc ies

» To add or remove a currency, double-click the Currencies label and the “Select currency(ies)” dialog will appear,
alternatively you can select the Currencies label and click Edit).

» To search all products for a given currency, select a currency and click Query.
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22.2 .3 Name Like

» To specify a name like, double-click the Name like label and the “Product name like” dialog will appear,
alternatively you can select the Name like label and click Edit).

– Enter the name you are searching for and click OK. You can also enter part of the name. For example, enter
B% to get the list of products beginning with B. The name like search is case insensitive.

– Then click Query.

22.2 .4 Search ing Products us ing the Code Panel
In this panel you can search products by product code. The list of available product codes is based on your product
code definition. Product codes are created from the Calypso Navigator using Configuration > Product > Code.
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» To search on a product code, double-click a product code and the “Value” dialog will appear as shown below.

– Enter a value and click OK.

– Then click Query.

22.3 Searching Products using the Custom Panel
The Custom Panel will appear provided you have implemented a custom panel. Refer to the Calypso Developer’s
Guide for information on implementing a custom panel.

A sample custom panel is provided in calypsox/tk/product/BondProductChooserHandler. Compiling this
sample will display the following custom panel.

To search on custom criteria, double-click a criteria, enter a value, and click Query.

22.4 Searching Products using a Template
Provided you have saved a template, you can select a template from the Templates field and click Query to load the
corresponding search criteria, as shown below.
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23. Shortcuts
 Ⓘ [NOTE: Typed letters are shown in this document in uppercase but may be typed in uppercase or
lowercase. Variables (for example, n to identify any integer) are shown in italics]

Combo Boxes and List Boxes

A, B, C, ... Z

0, 1, 2, ... 9

Typing a letter or a number selects the first item that starts with the character typed.

Currency Fields
In a currency field, click the down arrow, and type the first letter of the currency, for example E. The first currency that
starts with that letter will be highlighted, ESP for example. Then you can type U, and EUR will be highlighted. The field
will be automatically populated with the highlighted currency.

Currency Amount Fields
n represents an integer.

nK n thousand. For example, typing 10K makes 10,000.

nM nmillion. For example, typing 10Mmakes 10,000,000.

Date and Time Fields
When editing dates, type the date in your locale's format - For example, MM/DD/yy or MM/DD/yyyy.

With the date field in edit mode, the background will turn red if you have typed a non-business day. Type + or - to
move the date forward or backward by one day.

Ctrl+N Sets date to today or time to now.

Ctrl+E Sets time to end of day (23:59:59) to ensure loading of any market data available on the
specified day.

Ctrl+P or '+' Adds one day.

Ctrl+M or '-' Subtracts one day.

Ctrl+B or Shift+? Opens the Calendar Utility Window.

Period Shortcuts

Nasdaq Calypso
Trading Environment / Version 18

May 2025
Revision 5.0 / Approved

Proprietary and Confidential
Page 176 / 239



May 2025
Revision 5.0 / Approved

Proprietary and Confidential
Page 177 / 239

Typed in a date field, the Y, M, W, or D abbreviation will set that field's date to the end date of a period that is n years,
months, weeks, or days long, respectively. When typed in a start date field, the period is measured from the spot date
for the selected rate index or currency. When typed in any other field, the period is measured from the appropriate
period begin date. For example, if the start date of a swap is January 5, 2000 and you type '1y' in the End Date field,
the application will set the end date to January 5, 2001.

nY Date is n years out.

n.nY Date is n.n years out. For example, '2.5Y'.

nM Date is nmonths out.

nW Date is nweeks out.

nD Date is n days out.

IMM Dates Shortcuts

 Ⓘ [NOTE: The following shortcuts are supported only in the FRA trade window and for the FRA strategy in the
Pricing Sheet.]

Fyy Date is the IMMWednesday in January of year yy.

Gyy Date is the IMMWednesday in February of year yy.

Hyy Date is the IMMWednesday in March of year yy.

Jyy Date is the IMMWednesday in April of year yy.

Kyy Date is the IMMWednesday in May of year yy.

Myy Date is the IMMWednesday in June of year yy.

Nyy Date is the IMMWednesday in July of year yy.

Qyy Date is the IMMWednesday in August of year yy.

Uyy Date is the IMMWednesday in September of year yy.

Vyy Date is the IMMWednesday in October of year yy.

Xyy Date is the IMMWednesday in November of year yy.

Zyy Date is the IMMWednesday in December of year yy.

Zy All of the IMM-month shortcuts also work with a single digit year. The date will be set to the
next year ending in the single digit you type.

Date Sequence Shortcuts
IMM Tenors

The IMM Tenors refer to IMM dates that fall on the third Wednesday of March, June, September, and December.
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The IMM Tenors shortcut is supported in the Structured Flows trade window, the FRA trade window, and the Interest
Rates trade windows with the exception of the Trade Advance window and Trade AdvanceLetterCredit window.

Users can type a number followed by the letter i into the Start Date and End Date fields of a trade and press the Enter
key to populate a corresponding date.

» Start Date - The Start Date field uses the Value Date field as the reference or anchor date for determining the
Start Date from the shortcut.

Example: Value Date = 03/20/2017, the user enters the tenor 2i, the system generates a Start Date of 09/20/2017
(the 3rd Wednesday of September).

» End Date - The End Date field uses the Start Date as the reference or anchor date for determining the End Date
from the shortcut.

Example: Start Date = 09/20/2017, the user enter the tenor 4i, the system generates an End Date of 09/19/2018
(the 3rd Wednesday of September in 2018).

IMM dates are defined in the Date Rules Window.

For details on defining date rules, see "Defining Date Rules" under Reference Data in Calypso Getting Started
documentation.

Start Date
For most trades, the Start Date field is the current date plus the spot days for the selected currency. It will be
otherwise specified in the Help for that window.

To modify the spot days, from the Calypso Navigator, navigate to Configuration > Definitions > Currency Definitions
to invoke the Currency Default window.

» Select a currency and specify the spot days as applicable, then click Save.

Lag Fields
Lag fields specify a number of days after or before a given date. They are usually associated with a BUS checkbox so
that you can specify if the number of days are business days or calendar days.

To specify a number of business days, you can directly enter nb in the lag field. For example, 2b specifies 2 business
days.

Tables

 Ⓘ [NOTE: The Copy/Paste functions in tables requires SSL to be enabled]

Editing
Double-click in a cell Starts editing.
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F2 Starts editing.

Ctrl+E Starts editing.

Enter (when editing a
cell)

Accepts edit.

Enter (with cursor on a
cell)

Moves cursor down one cell.

Escape Cancels editing.

F3 Adds a row (allowed only in cashflow tables).

Ctrl+F3 Removes a row (allowed only in cashflow tables).

Ctrl+C Copies to clipboard.

Ctrl+V Pastes from clipboard. For example, you may copy a column of values from Excel and paste
them.

Ctrl+right-click in
header

Selects the table's column.

Printing
Ctrl+P Prints (to printer) in portrait mode.

Ctrl+L Prints (to printer) in landscape mode.

Exporting
Ctrl+H Exports table to HTML.

Ctrl+O Exports table to Excel (.xls format).

Ctrl+Shift+X Exports table to Excel (.xlsx format) and colors the document header in grey.

Ctrl+S Exports table to CSV file.

Double-right-click Exports table to Excel.

Shift+double-right-
click

Chooses columns and export them to Excel. Only applies if no popup menu is available for
right-click.

Trade Windows

F4 Prices.

F5 Saves.

F6 Creates new trade.

F7 Loads.

F8 Generates cashflows.

F9 Launches the Solver window to solve for the strike, fixed rate, spread, or volatility needed to
achieve a desired NPV.

Nasdaq Calypso
Trading Environment / Version 18



F10

Alt+F10

Loads a Bond trade template or a Repo trade template in Bond Front and Repo Front
respectively.

F11 In the Swap Worksheet, solves for the break-even fixed rate and applies it to the swap.

F12 In the Swap Worksheet, solves for the break-even spreadand applies it to the swap's floating
leg.

> In the fixed rate, spread, or strike rate field of a trading worksheet, adds one basis point to
the rate. (Place your cursor in the field and type '>'.)

< In the fixed rate, spread, or strike rate field of a trading worksheet, subtracts one basis point
from the rate.

Ctrl+S In the Swap Worksheet, displays the bond spread solver panel just below the fixed rate field.

Ctrl+H In the Swap Worksheet, hides the bond spread solver panel.

nB In any lag field, specifies a number of business days.

Double-click on curve On the curve name in any trading worksheet, opens curve worksheet for viewing or updating
that curve.

Shift+double-click on
curve

On the curve name in any trading worksheet, opens the curve assignment window for
choosing a new curve.

Ctrl+F In the Counterparty field of a worksheet for any contract-traded instrument, opens the Legal
Entity Chooser window to allow the selection of a counterparty.

Alt+B Launches the BO Browser.

Alt+K Launches the Trade Attributes (Keywords) window.

Alt+C Launches the Custom Data window, if any.
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24. Manipulating Cashflows
Select the Cashflows panel for generating and displaying the cashflows.

24.1 Cashflows Panel
The cashflows are generated when you click Price in the Trade panel, or when you choose Cashflows > Generate. The
cashflows are not saved unless you customize them. They are generated each time they are required for pricing the
trade.

Click here for a description of most cashflow columns.

Sample Cashflows panel with Customized Cashflows

» Choose Cashflows > Generate to generate the cashflows. The first table displays the cashflows of the pay leg,
and the second table displays the cashflows of the receive leg.

Note that if you have customized the cashflows, you should not generate the cashflows because those columns
will be overridden. You should instead choose Cashflows > Recalc.

» Check the “Customized” checkbox to modify the cashflows as applicable. [C] will appear next to the label of the
Cashflows panel.

To modify a value, double-click a cell and modify its value as applicable.

A column that contains modified values will show a star to the right of the column heading.

Note that if you do not want modified values to be overridden when the cashflows are re-calculated, you need to
lock the corresponding columns. Right-click a modified value and choose “Lock Column” or “Lock All Modified
Columns” from the popup menu.

A locked column will show a star to the left of the column heading.

» You can select a notional amortization structure and click ... to define its details.

See Product Details "Amortization Structures" for details.
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» Right-click any cell in the cashflows to display the Cash Flow Menu.

Manual Amount
The Manual Amt column is automatically checked when the Pmt Amt is manually modified. It indicates that changing
parameters that would normally be used in the calculation (fixed rate, interest start and end dates) will have no effect
since the payment amount has been manually set.

Compounding Flows
When you customize compounding flows, the "Compound Interest Amount" is added to "Interest Amount", and set to
0.

Stub Periods
When you customize the cashflows and create a stub period, you can now select the index tenor to interpolate the
stub rates on that period.

» Double-click the "Interp" field – It brings up the InterpIndexTerm dialog.

Check the “Interpolate” checkbox and select the interpolation tenors. Then click Apply.

If the system finds a curve for each stub tenor, it will use them to interpolate the stub period, otherwise it uses
tenors on the curve of the trade’s tenor forecast curve.

24.2 Cashflows Menu
All the menu items of the Cashflow menu are described below.

The Cashflow menu is accessible from the menu bar of the trade window, or when you right-click a cashflow.
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 Ⓘ [NOTE: All menu items described here may not be available for all types of trades because they would not
be applicable]

Menu Items Description
Generate To generate the cashflows.

[NOTE: If you have customized the cashflows, you should not choose Generate because the
customized columns will be overridden. You should instead choose Recalc]

Recalc When cashflows have been customized, choose Recalc to display the cashflows without
overriding customized columns.

Copy Ctl-C

Paste Ctl-V

To copy and paste into cashflow cells.

Select a cell, type [Ctrl+C], then select another cell and type [Ctrl+V]. The content of the
first cell will be pasted into the second cell.

Add Coupon To add a cashflow.

Right-click a row and choose Add. The selected row will be split between two rows. The first
one will be one day long, and the second one will fill the remaining term of the original period.
You can edit the periods as applicable.

Remove Coupon To remove a cashflow.

Right-click a row and choose Remove. The selected row will be removed.

Add Compound Period

Remove Compound
Period

To add or remove compounding periods.

These menu items require customized cashflows, and a compounding trade. Then you can
add or remove compounding periods. For example, if the trade compounds monthly, you can
add a compounding period midway through the month.

Scheduler To define an amortization schedule for the principal.

Right-click one or multiple Notional cells, and choose Scheduler. It will bring up the
Scheduler Notional window. You can select a Step-Down, Equal Principal, or Annuity
structure.

See Product Details "Amortization Structures" for details.

It will customize the cashflows.

Mortgage Scheduler To define a mortgage schedule for the principal.

Right-click one or multiple Notional cells, and choose Mortgage Scheduler. It will bring up the
Mortgage Structure window.

See Product Details "Amortization Structures" for details.

It will customize the cashflows.

Sample Values To display the sampling period for resets sampling at a frequency different from the
payment period.

Right-click a cashflow and choose Sample Values. This brings up the Reset Samples
window.
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Menu Items Description

» Enter the reset rates if they are not available and click Apply.

» You can right-click in the table to display a popup menu that allows configuring the
columns.

 Ⓘ [NOTE: Sample dates may not be available for performance swap trades with Auto
Adjust Notional and compounding or averaging on the funding leg]

Accretion Sample
Values

Only applies if the principal is amortized using the Accreting amortization structure.

To display the sampling period for the Accreting Schedule.

» Enter the reset rates if they are not available and click Apply.

Copy Principal To copy the principal cashflows from one side of the swap to the other. This is automatic if
the swap has actual principal exchange. You can copy the principal structure even if the
amortization frequency in the “from side” is different from the coupon frequency in the “to
side”. In this case, the amortization frequency will be copied as well. For instance, a side that
amortizes semi-annually can be copied to a side that pays monthly and results in a structure
that pays monthly and amortizes semi-annually.

Choose either “Copy Principal Left->Right” or “Copy Principal Right-> Left”.
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Menu Items Description
Lock Column To lock a customized column.

Right-click a customized column and choose Lock Column so that the values will not be
overridden when the cashflows are re-calculated.

A locked column will show a star to the left of the column heading.

Note that cashflows columns which are locked but not modified will cause the
corresponding fields to be outlined in blue in the trade worksheet.

Lock All Modified
Columns

To lock all customized columns.

Unlock Column To unlock a locked column.

Right-click a locked column and choose Unlock Column to unlock it.

Unlock All Columns To unlock all locked columns.

Configure Columns To select and organize displayed columns.

Save Column Config To save the column configuration.

Export to Excel To export the cashflows to an Excel xls spreadsheet.

Export to ExcelX To export the cashflows to an Excel xlsx spreadsheet.

Export to HTML To export the cashflows to an HTML page.

Show Consolidated
Cashflows

To bring up the Cashflow Report that displays all the cashflows associated with the trade.

Interest History To bring up the Interest History window if applicable.
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25. Cashflows Columns
This document describes the cashflow columns in Calypso.

- The general cashflows may be used by any product.

- The product-specific cashflows apply to the specified corresponding product.

Contents

- General Cashflows

- Bond Cashflows

- Call Notice Cashflows

- Cap Floor Cashflows

- Cash Cashflows

- CDS ABS Index Cashflows

- CDS ABS Index Tranche Cashflows

- Commodity OTC Option Cashflows

- Commodity Swap Cashflows

- Constant Maturity Swap (CMS) Cashflows

- Credit Default Swap Cashflows

- Credit Default Swap ABS Cashflows

- Equity Linked Swap Cashflows

- In Arrears Cashflows

- Non-Deliverable Swap Cashflows

- Performance Swap Cashflows

- Precious Metal Deposit Lease Cashflows

- Quanto Swap (Differential Swap) Cashflows

- Sales Margin Cashflows

- Swap Cashflows

- Swaption Cashflows

- Structured Flows Cashflows
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25.1 General Cashflows
Column Name Description
Act Exch Whether there is actual exchange of principal.

All-In Rate Used in products where the secondary market loan is an underlying instrument, such as the
Performance Swap.

The rate used to calculate the interest amount on the cash flow.

For floaters, All-in Rate = Rate + Spread

For fixed, All-In Rate = Fixed Rate

If there are caps or floors, apply those, too.

AllKnown It is checked when the reset rate is known, or clear when it is missing.

If the rate reset has been explicitly set to "0", it will appear checked.

Amort Amt Amortized amount.

Amort Rate Amortization rate.

Annuity Rate Cash
Displays the amortization rate entered in the scheduler.

Capitalization Factor Brady Bond
Setting the capitalization rate will compute the capitalization factor, which will in turn
compute the face value, notional amount, and amortization amount.

Capitalization Rate Brady Bond
Pay-in-kind rate. The coupon cap that accrues on the outstanding principal.

Cmp Begin Begin date of compounding period.

Cmp Calc Notional Notional for calculation of compounding flows (notional + accumulated interest).

Cmp End End date of compounding period.

Cmp Int Amt Displays the compounded interest amount defined at that particular period. When the
interest payments are made, the application resets the compounded interest amount, and
the subsequent interest payments are made on the following accrued interest.

Currency Specifies the currency of the cash flow, which you define in the Trade panel.

Day Ct Day count convention.

Refer to the Calypso Navigator's Help > Day-Count Conventions for a description of the
conventions.

Days Payment period length.

DC Days The number of days in the interest period, according to the Day Count convention of the
flow.

Decimals Bonds
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Column Name Description
Number of decimal places for the coupon; the coupon digits set in the bond product.

Default Date Bonds
Displays the date that the issuer defaulted, which is set in the Bond product. The interest
flow is zero.

df Discount factor used to discount the payment when calculating the present value.

External Id ID of some external system from which the flow has been imported.

Ex-Dividend Bonds
Ex-dividend date of the coupon.

Face Value Bonds
Value of the bond at maturity, set on the Bond product.

Final Index Level Inflation Swap
The final inflation index level.

Final Publ Date Inflation Swap
The final publication date of the inflation index level.

Final Rate Interest Rate Derivatives
Rate * Index Factor + Spread = Final Rate

Spread Swap and Spread Cap Floor
(Rate 1 * Index Factor 1 + Spread 1) + (Rate 2 * Index Factor 2 + Spread 2) = Final Rate

 Ⓘ [NOTE: Rounding can be applied in different ways based on the Rate Index
attributes ROUND_FINAL_RATE and ROUND_FINAL_RATE_ISDA]

Final Ref Date Inflation Swap
The final reference date when the inflation is effective.

Fixed The checkbox is selected if the interest rate is fixed.

To use a floating rate for a flow, customize the cashflows. Deselect the Fixed checkbox.
Double-click the Index Name column, and select the currency, index name, tenor, and rate
source from the drop-down menu.

Fwd Begin/End Start/end date of the forward period for which the pricer forecasts the floating rate in the
swap.

Fwd Rate Forecasted forward rate for the interest or compounding period.

Fwd Rate * Index
Factor

Interest Rate Derivatives
Forward rate for factored indices.

FX Rate The FX rate used in conversion from one currency to another (trade currency to settlement
currency for example).
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Column Name Description
FX Reset Date Date that the FX rate is reset on the cash flow.

Has Coupon Schedule Repos and Security Lending
Selected if the underlying Bond has a custom coupon schedule.

Index Factor Index factor.

Index Name A flow using a floating interest rate displays the name of the index from which it receives the
rate. Uses the index that you selected in the Trade panel, however, you can select a
different index in the Cashflows panel for an individual flow.

Idx Term Tenor of the reference index.

Inflation Factor Inflation Swap using Inflation Indexation
Final inflation level /Initial inflation level

Init Index Level Inflation Swap
The initial inflation index level.

Init Publ Date Inflation Swap
The initial publication date of the inflation index level.

Init Ref Date Inflation Swap
The initial reference date when the inflation is effective.

Int Face Value Interest face value.

Int Total Amt Cash
The interest amount and the compounding interest amount.

Interest Amt + Cmp Int Amt

Interest Amt Payment amount. For floating rate payments, this will be zero until the rate is set.

Interp Checkbox that indicates if the index tenor for the flow is interpolated.

Interp Rounding Interpolating rounding method.

Interp Rounding Dec Interpolating rounding method decimal places.

Is Compound Period When this checkbox is selected, the Compounding occurs at the End of the Period.

Lower/Floor Proj Amt Floor and Collar
Projected amount of a floorlet.

Manual Amt Specifies that the payment amount is a calculated amount that you have changed to a fixed
amount by entering the amount manually. Applies to interest and price change flows.
Changing parameters normally used in the amount calculation (fixed rate, interest start and
end dates) do not change the payment amount when Manual Amt is selected.

Manual Reset The application selects this checkbox when you edit the Interest Amt manually. Allows you
to modify the interest amount independently of the reset rate.
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Column Name Description
NB. Days The number of calendar days in the interest period, between the Pmt Begin date and the

Pmt End date.

Notional Principal amount for the period.

Notional Reset The accretion index last reset date.

Ntnl+Int Notional principal + interest amount.

Ntl Index Value Inflation Indexed Bond
Notional index value set on the bond.

Option Type Capped Swap
Payout formula type, for example, Range Floater.

Commodity Cap Floor
Specifies whether the option type is Cap, Floor, Collar, or Straddle.

Payout Rate In floating rate bonds, the real rate used to calculate the interest amount (includes the
spread and considers the floor and cap).

Period Period length expressed in years.

Pmt Amt Payment amount of the flow.

Pmt Begin Payment period start date.

Pmt Dt Payment date.

Pmt End Payment period end date.

PreConverted Fwd
Rate

Forward rate before basis conversion of projected forward rate.

PreConverted Rate Rate before basis conversion of automatic reset rates.

Principal Amt The principal amount exchanged in that flow.

Proj Amt Projected amount for the flow.

Proj FX Rate The projected FX rate.

Proj Notional Projected notional.

PV Disc Interest Amt * df

Pmt Amt * df

Rate Interest rate.

Rate Rounding Rounding method for the stub period.

Rate Rounding Dec Rounding method decimal places.

Record Date Bonds
Displays the record date for information purposes, only. The record date is the ex-dividend
date of the coupon unless the Bond product includes a record days offset.
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Column Name Description
ReFixed Rate Repo

Displays the reset rate set in Reset Samples on the flow generated to clean-up the interest.

Reset Reset date for the floating interest rate.

Sample Begin Sample begin date for averaging resets.

Sample End Sample end date for averaging resets.

Spread Spread to be applied to the floating interest rate.

If you customize the Spread, that flow changes; any remaining open flows keep the original
spread.

Commodities
Specifies the spread entered according to the delivery location. You can enter the spread in
the Definition panel, or customize the spread for each delivery period in the cashflows.

Spread Interest Interest Rate Derivatives
Notional * Spread * Period

Strike-lower The floor rate.

Strike-upper The cap rate.

Tax Bonds
Withholding tax set in the Bond product.

Type Displays the type of flow. Examples include: COMMODITY, DIVIDEND, INTEREST, PRICE_
CHANGE, and PRINCIPAL.

UnAdjusted Principal
Amount

Inflation Swap using Inflation Indexation on Principal Flows
The principal amount prior to applying any inflation indexation. See Inflation Factor.

UnAdjusted Interest
Amount

Inflation Swap using Inflation Indexation on Interest Flows
The interest amount prior to applying any inflation indexation. See Inflation Factor.

Upper/Cap Proj Amt Cap and Collar
Projected amount of the caplet.

Vol-Barrier Exotic Cap Floor
The barrier volatility.

You can overwrite the barrier volatility value in the BARRIER_VOL transient parameter.

Vol-lower The put volatility.

Vol-upper The call volatility.
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25.2 Bond Cashflows
Column Name Description
FX Rate In dual currency bonds, the coupon currency is different than the nominal currency. You can

customize the FX rate for each coupon.

Has Varying Schedule Selected if the pay-down schedule is varying.

Interest ShortFall Intex integration. Interest shortfall.

Interest ShortFall Reim Intex integration. Interest shortfall payback.

Pool Factor Outstanding pool principal divided by original principal, expressed as a decimal between 0
and 1.

Principal ShortFall Intex integration. Principal shortfall.

Principal Writedown Intex integration. Principal writedown.

Quantity Principal for the period.

Scheduled Principal
Amt

Intex integration. Scheduled principal amount.

Unscheduled Principal
Amt

Intex integration. Unscheduled principal amount.

Inflation Indexed Bonds
Infl. Factor Point on the Inflation Curve on the payment date of the flow.

Infl. Index Factor On the base date of the Inflation Curve we try to get the index factor from the quote set, for
example 122. Then we normalize it to calculate the inflation factor by dividing it by the
notional index value (for example 101, which is product specific).

Infl. Unadj. Proj. Amt Unadjusted flow amount.

Inflation Inflation by which we adjust the notional amount of a flow at time t = indexFactor *
inflationFactor.

Init Infl Reset Date Initial Inflation Reset date.

Initial Reference
Number Projection
Date

Initial reference number projection date. Taken from the Bond Product Definition.

Projected Initial
Reference Number

Projected initial reference number. Taken from the Bond Product Definition.

Final Infl Reset Date Final inflation reset date.Reset is computed based on the end period of the cashflows.

Final Reference
Number Projection
Date

Final reference number projection date.

Projected Final
Reference Number

Projected final reference number.
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Column Name Description

PricerBond
Credit Coupon Credit Derivatives

Present value of the credit coupon. Proj Amt = Credit Coupon + Credit Principal

If the INCL_RECOVERY_COUPON and INCL_RECOVERY_PRINCIPAL pricing parameters are
true, then Credit Coupon = Pmt Amt * (End Survival Prob. + (Recovery Rate * (Start Survival
Prob. - End Survival Prob.))

If INCL_RECOVERY_COUPON and INCL_RECOVERY_PRINCIPAL are false, then Credit
Coupon = Pmt Amt * End Survial Prob.

Credit Principal Credit Derivatives
Present value of the credit principal. Proj Amt = Credit Coupon + Credit Principal

If INCL_RECOVERY_PRINCIPAL is true, then Credit Principal = Notional * (End Survival Prob.
+ Recovery Rate * (Start Survival Prob. - End Survival Prob.))

If INCL_RECOVERY_PRINCIPAL is false, then Credit Principal = Notional * End Survival Prob.

Probable Amount The probable amount that will be received. This is the fixed or floating amount adjusted by
the riskiness of the bond. This is stored in the user data of the flow, not in the projected
amount.

Probable PV The npv of the flow. This is stored for display purposes only and is used by the cashflow
table. This is the discount factor times the probable amount.

Recovery Rate Credit Derivatives
Displays the expected recovery if the issuer defaults.

Start Default Prob.

End Default Prob.

Credit Derivatives
Probability that default will occur. 1 - Start Survival Prob.

Probability that default will occur. 1 - End Survival Prob.

Start Survival Prob.

End Survival Prob.

Credit Derivatives
Probability that default will not occur based on the Pmt Begin date.

Survival probability (interpolated) based on Pmt End date.

PricerBondAssetBacked
CPR Prepay annual rate %.

Estimate Face Value Face Value included in the Principal PrePayment Estimation.

Estimate Interest Projected amount.

Estimate Pool Factor Pool Factor included in the Principal PrePayment Estimation.

Estimate Principal
PrePayment

Scheduled Principal * CPR
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Column Name Description
Projected Notional Original notional amount + estimated principal prepayment amount.

Scheduled Mortgage
Payment

The scheduled mortgage payment for the period.

Scheduled Principal Value of the Scheduled Principal Payment (Scheduled Payment - Scheduled Interest).

PricerBondAusCPI – Australian Capital Indexed Bonds
K-Factor The compounded inflation-adjusted principal value.

p-Factor Average inflation between the reported Consumer Price Index (CPI) for that date and the
figure six months previous.

25.3 Cal l Notice Cashflows
Column Name Description
All In Rate Internal Rate + Internal Spread + Sales Margin

Internal Rate Internal Rate from the yield curve.

Internal Spread Internal spread from the Quote Engine.

Sales Margin Sales margin entered in the trade or from the Customer Quote Engine.

25.4 Cap Floor Cashflows
Column Name Description
Payoff Factor(%) Displays the payoff factor that you entered in the Trade panel. This factor applies to all

caplets that payout.

In the Cashflows panel you can customize the factor for an individual caplet by changing the
factor percentage.

PricerCapFloor
PRICER_
LOWERSTRIKEVOL

The put volatility.

For Collar or Straddle trades, both PRICER_UPPERSTRIKEVOL and PRICER_
LOWERSTRIKEVOL are populated. For Cap trades, PRICER_UPPERSTRIKEVOL only; for Floor
trades, PRICER_LOWERSTRIKEVOL only.

PRICER_
UPPERSTRIKEVOL

The call volatility.

PricerCapFloorBpVol
BLACK_EQUIV_VOL The Black equivalent volatility.
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Column Name Description
DELTA The DELTA measures how the options' value (which is the same as the current premium)

varies with changes in the underlying price. Mathematically, Delta is the first partial
derivative of the option price with respect to the underlying.

GAMMA GAMMAmeasures how much the Delta of an option changes with changes in the underlying
price. Mathematically this is the second partial derivative of the option price with respect to
the underlying price.

NPV_INTRINSIC Intrinsic value of the option.

THETA Theta is the change in an option's value relative to a change in the time left to expiry. In other
words, Theta measures how much an option's value changes with changes in time to
maturity. Mathematically, this is the partial derivative of the option price with respect to the
time to maturity.

TIME_VALUE Time value of the option.

VEGA Change in an option's value relative to a change in the underlying instrument's volatility.
Mathematically, this is the first partial derivative of the option price with respect to volatility.

PricerCapFloorCMSHagan
UNADJ SWAP RATE Unadjusted forward rate for the period.

25.5 Cash CashFlows
Column Name Description
All In Rate Internal Rate + Internal Spread + Sales Margin

Internal Rate Internal Rate from the yield curve.

Internal Spread Internal spread from the Quote Engine.

Sales Margin Sales margin entered in the trade or from the Customer Quote Engine.

WithHoldingTax Rate Displays the withholding tax fee applied to the cash flow.

25.6 CDS ABS Index Cashflows
Column Name Description
Fixed Correction The amount of correction corresponding to a shortfall amount that was understated and a

recovery amount overstated.

Float Correction The amount of correction corresponding to a shortfall that was overstated and a recovery
amount understated.

Int. ShortFall The interest amount shortfall, which is the difference between the expected interest
payment and the actual interest payment paid on the reference obligation.
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Column Name Description
Int. ShortFall Reim The recovery amount of an interest shortfall previously reported.

Pool Factor The pool factor for coupon and principal reduction factors. The initial value of the pool factor
is 1, and it decreases with the reduction factors.

Prin. ShortFall The principal shortfall amount, which occurs if the reference ABS fails to pay off principal by
its legal final maturity, or when the collateral pool supporting the reference obligation is
liquidated.

Prin. ShortFall Reim Recovery amount of the a principal shortfall previously reported.

Writedown The writedown amount, or a reduction in the principal.

Writedown Reim The recovery amount of a writedown previously reported.

25.7 CDS ABS Index Tranche Cashflows
Column Name Description
Loss Amount The loss amount.

Pool Factor The pool factor for coupon and principal reduction factors. The initial value of the pool factor
is 1, and it decreases with the reduction factors.

Reim Amount Reimbursement amount.

25.8 Commodity OTC Option Cashflows
Column Name Description
ATM Volatility ATM volatility for the option.

BreakEven Price Price at which a zero profit is recorded for the optionlet in deal currency per deal unit.

Buy/Sell Direction of the optionlet.

Commodity Reset Commodity reset selected in the trade.

Custom Fixing Dts B You can select custom fixing dates when you select a cash flow, right-click and choose
Show Fixings.

Deal Currency Defaults to the payment currency selected in the trade.

Deal Delta Delta in deal currency per deal unit.

Deal Gamma Gamma in deal currency per deal unit.

Deal Proj. Amount Projected amount in deal currency.

Max(0, (Deal Proj. Price in strik units - Strike)) * deal quantity

Deal Proj. Price Projected price in deal currency per reference unit.

Deal Quantity Quantity captured in the trade.
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Column Name Description
Deal Unit Units specified in the trade.

Deal/Strike Proj. Price Projected price in deal currency per strike unit.

Forward Delta Deal Delta (dealUnits) / discount factor

Forward Premium PV (dealCurr) / discount factor

OptionPrice Price for the optionlet.

Period Start

Period End

Start and end dates for the cash flow.

PV PV in deal currency.

Reference Currency Reference currency as specified in the commodity reset.

Ref. Delta Delta in deal currency per reference unit.

Ref Floating Price Floating price in reference currency per reference unit.

Ref. Gamma Gamma in deal currency per reference unit.

Ref Proj. Price Projected price in reference currency per reference unit.

Reference Quantity Quantity specified in reference currency and unit.

Ref Realized Price Realized price in reference currency per reference unit.

Reference Unit Reference unit as specified in the commodity reset.

Ref/Strike Floating
Price

Floating price in reference currency per strike unit.

Ref/Strike Proj. Price Projected price in reference currency per strike unit.

Ref/Strike Realized
Price

Realized price in reference currency per strike unit.

Strike

Lower Strike

Upper Strike

Strike price in deal currency.

Lower Strike price in deal currency.

Upper Strike price in deal currency.

Strike Unit Units for the strike.

Theta Measures the optionlet’s value relative to a change in the time left to expiry.

Total Commodity
Fixings

Known Commodity
Fixings

Unknown Commodity
Fixings

Total commodity fixings for a cash flow period.

Fixings with known prices.

Fixing with prices not yet known.

Vega Vega in deal currency.
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Column Name Description
Volatility

LowerVol

UpperVol

Volatility from the surface.

25.9 Commodity Swap Cashflows
The cashflows also display a set of the net columns, which includes Price Diff columns for the difference in price
between the pay and the receive leg.

Column Name Description
Average FX Rate The FX Quote averaged across the fixings by the Averaging Policy.

Currency Payment currency for the cash flow.

Custom Fixing Dates This checkbox is select if you have specified custom fixing dates for the period in the
Commodity Fixings dialog window.

Days Number of days in the period.

Deal Quantity The deal quantity specified for the period.

Deal Units Units specified in the trade.

Delta (RefUnit) Delta in the reference unit as specified in the commodity reset definition.

Df Weighted FX Rate This column does not appear by default, as the Average FX Rate column may be used.

For the DF Weighted FX Rate column, the known fixings have a discount factor of 1.

Fixing Date The date that the price is fixed for the settlement.

Fixing Price The price that is fixed for the settlement.

Fixing Start

Fixing End

The start and end dates of the fixing period.

Floating Price
(DealCurr/DealUnit)

Floating price in deal currency per deal unit.

Floating Price
(DealCurr/RefUnit)

Floating price in deal currency per reference unit.

Floating Price
(DealCurr/StrikeUnit)

Floating price in deal currency per strike unit.

Known Fixings Number of known fixing dates in the period.

Payment Amount
(DealCurr)

Payment amount in the deal currency.

Payment Date Date that the swaplet payment date occurs.
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Column Name Description
Period Start

Period End

Start and end date of the swaplet period.

Projected Amount
(DealCurr)

Projected amount in deal currency.

Projected Amount
(RefCurr)

Projected Price in Reference Currency per Reference Unit * Reference Quantity

Projected Price
(DealCurr/DealUnit)

Projected price in deal currency per deal unit.

Projected Price
(DealCurr/RefUnit)

Projected price in deal currency per reference unit.

Projected Price
(DealCurr/StrikeUnit)

Projected price in deal currency per strike unit.

Projected Price
(RefCurr/RefUnit)

Projected price in reference currency per reference unit.

PV (DealCurr) PV in the deal currency.

Realized Price
(DealCurr/DealUnit)

Realized price in deal currency per deal unit.

Realized Price
(DealCurr/RefUnit)

Realized price in deal currency per reference unit.

Realized Price
(DealCurr/StrikeUnit)

Realized price in deal currency per strike unit.

Reference Currency Currency of the underlying commodity as defined in the commodity reset definition.

Reference Quantity The deal quantity converted to the reference units.

Reference Units The units specified for the underlying commodity in the commodity reset definition.

Spread Adjusted Price
(DealCurr/DealUnit)

Spread adjusted price in deal currency per deal unit.

Spread Adjusted Price
(RefCurr/DealUnit)

Spread adjusted price in reference currency per deal unit.

Swaplet Breakeven
Price
(DealCurr/DealUnit)

Price at which a zero profit is recorded for the swaplet in deal currency per deal unit.

Swaplet Breakeven
Price
(DealCurr/RefUnit)

Price at which a zero profit is recorded for the swaplet in deal currency per reference unit.
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Column Name Description
Swaplet Breakeven
Price
(DealCurr/StrikeUnit)

Price at which a zero profit is recorded for the swaplet in deal currency per strike unit.

Total Fixings Total number of fixings for the swaplet.

Unknown Fixings Number of the fixings that have not yet occurred for the swaplet.

25.10 Constant Maturity Swap (CMS) Cashflows
Column Name Description
CMS_ADJUSTMENT Displays the total adjustment in CMS rate.

CMS_CORR_RATE_
INDEX_
PAYMENT_INDX

Displays the correlation between payment index and rate index.

CMS_PAYMENT_
INDEX_VOL

Displays the payment index volatility in percentage.

CMS_RATE_INDEX_
VOL

Displays the rate index volatility in percentage.

25.11 Credit Default Swap Cashflows
Column Name Description
PV Credit PV Credit = - (termination payment * (Start Survival Prob. – End Survival Prob.) * df)

Termination payment is typically notional – recovery.

PV Premium Interest Amt * df * Start Survival Prob.

Start Survival Prob.

End Survival Prob.

Survival probability based on Pmt Begin date.

Survival probability (interpolated) based on Pmt End date.

25.12 Credit Default Swap ABS Cashflows
Column Name Description
Int. ShortFall The interest amount shortfall, which is the difference between the expected interest

payment and the actual interest payment paid on the reference obligation.

Int. ShortFall Reim The recovery amount of an interest shortfall previously reported.

Pool Factor The pool factor for coupon and principal reduction factors. The initial value of the pool factor
is 1, and it decreases with the reduction factors.
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Column Name Description
Prin. ShortFall The principal shortfall amount, which occurs if the reference ABS fails to pay off principal by

its legal final maturity, or when the collateral pool supporting the reference obligation is
liquidated.

Prin. ShortFall Reim Recovery amount of the a principal shortfall previously reported.

Writedown The writedown amount, or a reduction in the principal.

Writedown Reim The recovery amount of a writedown previously reported.

Implied Writedown Amt If the reference ABS does not allow for writedown, an Implied Writedown may apply as a
credit event. The amount of Implied Writedown is calculated based on the under-col-
lateralization of the reference security, or any shortfall between the reference obligation's
pool balance and the aggregate balance of all pari passu obligations and senior securities
backed by the same pool.

Implied Writedown
Reimbursement
Amount

If the underlying instruments do not provide for writedowns, applied losses, principal defi-
ciencies or realized losses in regard to the reference obligation, an amount determined by
the Calc Agent will be provided.

25.13 Equity Linked Swap Cashflows
Column Name Description

Price Change Cashflows
Fixing Dt Date that a price or rate is fixed on the cash flow.

Pay Proj. Start Price

Pay Proj. End Price

The projected start and end price of the equity in the pay currency.

Pay Start Price

Pay End Price

The start and end price of the equity in the pay currency.

Proj. Start FX

Proj. End FX

If the reference currency does not match the pay currency, then the Proj. Start Price and
Proj. End Price will be converted into the pay currency using the projected FX rates.

Proj. Start Price

Proj. End Price

Projected Start and End price of the equity from the dividend curve.

Proj. Start Qty

Proj. End Qty

Projected start and end quantity.

Ref. Ccy The currency of the underlying equity.

Start FX rate

End FX rate

If the reference currency does not match the pay currency, then the Start Price and End
Price will be converted into the pay currency using the FX rates.
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Column Name Description
Start Price

End Price

Start and End Price of the equity.

Start Quantity

End Quantity

Start and end quantity of the equity.

Dividend Cashflows
Div Ex Date Projected dividend ex-date based on the dividend rule associated with the trade.

Div Qty Number of shares negotiated at transaction level.

Div Ratio 100%.

Div Record Date Projected dividend date based on the dividend curve associated with the trade.

Div retro rate Retrocession Rate negotiated at transaction level. Final Dividend Amount adjusted by this
coefficient.

Div Tax Refund Refund the taxes attached to the dividend.

Div Unit Amt The dividend unit amount is based on the projected dividend of the dividend curve
associated with the trades.

Note that in order to generate projected dividends, the dividend curve associated with the
trade must be a discrete dividend curve.

Proj Div Unit Amt Projected dividend unit amount.

25.14 In Arrears Cashflows
Column Name Description
IA_ADJUSTMENT Displays the total adjustment.

IA_CORR_RATE_INDEX_
PAYMENT_INDX

Displays the correlation between the payment index and the rate index.

IA_PAYMENT_INDEX_
VOL

Displays the payment index volatility in percentage.

IA_RATE_INDEX_VOL Displays the rate index volatility in percentage.

25.15 Non-Del iverable Swap Cashflows
Column Name Description
df Settle The discount factor converted to the settlement currency.

Interest Amt in Native
Ccy

The interest amount in the native or non-deliverable currency.
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Column Name Description
Native Ccy The native or non-deliverable currency.

PV Disc in Settlement
Currency

Interest Amount (settle ccy) * df (settle ccy)

Settlement FX
Description

Includes the currency pair and the FX Reset name.

Settlement FX Rate The FX reset rate used to convert the interest amount to the settlement currency.

Settlement Reset Date of the FX Reset.

25.16 Performance Swap Cashflows
Column Name Description

Price Change Cashflows
Fixing Dt Date that a price or rate is fixed on the cash flow.

Proj. Start FX

Proj. End FX

If the reference currency does not match the pay currency, then the Proj. Start Price and
Proj. End Price will be converted into the pay currency using the projected FX rates.

Proj Start Price

Proj End Price

Projected Start and End price of the equity from the dividend curve.

Proj Start Qty

Proj End Qty

Projected start and end quantity.

Ref. Ccy The currency of the underlying equity.

Start FX rate

End FX rate

If the reference currency does not match the pay currency, then the Start Price and End
Price will be converted into the pay currency using the FX rates.

Start Price

End Price

Start and End Price of the underlying.

Start Notional

End Notional

Start and end notional of the underlying.

Sub Id Id of the underlying.

Dividend Cashflows
Div Ex Date Projected dividend ex-date based on the dividend rule associated with the trade.

Div Qty Number of shares negotiated at transaction level.

Div Ratio 100%.

Div Record Date Projected dividend date based on the dividend curve associated with the trade.
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Column Name Description
Div retro rate Retrocession Rate negotiated at transaction level. Final Dividend Amount adjusted by this

coefficient.

Div Tax Refund Refund the taxes attached to the dividend.

Div Unit Amt The dividend unit amount is based on the projected dividend of the dividend curve
associated with the trades.

Note that in order to generate projected dividends, the dividend curve associated with the
trade must be a discrete dividend curve.

Proj Div Unit Amt Projected dividend unit amount.

Bond Index Cashflows
Start Mod Adj Duration Bond index - start modified adjusted duration for the period.

End Mod Adj Duration Bond index - end modified adjusted duration for the period.

Start Spread Bond index - start spread for the period.

End Spread Bond index - end spread for the period.

25.17 Precious Metal Deposit Lease Cashflows
Column Name Description
Interest Amt in Native
Ccy

Interest amount in the precious metal currency before it is converted using the FX rate.

25.18 Quanto Swap (Differential Swap) Cashflows
Column Name Description
QTO_ADJUSTMENT Displays the total adjustment.

QTO_CORR_RATE_
INDEX_FX

Displays the correlation between the FX rate and the rate index.

QTO_FX_VOL Displays the FX rate volatility.

QTO_RATE_INDEX_
VOL

Displays the index rate volatility in percentage.

25.19 Sales Margin Cashflows
Column Name Description
Disc. Interest Amt (Sales Margin) Interest Amt(Sales Margin) * df.

Present value of the sales margin cash flow.
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Column Name Description
Interest Amt (Sales Margin) Sales margin amount for the payment period.

Sales Margin Percentage of the notional applied on the premium date.

25.20 Swap Cashflows
Column Name Description
Coupon Formula The quotable variable defined in the exotic structure.

Exotic Capital Displays the notional or variable that represents the notional amount in the exotic structure.

Net Proj Amt Displays the net projected amount from both legs’ flows. If the net projected amount
contains flows that are more than 5 days apart, then the amount has an asterisk (*)
displayed after the number.

Net PV Amt Displays the net amount from both legs’ flows. If the net amount contains flows that are more
than 5 days apart, then the amount has an asterisk (*) displayed after the number.

Redemption Formula The redemption formula defined in the exotic structure.

25.21 Swaption Cashflows
See also Swap Cashflows.

Column Name Description
Adj FX Displays the FX rate used to calculate the adjustment amount.

Adj Reset Displays the FX Adjustment reset date.

Prin Adj Shows which period requires the FX Adjustment.

Prin Adj Amt Shows the adjustment amount for the period.

25.22 Structured Flows Cashflows
Column Name Description
Int Pmt Amt Displays the interest payment amount.
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26. Capturing Details
The Details panel allows entering and viewing additional information on the trade. It also gives you access to workflow
functions for modifying and processing the trade.

» Enter information as applicable. The fields are described below.

» You can click Bundles to associate the trade with a trade bundle. You will be prompted to select a trade bundle.
The associated trade bundle will be displayed. Trade bundles are created from the Calypso Navigator using
Configuration > Books & Bundles > Trade Bundle.

You can define the action to apply when a trade is added to a trade bundle in the domain
"actionAddTradeBundle". If not defined, the AMEND action is applied.

» You can click Remove From Bundle to remove the trade from the selected bundle.

You can define the action to apply when a trade is removed from a bundle in the domain
"actionRemoveTradeBundle". If not defined, the AMEND action is applied.

» You can click Back Office to display the back office operations.

See BO Browser for details.

» You can click Trade Attributes to specify trade attributes.

See Defining Trade Attributes for details.

» You can click Product Code to enter values for OTC product codes that have been defined in the Product Code
Window.

 Refer to Calypso Getting Started documentation for details on defining product codes.

 Ⓘ [NOTE: Product code values for securities are specified at the product level (i.e., in the product definition)
while product code values for OTC products are specified at the trade level, as discussed here]

Fields Details

Fields Description
Trader Select a Trader.

You can click ... to add new traders. You will be prompted to enter a trader name. Trader
names are defined in the "trader" domain.

Trade Date If the Current Trade DateTime is checked, the trade date displays the current date and time
and cannot be modified. Otherwise, you can modify it as applicable.

Current Trade Date
Time

Check this box to save the trade with the current date and time, or with the specified trade
date otherwise.
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Fields Description
You can set the default value for this checkbox using Configuration > User Access Control
> User Settings from the Calypso Navigator.

The property is "TradeDateTimeCurrent".

Sales Select a sales person.

You can click ... to add new sales persons. You will be prompted to enter a sales person
name. Sales persons are defined in the "salesPerson" domain.

MarketPlace Select the market place where the trade is captured.

A market place is a legal entity of role "MarketPlace".

Action Shows the action currently performed on the trade based on the workflow configuration.

You can select an action that will be applied to the trade upon saving as applicable.

If you are not sure of the consequences of a given action, choose Trade > Simulate. You will
be prompted to select an action and the Trade Simulation Report will appear.

You can prevent some actions from being applied in Trade Details panel — The trade rule
CheckValidAction can be added to the mandatoryTradeRule domain so that it will be
checked on any transition. The following actions are prevented by default: TERMINATE,
EXERCISE, ROLLOVER, ROLLBACK, and the reconvention actions defined in the domains
“ReconventionAction.<reconvention type>” and “ReconventionDeleteAction.<reconvention
type>”. These actions have to be performed from their dedicated windows and processes.
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Fields Description
Status Shows the current status of the trade based on the action performed and the workflow

configuration.

A status of NONE or PRICING indicates a trade that has not yet been committed to with a
counterparty. A status of PENDING indicates a trade awaiting approval before it can be
booked. A status of VERIFIED indicates a booked trade. The VERIFIED status will generally
trigger the Back Office operations.

Market Type Select a Market Type as needed: None, Primary or Secondary.

Subsidiary Click ... to select a subsidiary. The Legal Entity Chooser will appear. You will be prompted to
select a legal entity of role subsidiary.

StepIn Transferor Transferor from a Step-In Novation done through DTCC.

Calc Agent Select a calculation agent as needed. The calculation agent is the party who acts as the
referee in the event of a disagreement about a deal's rate reset or other payment detail. The
calculation agent will be designated in a legal agreement such as an ISDA agreement.

Comment Enter a comment as applicable.

Mirror Check this box to generate an internal mirror trade. You will be prompted to select a book for
the mirror trade.

In order to enter a mirror trade, the counterparty of the trade can be one of the following:

• The processing org that owns the mirror book, provided it has a CounterParty role.

• An internal counterparty, i.e. a counterparty which parent is the processing org of the
trade.

After the trade is saved, the id of the mirror trade will appear next to the Mirror checkbox.

If you add trade keywords to the "MirrorKeywords" domain, when these trade keywords are
populated on the original trades, they will be saved on the mirror trades as well.

Upon saving, two trades will be saved, and two tasks will be created, one for each trade.
This is the default behavior with environment property MIRROR_WORKFLOW = true. So after
the trades are saved, the mirror trade will be independent from the original trade, and will
follow its own workflow. By using a static data filter on the mirror book for example, you can
apply different actions to the mirror trade. Note that you can only specify a static data filter
on the mirror book on an STP transition.

However, if you set MIRROR_WORKFLOW = false, two trades are saved, but only one task is
created. So from the point of view of the workflow you only see one trade. Upon saving, the
action is automatically applied to the mirror trade regardless of whether the mirror trade
satisfies the rules or not (unless the rules are specifically designed for mirror trades, like
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Fields Description
CheckMirrorSDI) .After the trades are saved, any modification to one of the trades is
automatically propagated to the other.

 Ⓘ [NOTE: The environment property MIRROR_WORKFLOW does not apply to FX
trades or Cash trades. FX trades have their own routing process, please refer to
Calypso FX Trade & Position Routing documentation for details. Cash trades are linked
using the MMLinked workflow rule unless the environment property CASH_MIRROR_
WORKFLOW = True]

Internal Ref. Enter an internal reference for the trade as needed.

It can be used for reporting purposes, and you can search trades using their internal
reference throughout the system.

You can set the environment property AUTO_FEED_INTERNAL_REF to true to automatically
populate the internal reference with the ID of the original trade for trades created through
partial termination and novation, else with the trade ID.

External Ref. Enter an external reference for the trade as needed.

It can be used for reporting purposes, and you can search trades using their external
reference throughout the system.

You can set the environment property AUTO_FEED_EXTERNAL_REF to true to automatically
populate the external reference with the value of the trade keyword TRANSFER_FROM if not
empty, else with the trade ID.
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27. Viewing Trade History
You can display a History panel in a trade window, to view all lifecycle activity associated with a given trade.

To view this panel, choose View > Trade History Tab in a trade window.

Sample History panel

By default, it shows trade keywords related to trade lifecycle activity.

You can right-click in the table and choose "Column Configuration" to add more columns to the display. You can also
save the column configuration as a template.
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28. Pricing a Trade
The pricing fields and pricing panels at the bottom of the Trade panel are common to all trade worksheets.

Sample Pricing panels

Two additional panels, Pricer Override and Market Data Item Override are available in case the product supports the
Trade Level Override feature as defined in the domain “TradeLevelOverride.Products”. These two panels are used to
override the default pricer and default market data item specified in the Pricing Environment. See below.

The Pricing Env defaults to the pricing env of the user defaults, and the Val Date defaults to today. You can change
those values as applicable. Changing the val date and clicking Back Office > Historical Pricing will allow a user to
audit the trade using past data.

» You can double-click the Val Date label to get the current date and time.

» You can double-click the Pricing Env label to select another pricing environment.

» Choose Pricing Env > Check to check if all required market data are available in the pricing environment.

» Click Price to price the trade.

Market Data Panel
The Market Data panel shows the market data used to price the trade. They are loaded from the selected Pricing Env.
You can double-click a market data item to view its details.

For CRD trades, when you double-click a market data item, it will bring up the Credit Market Data window.

A market data item is identified as follows:

- A label which indicates the type of market data item (for example REC_DIS for receiver side discount curve, and
REC_FOR for receiver side forecast curve).

- The market data item name, currency, instance type and date time.

- (R) to indicate that the market data item has been rolled to the current valuation date.

To get the market data from a feed source, select a Market Data Server in the User Defaults, and start the Market Data
Server.

Refer to Market Data Server Documentation for details.
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If Pricing Env > Real Time Change is checked, the market data are updated in real-time according to the configured
frequency, and turn yellow when they are modified.

» You can double-click a market data item to display its details. If the Market Data Server is locked (lock icon in
locked position), it brings up the corresponding market data window, and if the Market Data Sever is not locked, it
brings up the Market Data Manager. You can always bring up the Market Data Manager using Pricing Env >
Market Data Manager.

» You can lock the Market Data Server by clicking the lock icon in lock position. It freezes the market data, and the
trade no longer receives real-time updates. You can double-click a market data item to modify it, or bring up the
Market Data Manager to modify the market data as needed. The modifications only apply to the current trade.

» You can switch market data items on-the-fly. Shift-double-click or Ctrl-double-click a market data item to display
the market data item selection window.

Enter selection criteria as applicable and click Load.

A market data item that is different from which of the pricing environment turns green.

The modifications only apply to the current trade.

 Ⓘ [NOTE: If you do not have a Market Data Server running, and you modify the market data for the trade, the
local modifications will not be propagated to any On Demand Analysis request with "trade source" parameters.
Local modifications will only be propagated if a Market Data Server is running and locked - Please refer to
Calypso On Demand Analysis documentation for details]

Pricer Params Panel
The Pricer Params panel shows the pricer and the pricing parameters used to price the trade.
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» You can change the pricer and the pricing parameters as applicable to price the current trade. The settings in this
panel are not persistent, they are only used to price the current trade and do not apply to other trades.

Note that if you change the val date, the local parameters are reset to their default value. You need to set them
again as applicable.

» To change the settings at the pricing environment level, choose Pricing Env > Pricing Param to invoke the Trade
Pricing Param window.

It allows you to change the pricer and the pricing parameters, and distinguishes between global parameters and
local parameters. Click Applywhen you are done.

» You can configure the order of the pricing parameters. Select the product-specific menu and choose “Re-order
Pricing Parameters”.

» If you want to save the pricing parameters configuration, select the product-specific menu and choose “Save
Parameters Order”.

Results Panel
The Results panel shows the pricer measures – the outputs of the pricers.

» Double-click a pricer measure to display more pricing details – not all pricer measures provide details.

» You can configure the pricer measures displayed in the Results panel. Select the product-specific menu and
choose “Configure Results”. You will be prompted to select pricer measures.

For most trades, you can select the pricer measure DETAILED_DATA that displays pricer measure results in
multiple currencies if applicable (base, pay, and receive currencies).

» If you want to save the results configuration, select the product-specific menu and choose “Save Result Config”.

 Ⓘ [NOTE: You can format negative numbers and the background color using the following User Default
attributes: NumberFormat, DefaultZebraBackgroundColor, ZebraRowColor]

Pricer Override Panel
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This panel appears provided the product type is set in domain “TradeLevelOverride.Products”.

The Pricer Override panel allows overriding the default pricer coming from the pricing environment in a persistent
fashion. This trade will always be priced using the new pricer. A key establishing the product-pricer relationship is
used to override the default pricer.

Select an existing key from the Key Name field. Keys can be created locally or you can create system-wide keys from
the Pricer Configuration. The Pricer Override key is saved with the trade.

» Click New to create a local key. Only this trade can use this key. It opens the “Create a new Pricer Override Key”
window.

Enter the required details, Key name (represents a unique relation between product and pricer) and Pricer as
shown below.

Click Create to create the new key. The newly created key is selected automatically.

If you want to use this key system-wide, click Update PricerConfig.

To remove an override, you can select “none” in the Key Name and price the trade once again.

Market Data Item Override Panel
This panel appears provided the product type is set in domain “TradeLevelOverride.Products”.

The Market Data Item Override panel allows overriding the default market data coming from the pricing environment
in a persistent fashion. This trade will always be priced using the new market data. A key establishing the product-
pricer-market data relationship is used to override the default pricer.
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» Select an existing key from the Key Name field. Keys can be created locally or you can create system-wide keys
from the Pricer Configuration. The Market Data Item Override key is saved with the trade.

Repo trades use a different key system - See "Repo Trade Keys" below for details.

» Click New to create a local key. Only this trade can use this key. Its opens the “Create a newMarket Data Item
Override Key” window.

Enter the required details, Key name (represents a unique relation between product and market data item),
Product, Pricer, Usage and Market Data Item as shown below.

Click Create to create the new key. The newly created key is selected automatically.

If you want to use this key system-wide, click Update PricerConfig.

To remove an override, you can select “none” in the Key Name and price the trade once again.

Repo Trade Keys

For repo trades only, the keys are static data filters, and the list of available keys is defined in the domain
"Repo.TLO.SDF".
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» Define a static data filter as needed. In the Comment field, enter the name of the key to be mapped with the static
data filter.

» Add the static data filter to the "Repo.TLO.SDF" domain. In the Value field, enter the name of the static data filter.
In the Comment field, enter the name of the key as it was entered on the static data filter.

 Ⓘ [NOTE: You need to reload the pricing environment after modifying any of these domain values]
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29. Displaying Resets
Select the Resets panel to display reset rates.

Note that it only displays official reset rates, not specific resets defined at the trade level.

Official reset rates are set from the Calypso Navigator using Trade Lifecycle > Reset > Rate Reset, or using the RATE_
RESET scheduled task.

Sample Reset panel

» Click Load Resets to display all relevant resets for the current trade.
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30. Manipulating Trade Templates
Note that not all types of trades allow creating a trade template.

30.1 Saving a Trade Template
Enter a trade in a trade worksheet, and select the product-specific menu and choose “Save As Template” to create a
trade template.

» You will be prompted to enter a template name, and to specify if the template is private or not (other users will not
be able to use private templates).

The values of the trade will be used as default values when the template is selected in the same trade window.

To store trade keywords with the template, add the keyword names to the domain "tradeTmplKeywords".

Example:

30.2 Using a Trade Template
A template can be used to specify a trade speed button, and is available for selection in a trade worksheet from the
Template field.

30.3 Delet ing a Trade Template
Select the product-specific menu and choose “Delete Template”.

» You will be prompted to select a template name.

Only the user who created a template (whether it is public or private) can delete it.

You can also delete templates from the Calypso Navigator using Utilities > Maintenance > Monitoring > Clean-up
> Clean-up Database > Products panel.

Refer to Calypso Utilities documentation for details.
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31. Trade Version
Calypso provides extensive version control and audit facilities through the audit mode. A firm chooses what types of
data to audit. For example, a firm can audit reference data and trade data but not market data. When a firm decides to
audit a type of data, Calypso tracks every change to each piece of data of that type.

Users can:

• See old and new versions side-by-side

• See a trade as it existed at a particular point in time

• Compare changes on a field-by-field basis to see each field that changed, who made the change, when, what the
old value was, and what the new value is

The ability to reconstruct a trade as it existed in the past is useful not just for audit and control, but also for P&L
attribution: is a P&L change due to changing market conditions or to corrections to the trade details?

The version number of a trade is only incremented if data has changed on the Trade. If you save a trade twice without
making any modifications, the trade version number will remain the same.

 Ⓘ [NOTE: If the environment property TRADE_VERSION_INC is true, the version number of a trade will be
incremented each time the trade is saved, whether trade data has changed or not]

Refer to Calypso Audit documentation for complete details.

Nasdaq Calypso
Trading Environment / Version 18



32. Defining User Defaults
Once you have logged into the Calypso Navigator, you may want to set up default values for various fields. They will
mostly be used in trade worksheets, and will apply to your user name only.

From the Calypso Navigator, navigate to Configuration > User Access Control > User Defaults (menu action
refdata.UserDefaultsWindow) to define default values.

» Select a user and edit the fields as applicable. The fields are described below. Then click Save to save your
changes.

» You can click Load All to load all users.

» You can click Attributes to specify User Defaults attributes as applicable.

See Out-of-the-Box Attributes for details on attributes provided out-of-the-box.
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You can set your signature on the trade confirmation messages by setting the Workflow rule "AppendSignature"
with the specific manual action 'SIGN' and message keyword "APPROVAL_SIGNATURE". The value of the
signature will be a link to an image file stored in the image repository.

When the workflow rule is set, a pop-up is displayed to approve and append the signature:

If you select yes, then User Defaults > Attributes > Signature is set and confirmation will be generated with the
signature.

If you select no, then User Defaults > Attributes > Signature is not set, confirmation will be generated with empty
signature, and a task “No signature found for user ‘username’" is created.

» You can click Templates to select default trade templates per product type.

Nasdaq Calypso
Trading Environment / Version 18



Then click Save to save the default templates.

When you open the corresponding trade window, the template will be loaded by default.

Fields Details

Fields Description
User Select a user.

User Type Select a user type: Sales, System, Trader or Any.

The user type is for information purposes only.

User types are defined in domain "UserTypes".

E-Mail Enter the default email address as needed. It will be used when you send messages through
the EMAIL gateway.

Default Directory Click ... to select the default directory. It will be used to store documents and reports. If not
specified, the system's user directory will be used.

Example: C:\Users\<user>.

Currency Select the default currency. New trades default to this currency.

Currencies are created from the Calypso Navigator using Configuration > Definitions >
Currency Defaults.

Please refer to Calypso Getting Started documentation for details.

Language Select the default language (used mainly for messages).

You can click ... to add a language.

Trade Filter Select the default Trade Filter to load trades.

Trade filters are user-defined collections of trades.

They are created from the Calypso Navigator using Configuration > Filters > Trade Filter.

Please refer to Calypso Trade Filter documentation for details.
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Fields Description
Time Zone Select the default time zone in which the user operates.

Book Select the default trading book.

Trading books are created from the Calypso Navigator using Configuration > Books &
Bundles > Trading Book.

Please refer to Calypso Getting Started documentation for details.

Holidays Select the default holiday calendar. This calendar is used when there is no holiday calendar
specified in the Currency Defaults. It is also used when there is no holiday calendar specified
for running scheduled tasks in the Trigger Definition Window.

You can click ... to add all calendars that apply.

Holiday calendars are created from the Calypso Navigator using Configuration > Definitions
> Holiday Calendars.

Please refer to Calypso Getting Started documentation for details.

Trader Name Select the default name of the trader capturing trades.

Trader names are defined in the "trader" domain.

Book Hierarchy Select the default book hierarchy for sorting trades and positions in reports.

Book hierarchies are created from the Calypso Navigator using Configuration > Books &
Bundles > Book Hierarchy.

Please refer to Calypso Getting Started documentation for details.

Marketplace Select the default market place where the trades are captured.

A market place is a legal entity of role "MarketPlace".

Sales Person Select the default name of the sales person initiating trades.

Sales persons are defined in the "salesPerson" domain.

If the domain salesPerson is empty (and only in that case) and the Sales Person is set to
blank in the User Defaults, the Sales Person field defaults to blank in the trades.

Security Code Select the default security code (ISIN, CUSIP, INTERNAL, etc) to display on trade entry
windows for position-based products.

Security codes are created when defining products.

Market Type Select the default market type of the trades you enter.

Market types are created when defining bond products.

Default Index Select the default interest rate index.

Rate indices are created from the Calypso Navigator using Configuration > Interest Rates >
Rate Index Definitions.

Please refer to Calypso Getting Started documentation for details.

Bond Type Select the default bond type.
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Fields Description
Bond types are created when defining bond products.

Rate Decimals Enter the default number of decimals you want to display for interest rate indices.

For example, if the Rate Decimals field is set to 5 for a particular user, in the swap trade
window, the fixed rate 6.123456 will be displayed as 6.12345.

 Ⓘ [NOTE: A currency's Rate Decimals setting in the Currency Default window
normally takes priority over the Rate Decimals setting in the User Defaults window.
However, if you enter -1 for Rate Decimals in the Currency Default window, this will give
priority to the setting specified in User Defaults. See "Defining Currencies and Currency
Pairs" in the Getting Started documentation for further details]

Pricing Env Select the default Pricing Environment.

Pricing environments are created from the Calypso Navigator usingMarket Data > Pricing
Environment > Pricing Environment

Please refer to Calypso Pricing Environment documentation for details.

Country Select the default country.

Countries are created from the Calypso Navigator using Configuration > Definitions >
Countries.

Please refer to Calypso Getting Started documentation for details.

Locale Setting the Locale here enables different users to be logged in to the same data server but
each using a different locale.

The value set in this field overrides the value set in the Environment.

Trade Reference Select the default trade reference for selecting trades: ID, Ext Ref, or Int Ref.

In trade windows and reports, you can load individual trades based on the trade id (ID),
external reference or internal reference.

The internal reference and external reference can be set in the Details panel of the trade
worksheets.
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Fields Description
Event Filter Enter a filtering string as needed to filter the events that the user will receive - For example,

Trader=Andy.

Note that this string will only be processed by the event server provided custom processing
classes have been implemented. Refer to the Calypso Developer’s Guide section “Event
Filtering” for complete details.

Workflow Tasks Filtering
If you set the Event Filter to Task, tasks will be filtered on the server side based on the Task
Station User Defaults if they contain a task internal reference. As a result, the Task Station of
the user will only receive those task events that match the specified task internal reference.

Please refer to Calypso Task Station documentation for complete details.

ShowMain Trade Menu Check this box to display the Trade menu from the Calypso Navigator, or hide it otherwise.

When the Trade menu is hidden in the Calypso Navigator, you can capture trades from the
Trade Blotter.

Trade Window Config In some cases, Calypso provides various implementations of the same trade window, and it
also allows invoking custom trade windows.

The trade window configuration allows associating a trade window with a given
implementation, other than the default. Select the trade window configuration here. You
need to restart the Calypso Navigator in order for the change to take effect.

Trade window configurations are created from the Calypso Navigator using Configuration >
User Access Control > Trade Window Configuration (menu action
refdata.TradeWinConfigWindow). When a specific trade window configuration is needed
it will be described in the corresponding asset class user guide.

Please refer to the Calypso Developer’s Guide for information on implementing custom
trade windows.

Clear Trade After Save When this flag is checked, after you save a trade, the trade window clears the trade and
restores the trade window to the default template values.

 Ⓘ [NOTE: This feature currently only applies to FX trade windows (Spot, Fwd, Swap,
Spot Reserve, TTM, NDF and Opt Fwd), including FX Pricer in Front Office Workstation.]

Out-of-the-Box Attributes
The following attributes can be set out-of-the-box.

Attributes Description
ArbitrageSolveForPreference Default lock preference for Arbitrage window. you can

select Point, PrimaryInterest or SecondaryInterest.

Please refer to Calypso FX Arbitrage documentation for
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Attributes Description
details.

Average Price Per Hour To calculate the cost of a STP break.

Please refer to Calypso Web Operations Dashboard
documentation for details.

BOBrowser Trade Reference Default trade reference for the BO Browser. It can be ID or
Int Ref. It only applies when the BO Browser is open from a
Trade window.

Bloomberg IP

Blommberg UUID

Bloomberg User Mode

Please refer to the Calypso Bloomberg Server API
Integration Guide for details.

Close FOWS QTE After Position Split Transfer If true, the Position split/transfer pop up QTE will
automatically close after trade is booked.

If false (default) , the Position split/transfer pop up QTE will
not close automatically.

Default Ad-Hoc Calculation Server Default adhoc Calculation Server to be used for on-the-fly
risk analyses.

A Calculation Server is part of a Risk Server.

Please refer to the Calypso Installation Guide for details on
setting up adhoc Risk Servers.

Default Ad-Hoc Presentation Server Default Presentation Server to be used for on-the-fly risk
analyses.

A Presentation Server is part of a Risk Server.

Please refer to the Calypso Installation Guide for details on
setting up adhoc Risk Servers.

Default Dispatcher Default dispatcher to be used for on-the-fly risk analyses in
the Trade Blotter.

Please refer to the Calypso Installation Guide for details on
setting up distributed processing.

Default Pricing Grid Auto Update Dispatcher Default dispatcher configuration to compute pricing results
in the Pricing Grid and FOWSMarket Sheet.

EDealingOrderBlotterShowAlertsTab True to show the Alerts tab in the ePortals Order
Management window or false otherwise.

EDealingOrderBlotterShowImportExportTab True to show the Import Export tab in the ePortals Order
Management window or false otherwise.

EDealingOrderBlotterShowOperatingSystemTrayAlerts True to show the Operating System Tray Alerts in the
ePortals Order Management window or false otherwise.
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Attributes Description
EDealingOrderPendingBlotterMinRefreshInterval Default refresh interval of the Pending Orders Blotter in the

ePortals Order Management window.

EdealingTIMPendingSearchStatus Default status for Pending Search Status field in eFX
Configuration window.

Please refer to eFX Configuration documentation for
details.

EMA Open DACS AppId

EMA Open DACS Daemon

EMA Open DACS ForceUserNameLowerCase

EMA Open DACS Retry Rate

EMA Open DACS Site

EMA Open DACS UsageLoggingType

EMA Open DACS User IP

EMA Open DACS User Mode

EMA Open DACS User Name

Please refer to the Calypso Refinitv EMA Integration Guide
for details.

Employee Id Employee identifier, as needed.

FX Auto Populate TakeUp Amounts True to auto populate the remaining amount on Take Up
window, or false otherwise.

FX Default Broker Not used.

FX Default CounterParty Not used.

FX Default Currency Pair Select the default currency pair that loads in the trade
window when you open it.

FX Default Current Trade Datetime Flag True to check Current Trade Dt field be default in FX Deal
Station, or false otherwise.

FX Default Deal Type The default deal type that is displayed when the FX Deal
Station window is opened. Select either Outright or Swap.

FX Default Deliverable Type Select either Deliverable or Non Deliverable.

FX Default Delivery Type Not used.

FX Default Override Ccy As Deliverable Currencies to be considered as deliverable in the FX Deal
Station even if the Currency Defaults setting is Non-
Deliverable.

Please refer to Calypso FX Deal Station documentation for
details.

FX Default PositionKeepingBookType.SALES Disable
Trade Routing

True to disable trade routing for the Sales book, for both
internal and counterparty trades. Or false otherwise.
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Attributes Description
Please refer to Calypso Trade & Position Routing

documentation for details.

FX Default Prime Broker Not used.

FX Default Rollover Type Default rollover type for FX Trade Rollover window.

Please refer to Calypso FX Lifecycle documentation for
details.

FX Default Spot Delivery Type Select either Known or Unknown. The values for the button
are 'Delivery Known' and 'Delivery Unknown'.

• When the delivery is known, a spot date deal is booked
as an FX spot trade.

• When the delivery is unknown, a spot date deal will be
booked as an FX forward trade. In this case, the deal
can later be modified by changing the settle date.

FX Default Trade Region Default trade region for ePortals.

Please refer to Calypso ePortals Installation
documentation for details.

FX Default Trade Role Not used.

FX Spot Delivery Type Not used - Use FX Default Spot Delivery Type.

FX Termination Book Spot Trade Simultaneously Default value for Book Spot Trade Simultaneously field in FX
Termination window.

Please refer to Calypso FX Lifecycle documentation for
details.

FX User Type Select whether the default FX user is Sales or Trader.

FX WindowForward Default End Tenor Default window end tenor for a new FX Window Forward
trade in the FX Deal Station.

FX WindowForward Default Start Tenor Default window start tenor for a new FX Window Forward
trade in the FX Deal Station.

FXFlexiForward Default End Tenor Default end tenor for a new FX Flexi Forward trade in the FX
Deal Station.

FXFlexiForward Default ShortDays Strategy Default ShortDays Strategy for a new FX Flexi Forward trade
in the FX Deal Station.

FXFlexiForward Default Start Tenor Default start tenor for a new FX Flexi Forward trade in the FX
Deal Station.

FXFlexiForward Default TakeUp Type Default TakeUp Type for a new FX Flexi Forward trade in the
FX Deal Station.

FXFlexiForward Default Window Type Default Window Type for a new FX Flexi Forward trade in the
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Attributes Description
FX Deal Station.

FXForward Default Tenor Default tenor to set the settlement date for FX Forward
trades, applied to the spot date. If not set, the settlement
date is set to the spot date.

FXForwardStart Default Reset Tenor Default Reset Tenor for a new FX Forward Starting Trade in
the FX Deal Station.

FXForwardStart Default Underlying Type Default Underlying Type for a new FX Forward Starting
Trade in the FX Deal Station.

FXNDF Default Negotiated Ccy Default Negotiated Ccy for FX NDF trades.

FXNDF Default Tenor Default tenor to set the settlement date for FX NDF trades,
applied to the spot date. If not set, the settlement date is set
to the spot date.

FXNDFSwap Default Far Tenor Default tenor to set the settlement date for FX NDF Swap
trades (far leg), applied to the spot date. If not set, the
settlement date is set to the spot date.

FXNDFSwap Default Near Tenor Default tenor to set the settlement date for FX NDF Swap
trades (near leg), applied to the spot date. If not set, the
settlement date is set to the spot date.

FXSwap Default Far Tenor Default tenor to set the settlement date for FX Swap trades
(far leg), applied to the spot date. If not set, the settlement
date is set to the spot date.

FXSwap Default Near Tenor Default tenor to set the settlement date for FX Swap trades
(near leg), applied to the spot date. If not set, the settlement
date is set to the spot date.

Historic Rate Rollover Specify the default funding rate for rollovers done from the
trade window by choosing File > Trade Rolloverwhen the
trade is in the VERIFIED status. The value ‘true’ specifies that
the historical rate will be used in the rollover. The HRR
checkbox is automatically selected when you open the FX
Rollover Split application. Set the attribute to ‘false’ so that
the market rate is used by default. The HRR checkbox is not
selected when you open the trade rollover application.

Load Min Product Info Not used.

Manual Quote Expiry(secs) Not used.

Market Data Server Config Select the Market Data Server configuration that you want
to use.

Running a Market Data Server is required to obtain any kind
of real-time market data.

Nasdaq Calypso
Trading Environment / Version 18



Attributes Description
A Market data Server is part of a Risk Server.

Please refer to the Calypso Installation Guide for details on
setting up adhoc Risk Servers.

Max Number of Reconnections Not used.

NumberFormat Select the format of negative numbers for the Results area
of all Trade windows and to the pricer measure DETAILED_
DATA.

You can select the number of decimal places and the
format: -<number> in black or red, or (<number) in black or
red.

PDFConfig PDF configuration file for environment property PDF_
DOCUMENT_FONT.

Please refer to Calypso Environment Properties
documentation for details.

PosRefCurPairs At the system level, you can define currency pairs in both
the direct and inverse order, such as USD/JPY and
JPY/USD, in the Calypso Navigator using Configuration >
Definitions > Currency Definitions.

However, trades entered in both currency pairs appear in
one position. The currency pair that has the Pair Pos Ref
checkbox selected is the position reference currency pair.

However, if you trade the opposite currency pair locally (for
example JPY/USD), you can set that currency pair as the
position reference at the user level. You can enter multiple
currency pairs separated by commas in the attribute.

Pricing Sheet Default Book Default book for the FX Options Pricing Sheet.

Pricing Sheet Pricing Environment Default pricing environment for the FX Options Pricing
Sheet.

Qt Side Mkt Maker Configure the display of quotes as either Market Maker or
Sales Trader by setting the Qt Side Mkt Maker attribute in
User Defaults.
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Attributes Description
• Market Makers — This is the default value (true). The

quotes are from the bank’s perspective. The bid rate
and Sell quote are on the left side; the ask rate and Buy
quote are on the right side.

• Sales Traders — Set the attribute to false. The quotes
are from the customer’s perspective. The bid rate and
Buy quote are on the left side; the ask rate and Sell
quote are on the right side.

Qt Side Mkt Taker Not used.

Reconnection Timeout Not used.

ReportRoundingDisable True to export reports to ExcelX spreadsheets without
rounding the amounts, or false otherwise.

Reuters Open DACS Site

Reuters Open DACS User IP

Reuters Open DACS User Mode

Reuters Open DACS User Name

Please refer to the Calypso Reuters RFA Integration Guide.

Reverse Margin on HRR When this is set to True, the sales margin will follow the
Japanese convention, which means that a sales margin is
booked as profit on the trade date but not received until
settlement.

SSO User ID Microsoft Azure AD name or email depending on CALYPSO_
OPENID_USER_NAME.

Please refer to the Calypso Installation Guide for details.

Sales Location Default sales location.

Trade Blotter Calculation Server Not used.

Trade Blotter Dispatcher Not used.

Trade Blotter Presentation Server Not used.

Try Opening Trade in FOWS First By default, the system tries to open FX trades in the Front
Office Workstation, or using the Trade Window Config if not
configured.

You can set to false to only use the Trade Window Config.

Please refer to Calypso Front Office Workstation
documentation for details.

UploaderDefaultPersistMessage Default value for Persist Message field in Data Uploader
window.

USE_FX_MARGIN_RULES_FOR_TRADE_ENTRY By default, FX Margin Rules are applied to Margin fields in
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Attributes Description
the FX Pricer.

You can set to false if you do not want to use the FX Margin
Rules.

Please refer to Calypso Front Office Workstation
documentation for details.

DefaultZebraBackgroundColor

ZebraRowColor

Select the default background color.

This applies to the Results area of all Trade windows and to
the pricer measure DETAILED_DATA.

Select the background color of every other row.

This applies to the Results area of all Trade windows and to
the pricer measure DETAILED_DATA.
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33. User Settings
The User Settings window allows copying properties and column configurations from various windows between
users.

From the Calypso Navigator, navigate to Configuration > User Access Control > User Settings to bring up the User
Settings window.

» You can modify the "Trade Capture" preferences as needed. The various search components are described
below. Click Savewhen you are done.

You can also copy "Trade Capture" preferences between users.

» "Trade Blotter" and "Uncategorized" preferences are saved by the system when a user chooses preferences in
the corresponding window. They should not be modified here. They can be copied between users however as
described below.
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33.1 Copying Preferences

» Select a user and a To User, and select a set of preferences as needed.

» Click Copy All or Copy Selected to copy the preferences to the To User.

 Ⓘ [NOTE: When copying preferences between users, the preferences of the To User will be overridden. Also,
copied preferences will be lost when the To User saves new preferences in a window]

33.2 Trade Capture Preferences
"Trade Capture" preferences allow configuring the search capability for various components.

Counterparty Search
The FX Deal Station allows searching for counterparties as shown below.

You can configure the display of the search table under Counterparty Search.
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» Check "Field Display" to display the corresponding column value in the Counterparty field.

» Check "Table Display" to display the corresponding column in the search table.

» Check "Search" to search the corresponding column.

Account Search
In the context of ETD Clearing, the Pricing Sheet allows searching for client accounts.

You can configure the display of the search table under Account Search.

» Check "Display" to display the corresponding column in the search table.

» Check "Search" to search the corresponding column.

Book Search
The FX Deal Station allows searching for internal books and trading books.

You can configure the scope of the search under Book Search.

» Select All, Favorites Only, or Favorites Then All.

Bond Search
Not currently available.

Equity Search
Not currently available.

Listed Search
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The Listed Contract windows allow searching for listed contracts.

You can configure the display of the search table under Listed Search.

» Check "Display" to display the corresponding security code in the search table.

» Check "Search" to search the corresponding security code.

33.3 Trade Blotter Preferences
"Trade Blotter" preferences are saved by the system when the user chooses preferences in the Trade Blotter.

These preferences should not be modified here. They can be copied to another user however as needed.

Trade Blotter Preferences

Preferences Description

Viewers List of viewers selected by the user: workspaces, books, trade filters, bundles, and coun-
terparties.

Trade Blotter Prefer-
ences

Menu items selected by the user: Real-time trade, panel selection, total view.

Trade Blotter Columns Columns selected by the user.

Speed Buttons Speed buttons selected by the user.

View Configuration View templates selected by the user.

Other Configuration Technical property - Versions of view templates.

Colors Status colors selected by the user.
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You can refer to Calypso Trade Blotter documentation for complete details on these preferences.

33.4 Propert ies and Columns Preferences
"Properties and Columns" preferences are saved by the system when the user chooses preferences in the
corresponding windows.

These preferences should not be modified here. They can be copied to another user however as needed.

Properties Preferences

Preferences Description

<window>LastSelectedView Last selected view template for the window.

<window> Technical property - Last window size.

Some windows use <window>_WINDOW_SIZE instead.

<window>_Template Last selected template for the window.

<window>_WINDOW_POS Technical property - Last position of the window.

<window>_WINDOW_SIZE Technical property - Last window size.

<product type>_RT_FLAG Real-time flag of the Trade window.

BO_TRADE_MESSAGE_SELECTED_
TRANSFERS

Last selected "Selected Transfers" flag in the BO Browser window.

BOCashFinancingAction

FinancingMultiTradeAction

Last selected financing action.

<product type>/FAVORITE_BOOKS Favorite books selected for the trade window.

<product type>Pro-
ductChooserHandlerCurrencies

List of currencies for the product chooser.

<product type>Pro-
ductChooserHandlerTab

Number of tabs for the product chooser.

<product type>Pro- List of product types for the product chooser.
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Preferences Description

ductChooserHandlerType

<window>TemplatePanel.

INV_POS_DATE_TYPE

INV_POS_TYPE

IS_BASKETS_PROCESS

IS_MARGIN_CALL_PROCESS

IS_OTC_PROCESS

IS_POSITION_PROCESS

Agent Aggregation Only

CARepoedPLPosition

Filter Display

Show Log Process

Last inventory position criteria selected for the window.

CalypsoJideSplitPane_<window> Technical property - Panel split size.

calypsouser.split_<window> Technical property - Panel split size.

<window>_HISTORY_TAB History tab display in the trade window.

<window>_STATUS_BAR Status bar display in the trade window.

CDS_RATE_IN_BP Technical property - Default CDS rate format.

ContactType Technical property - Default contact type.

CorporateActionFrameDefaultTab Technical property - Default tab of the Corporate Action window.

<legal entity rle>/FAVORITE_CPTYS Favorite counterparties for the trade window and role.

<curve>SelectorStartDate Last selected start date in the curve selector.

CWSRiskShortcutIndices Not used.

CWSTradeShortcutIndices Trade speed buttons selected in CWS.

DealStationCompositionRole Last selected role in FX Deal Station.

DealStationPersona Last selected persona in FX Deal Station.

needToDoInterestCleanup.<product type> Last selected value of Interest Cleanup in product Termination.

PositionKeeper<criteria> Last selected criteria in Position Keeper.

PricingSheet<preferences> Pricing Sheet preferences.

Please refer to Calypso Pricing Sheet documentation for details on
these preferences.

QuickSearchWindowIdType Last selected object in the Quick Search window.
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Columns Preferences

Preferences Description

<window>_COLS Last selected columns for the window.

<product type> Pricing Last selected pricer measures in Trade window.

<task station tab> Last selected columns for Task Station tab.

<product type> CF Last selected cashflow columns in Trade window.
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